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Task Guide 01 – What’s New in Toolkit 9 

 
What’s New? 
 
Conservation Stewardship (CStwP) Reinvention Updates 

• New Conservation Stewardship Program (CStwP) plan type 
• Plan Wizard and Contract Wizard provide option to select Detail or Summary view 
• Land Use Report option added to Quick Reports Tool 

 
Conservation Planning 

• GIS Tools tab in Toolkit Preferences updated adding option to update map template or 
leave current template and removing options that are no longer used 

• Check Out without File button now includes a copy of the Toolkit Template ArcMap 
Document allowing users to open ArcMap and access the Toolkit toolbar 

• Practice Filter Tool added to Toolkit Toolbar and Practice Schedule allows user to filter 
practices displayed on the map or the Practice Schedule 

• Export Tool added to Toolkit Toolbar to export practices or Case PLUs to a shapefile 
• New tools added to Practice Editor Toolbars: Replace Practice, Import Practice, Create 

and Convert Practice, and Explode Practice 
• The Land Unit Replace Tool will ask the user if they want to update the land unit acres to 

match the new calculated amount 
• Practice Narrative selection added to the Practice Attribute Tool 
• New Copy Practice button replaces Create Practice on the Practice Attribute Tool 
• Rules enforced for applying practices: practices cannot be applied in the future, and 

applied amount for acre-based practices cannot exceed the land unit acres 
• Halo and text color options added to the Map Labels Tool 
• Check In Features button allows practices to be checked into NPAD without having to 

check in the customer folder 
• Plan Approval button added to the Practice Schedule and Plan Approval Tab removed 
• Option to view land units in Plan by Tract/Land Unit or by Land Use added to the Land 

Unit Tree on the Practice Schedule and the Add/Remove Plan Land Units dialog  
• Contract Wizard Name and the Contract Item number are displayed in the Practice 

Schedule Grid 
• ProTracts Contract Number replaces Contract Wizard Name in the Practice Schedule 

Grid when practices are uploaded to ProTracts 
• Agreement Status and Agreement Item Status from ProTracts are displayed in the 

Practice Schedule Grid 
• Once practices are uploaded to ProTracts, the practice code, planned amount, planned 

date, and practice narrative cannot be edited without first deleting the item from 
ProTracts  

• Contract Wizard allows the planner to select the Practice Code to select all Tracts and 
Land Units and create a contract item 



Task Guide 1 P a g e  | 2 September 16, 2016 

• Contract Wizard allows the planner to select any combination of Tract(s) and Land 
Unit(s) from within a practice to create a contract item 

• Contract Wizard allows the planner to remove a Land Unit from a contract item 
component without deleting the contract item 

• Contract Wizard allows the planner to create a Contract Item Group for grouping 
contact items in the 1155 and 1156 and for display in ProTracts 

 
Easement Planning and Reconciliation Tools 

• New Easement folder type, easement folders are linked to the National Easement 
Staging Tool (NEST) enrollment number and client 

• Advanced Search options added to locate easement folders 
• New Easement Reconciliation role added in zRoles 
• Cooperating Entity added as client association type 
• National Easements Geospatial (NEG) layer is displayed in ArcMap for easement folders 
• Easement Land Unit Tool added to the Toolkit Toolbar to associate easement land units 

to the NEST ID number 
• Easement Reconciliation Tool added to the Toolkit Toolbar allows users with the 

appropriate zRoles permissions to review and lock easement land units 
• Reconciled easement land units are locked in Toolkit 
• Locked Easement land units can be split or merged (interior edits), no other edits are 

allowed while the land unit is locked 
• A warning message is given when new practices are scheduled outside of the easement 

plan and overlap a reconciled easement land unit 
 
Integrated Erosion Tool 

• Integrated Erosion Tool (IET) ArcMap add-in allows the user to select a PLU (or another 
polygon features within ArcMap) and run RUSLE2 or WEPS within ArcMap. 
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Conservation Stewardship (CStwP) Reinvention Updates 
Create/Manage Plan 
A new CStwP plan type will be used to create a plan and contract items to upload to ProTracts 
beginning with the FY17 sign-up for General CStwP and the FY18 sign-up for CStwP Renewals. 
The CSP plan type will continue to be used for the FY17 Renewal Sign-up and for all FY16 and 
earlier sign-ups that have been entered in the Conservation Management Tool (CMT). 
 

 

 

 
The steps for creating and managing a CStwP plan will follow a similar path as working with a 
conservation plan. The application number is not entered when creating a CStwP plan because 
these plans to not use the CMT. Land units are added or removed from a CStwP plan using the 
Add/Remove Land Units link within the Create/Manage Plans menu. In the Add/Remove Land 
Unit dialog, land units can be sorted by Tract/Land Unit or by Land Use. 
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Practice Schedule 
The Practice Schedule land unit tree can be viewed by Tract/Land Unit or by Land Use to select 
land units and schedule CStwP enhancements by land use. New CStwP Enhancement codes 
have been added and planner will be able to schedule these enhancements or conservation 
practices on land units in a CStwP plan. The list of practices on the Practice Schedule and the 
Practice Attribute Tool can be filtered to show only enhancements or only practices. 
 

 

 
  

 
CSP ProTracts Land Use Check 
The CSP ProTracts Land Use Check will not be used for CStwP plans because these plans do not 
use the CMT. The CSP ProTracts Land Use Check will continue to work with CSP plan types. 
 
Quick Reports Tool 
A new Land Use Report has been added to the Quick Reports Tool. This can be used to generate 
a report of land use acres for the CStwP plan and export the report to Excel.  
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Plan and Contract Wizard 
The Plan Wizard and Contract Wizard will allow users to select a Detail View or Summary View 
when generating a Plan Report or Contract Document. In the Plan Report, items can be sorted 
by practice or land use. Up to 3 additional signature blocks can also be added to the Plan Report 
or Contract Document. The signature blocks can be customized by the user and are saved for 
future use. 
 

 

 
 

 
Conservation Planning 
Preferences 
The GIS Tools Tab in Toolkit Preferences only allows users to set the Map Projection and the 
Update Map Template option. Out-of-date options have been removed from this tab. The 
option to Update Map Template is new and allows the user to control whether the Map 
Template is updated when preferences are set. If the update option is not selected, 
customizations in the user’s current template will be retained. 
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Check Out Without File 
The Check Out without File button will now include a copy of the Toolkit Template ArcMap 
Document. This Enables users to open Arc Map and update the Case PLUs, Plan and Practices. 
No files are checked out from the local server and users will only have the generic template 
ArcMap Document. Any changes made to the ArcMap document file will not be saved when the 
folder is checked in. 
 

 
 
Toolkit Toolbar 
Two new tools have been added to the Toolkit Toolbar. The Practice Filter Tool  allows the 
user to filter which practices from a plan are displayed in ArcMap and only view or print the 

selected practices. The Export Tool  can be used to export practices from a plan or land 
units from the Case PLUs layer into a shapefile for use in GPS or other tools. 
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Practice Editor 
Several new tools have been added to the Practice Editor Toolbars. Replace Practice Shape  
is similar to the Replace Land Unit Tool and allows the user to replace a practice shape either by 
digitizing or copying from a source layer. The Import Practice Shape Tool  replaces 
Copy/Paste functionality and allows the user to import a new practice shape from a source 
layer. Convert and Create Practice  can be used to select a polygon and convert the 
perimeter to a practice line or to select a line and convert it to a practice polygon. The Explode 
Practice Tool  explodes a selected multi-part practice into separate practices with the same 
attributes. One practice is selected to retain the original practice record, including the practice 
status and contract item. The new practices created will be in “alternative” status. 
 
Land Unit Editor 
The Replace Land Unit Tool will ask the user if they want to update the land unit acres to match 
the new calculated amount when the land unit is edited. 
 
Practice Attribute Tool 
Practice Narratives can be selected from the Attribute Tool. The Create Practice button has 
been renamed Copy Practice to clarify its purpose. Validation checks have been added that will 
not allow the practice to be applied in the future and for acre-based practices, the Applied 
Amount cannot exceed the land unit acres. 
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Map Label Tool 
Options to set label color and add halo have been added to the Map Label Tool. The Text Size 
and Add Halo selections are saved along with the other Label Tool User Preferences. 
 

 

 

 
Practice Schedule 
The Practice Filter Tool  allows the user to filter which practices are displayed in the Practice 
Schedule Grid making it easier to apply or view practices. The Plan Approval Tab has been 
removed from Toolkit and replaced with a Plan Approval Button located on the Practice 
Schedule.  
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An option was added to the Land Unit Tree to view the land units either by Tract/Land Unit or 
by Land Use.  
 

 

 
 
  

 
Validation checks have been added that will not allow the practice to be applied in the future 
and for acre-based practices, the Applied Amount cannot exceed the land unit acres. The 
Contract Wizard Name and Contract Item number are displayed in the Practice Schedule Grid 
when the Contract Wizard saved. As soon as the practices are uploaded to ProTracts, the 
ProTracts Contract Number replaces the Contract Wizard Name. Agreement Status and 
Agreement Item Status are displayed from ProTracts. Once practices are uploaded to ProTracts, 
the practice code, planned amount, practice narrative, planned month and planned year cannot 
be edited without first deleting the item from ProTracts. ProTracts will automatically unlink 
practices, making them editable in Toolkit, once the application status is no longer valid for 
obligations. 
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Contract Wizard 
In the Contract Wizard, the planner can now select the Practice Code to select all Tracts and 
Land Units and create a contract item and components. The planner can select any combination 
of Tract(s) and Land Unit(s) from within a practice to create a contract item. The planner can 
remove a land unit or land units from a contract item component without deleting the contract 
item. The Contract Wizard allows the planner to create a Contract Item Group of practices for 
grouping contract items in the 1155 and 1156 and for display in ProTracts. Contract Item 
Groups are used for grouping and displaying practices for the producer and do not change any 
rules on contract item certification and payments. 
 

 

 

 
Easement Planning and Reconciliation Tools 
Create Customer Folder 
An Easement folder type has been added to the Create Folder dialog. When an Easement type 
folder is created, the user will select a county (available options are based on the user’s 
preferences) and the easement program code. The create folder dialog will show NEST 
enrollment numbers for the selected county and program that are not already associated to an 
easement folders and the user will select an available enrollment number.  
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Only one easement folder can be associated to each NEST enrollment number. The 
Company/Business name is automatically populated with the enrollment number. The folder 
decision maker and associated clients are automatically added from NEST and can only be 
changed in NEST. The Add/Remove Clients and Update Decision Maker dialogs at the folder 
level (on the General Tab) are disabled for easement folders. The Folder Decision Maker is 
automatically updated when the Land Owner Decision Maker is updated in NEST. 
 
Check-In/Check Out and Customer Folder Tabs 
The search for Toolkit Folders by Customer Name will return search results from both SCIMS and 
NEST. The Customer Name displayed in the NPAD search results window will update 
automatically when the Land Owner Decision Maker is updated in NEST. 
 
Change County/Servicing Office 

An option has been added to the Change County/Servicing Office dialog  allowing users to 
change the agreement number associated with a Toolkit easement folder. This option is 
available when an Easement Folder is selected and the user has Toolkit All or Toolkit Easement 
Reconciliation permissions in zRoles. 
 

 
 
Customer Folder – General Tab 
Client information for easement customer folders is imported from NEST and is read-only in 
Toolkit. The system determines the client(s) associated with the easement customer folder 
based on the NEST enrollment number and defaults the decision maker from NEST to the 
decision maker on the easement folder. The Add Associated Customer and Edit/Delete 
Associated Customer buttons are disabled for easement folders, any needed changes must be 
completed in NEST. The client land owner information will update automatically when updated 
in NEST. Client land owner information from NEST is historical information related to the 
easement and remains a permanent record on the easement folder. Once a client is associated 
to the easement they will always remain associated to the easement folder even if the client 
sells the entire easement. 
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Easement Land Unit Tool 

The Easement Land Unit Tool  has been added to the Toolkit Toolbar and is used to 
associate easement land units to the NEST ID number. At least one land unit must be associated 
to the Easement ID in order to create a plan within the Easement folder. Easement land units 
can be associated to more than one plan in more than one folder. There is also an option to 
remove land units from the easement association. Land units associated to an easement cannot 
be deleted. In order to delete a land unit associated to an easement the land unit must first be 
removed from the easement association using the Easement Land Unit Tool. The system will 
prevent the user from removing the last land unit associated to the easement if there are any 
practices in the Easement Plan. 
 

 
 
Transfer Tool 
Land units, practices and documents may be transferred to and from other conservation 
customer folder(s) before the reconciliation is completed and Case PLUs are locked. Once the 
Easement PLUs are locked (reconciled) the transfer tool will only allow practice transfers from 
one plan to another plan within the easement folder. Plan transfers are not allowed to and 
from easement planning folders due to the complexity of client management. 
 
Toolkit Digitizer 
Locked Easement land units can be split or merged (interior edits), no other edits are allowed 
while the land unit is locked. If user needs to make any other edits, the reconcile tool must be 
used to unlock the Case PLUs. The National Easements Geodatabase (NEG) layer is selectable as 
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a source layer for the Import and Replace Tools. An Explode Land Units Tool  has been 
added to the Land Unit Editor Toolbar to explode multi-part (merged) PLUs into separate 
polygons. 
 
Create/Manage Plans 
One or more plans can be created in an easement folder. Easement land units, within an 
easement folder, may be added or removed from one or more conservation plans located in 
one or more conservation customer folders. At least one land unit has to be associated to the 
Easement ID in order to create a plan within the Easement folder. In cases where the easement 
restoration is completed, there is no requirement that practices must be planned or that the 
plan must be signed. For easement folders, Cooperating Entity has been added to the selection 
list for client association type. Client changes in NEST do not change the clients, decision maker 
or client associations to an easement plan. If a land owner sells the easement to a new client, 
the new client will be added to the easement folder from NEST, the user can manually update 
the plan clients and Decision Maker as needed. The user is allowed to cancel or complete an 
easement plan in the Modify Folder/Plan Status dialog. 
 

 
 
Reconcile Easement 
The Easement Reconciliation Tool  added to the Toolkit Toolbar allows users with the 
appropriate zRoles permissions to review and lock easement land units. The user must have the 
Easement Reconciliation role in zRoles to reconcile or to justify why reconciliation was not 
completed. The Easement Reconciliation Tool cannot enforce easement rules before there is a 
closed date in NEST. The system will alert the user when the land unit calculated acres and 
NEST closed acres are not within 2% of each other. Land Units in planned status will be locked 
and be displayed as locked once the Enforce Easement Rules checkbox is selected and saved. If 
any land units are locked by ProTracts when the reconcile easement tool is used, the  
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easement can be reconciled. If the Enforce Easement Rules is later removed, any PLUs locked 
by ProTracts will remain locked. 
 

 
 
Practice Schedule Tool 
When a practice is created outside of the easement folder that overlaps a locked easement 
land unit, a warning message is displayed. The message is also displayed when an alternative or 
planned status practice outside of the easement folder that overlaps a locked easement land 
unit is edited. The available Program Codes for the easement folder are limited to the NEST 
program associated to the easement folder and CTA-GEN. When a practice is created, the 
default program code is CTA-GEN. 
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Advanced Search 
Advanced search options have been added to allow the user to search for all folders that have a 
cooperating entity association and to search by a specific cooperating entity name. Advanced 
search will return results for both SCIMS and NEST clients. The user can search for an easement 
by agreement number. Easements that need to be reconciled can be located by selecting the 
Easement Not Reviewed checkbox. 
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Integrated Erosion Tool (IET) 
The Integrated Erosion Tool  is an ArcMap add-in that allows the user to select a PLU (or 
another polygon features within ArcMap) and run the Revised Universal Soil Loss Equation 
version 2 (RUSLE2) or Wind Erosion Prediction System (WEPS) within ArcMap. 
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Task Guide 2 - What’s New in Toolkit 8 

What’s New? 

• Land units are created/managed in the Case PLU layer  
• Land units in locked or plan status can be added to practice schedules from the Case PLU or 

Active PLU layers 
• Land units can participate in multiple practice schedules from multiple customer folders 
• Decision makers and clients are associated to each practice schedule within the customer folder 
• Land Unit Quick Report tool displays land unit and practice information from Case, Active and 

Legacy Land Units 
• Land Unit Editor has a new Collapse tool which allows land units that overlap more than 25% to 

be consolidated into a single land unit 
• Land Unit Editor has a new Replace tool which allows the user to replace the land unit boundary 

by digitizing a new boundary or importing the boundary from a source layer. 
• The Transfer tool allows transfer of land units, practices, land units and practices, plans and 

documents between folders. Practices can be transferred to another plan within the same folder 
to create a master plan. 

 

 
 
In previous versions of Toolkit, land units and plans (practices) were linked in the same layer called the 
planned land units and were normally named consplan, consplan1, etc. If a client owned land that was 
operated by another client or if a separate plan was needed, in Toolkit 2004, the land would usually be 
redrawn (pancaked) in the operator’s customer folder. With changes made in Toolkit 7 to check 
topology and eliminate pancaking, the land would have to be put in the operator’s folder in order to 
create a plan for the operator which also meant that the land owner could not have a plan for the land 
that he owned. Having the land in the operator’s folder, caused problems because operators might 
change regularly and the land would not be available to put in the new operator’s folder. Compounding 
the problem was the fact that the land could not be moved between customer’s folders. 
 
Additionally, there could be only one plan for a land unit. 
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In Toolkit 8, land units will be digitized into a separate layer called the Case PLU layer. Each customer 
folder will automatically contain a Case PLU layer which should generally contain all the land that is 
owned by the customer. Plans (practice schedules) will be developed by selecting land units from the 
customer’s Case PLU’s or other customer’s Case PLU’s (via the Active PLU layer). Multiple plans can be 
developed for the same land units, either for one customer or multiple customers. 
 
In the first example above, Tom Jones owns and operates Tracts 1234 and 9999. The land is digitized 
into the Case PLU’s and land units are selected to be put into plans, in this case, one for each tract. 
However, all the land units could be put into one plan or land could be put into separate plans based on 
some criteria such as land use, nutrient management, pest management, or grazing management, etc. 
In the second example, Joe Smith owns Tract 9876 but does not operate it. John Doe has a one year 
lease and operates the tract. The land is digitized into Joe Smith’s Case PLU’s but the plan is developed 
in John Doe’s customer folder. Next year if someone else operates the land, a plan could be developed 
in the new operator’s customer folder or the current plan could transferred to the new operator. If a 
new plan was developed for the new operator the current plan could be marked completed, cancelled, 
or deleted. 
 
In the third example, Bob White owns tracts 6500 and 7890. He operates tract 6500 and has a plan for it. 
He also has a plan for the structural practices on Tract 7890 but Ralph Sneed operates the tract and has 
a plan for the management practices on the tract. Another example would be that Bob White has a CRP 
plan for part of Tract 7890 and Ralph Sneed has a plan to operate the rest of the tract.  
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Case PLU’s 

The Case PLU layer is automatically included in all customer folders. Land units are no longer added via 
the New Toolkit Layer  button but by the Editor button . 
 

 

 

 
The Land Unit Editor toolbar has a new Import Land Unit(s)  button to import shapes from a source 
layer, such as the CLU or History PLUs layers. Land units can still be manually digitized with the Add Field 

 tool. 
 

 
Since land units are not digitized into the Consplan layer it is no longer necessary to select the plan 
before digitizing the land units. 
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The Select Plan  button is now the Create/Manage Plans button. The user can select existing plans or 
create new plans.  
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The Actions links allow the user to add or remove land units to or from plans or edit the plan decision 
maker. 

 

 
 

 

 
Land units can be selected via the map or by searching the Active PLU and/or Case PLU layers. 
 

 
Edit the decision maker for the plan by placing a check mark in the Decision Maker radio button. 
 

 
Note:  Available Customers comes from the Associated Customers in the customer folder on the General 
tab.  
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Quick Report Tool 

The Quick Report  tool allows the user to view information about land units. The land units can be 
selected via the map or by selecting the Case PLU’s or Plans land units. 

The upper window will display the selected land units number, land use, status and acres. 
The lower grid will show the customer folder, plan name, plan status, the decision maker and practice 
information about the selected land units. 

The information can also be exported to an Excel spreadsheet for later use. 
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Transfer Tool 

The Transfer tool  allows the user to transfer plans, land units, practices, land units and practices as 
well as documents from one customer folder to another. Both customer folders (transfer to and from) 
must be checked out from the NPAD to the local computer. 
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Land Unit Editor Replace Tool 

The Replace tool on the Land Unit Editor toolbar allows the user to replace a land unit boundary with a 
new boundary by digitizing or selecting the boundary from a source layer. The attribute and plan 
information for the land unit is retained. 
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Land Unit Editor Collapse  Tool 

The Land Unit Editor Collapse tool allows the user to merge land units when they overlap by more than 
25%. This tool will be useful to clean up old Legacy or Draft land units that still have planned practices by 
merging them with current land units. 
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The following is an example of the use of the collapse tool. The customer folder has several plans, in this 
case there are two land units on the same land that overlap. One is Legacy status and one is Planned 
status, they both have practices. Some of the Legacy Land Unit’s practices are planned and some are 
applied. 
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After the collapse, all of the planned practices are moved to Land Unit 2. Land Unit 10 and any applied 
practices are moved to the History layer. 
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Practice Schedule 

A practice status has been added to the practice scheduler, so that the user can choose to see only 
practices with a certain status (All, Alternative, Planned, Cancelled, Applied). 
 

 

 

 
 

 
Showing only Planned Practices: 

 
Changing Practice Status 
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Task Guide 3 - Getting Started 

Customer Service Toolkit (CST or Toolkit) is the official conservation planning tool used by the Natural 
Resources Conservation Service and Conservation Districts. Toolkit is used for conservation planning and 
design, layout, and evaluation of approved conservation practices. It is also used to capture practice and 
plan-based agency reporting measures. 
 
Toolkit 9 was developed to be used with ArcGIS 10.3 Service Pack 0.  It can utilize Microsoft Access and 
Excel to create products to deliver to clients. Planning data is saved in the National Planning and 
Agreements Database (NPAD). 

Overview of Toolkit Design 

Tabular and Spatial Data 

Toolkit checks in and out tabular and spatial data related to the customer folder, client, assistance 
notes, plan, Toolkit contract items, land units and practices into NPAD which is then available to be used 
by other applications. 

Customer Files 

Toolkit checks in and out customer files from a local server that stores client’s documents, maps, photos, 
geospatial information, determinations, practices design and certifications as well as any other data 
associated to the customer folder. 

Toolkit Diagram 
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Information Needed 

1. Geospatial Data is used in ArcGIS for many planning purposes. Geospatial data is stored locally 
in the F:\geodata folders or can be found on the web. 

2. Payment Rate Lists (Costs lists) are spreadsheets that are used in the contract wizard for the 
purposes of creating contract items in a schedule of operations. Data for payment rate lists are 
stored in the Field Office Technical Guide, Section I. 

3. Service Center Information Management System (SCIMS) – Customer information from SCIMS 
is exported directly into the Toolkit General tab when creating a new customer folder or adding 
a new Associated Customer to an existing customer folder. 

4. Conservation Management Tool (CMT) – Before creating a Conservation Stewardship Program 
(CSP) plan in Toolkit, Toolkit confirms that the CSP contract number is in CMT and that no other 
CSP plan has been created using the same CSP contract number. All new enhancements and 
practices used in CMT must be in the practice schedule before the plan can be approved and 
printed. 

5. Conservation Practice Standards (CPS) – Practices and practice narratives are downloaded from 
the CPS database into the Toolkit Domain Data. The Preferences practice tab is used to manage 
which practices show up for use in ArcMap and the practice schedule. 

6. zRoles Permissions – zRoles is an application that is used to set permissions controlling which 
counties that the Users will be able to check out in Toolkit. Permissions to view and modify 
specific customer data are based on the user’s role in the planning process. Users are only able 
to check out folders in the counties they have been granted permissions for. 

7. Office Information Profile (OIP) – Service Center information is managed by each state OIP data 
steward in the OIP database. Each Service Center is associated to one or more counties that are 
available for planners to select and associate a customer folder to. Toolkit displays the term 
Servicing Office for the Service Center name from OIP. 

8. National Easements Staging Tool (NEST) – For easement folders, Toolkit reads the easement 
agreement number, program, agreement status and client information from NEST. Associated 
clients, cooperating entities, and decision makers for easement folders are defaulted from NEST. 
These are read-only in Toolkit and any changes must be made in NEST. 

Software Toolkit Uses 

1. ArcGIS 10.3 SP0 is used to create/edit/attribute geospatial data such as land units, practices, 
resource inventory and build your own layers. It is also used to run soils reports, soils maps, 
conservation plan maps as well as many other types of analysis needed for planning and practice 
design and implementation.  

2. Microsoft Access is used to manage tabular data associated to plans such as client information, 
practice schedule (plan wizard/contract wizard), plan approval and conservation plan notes. It is 
also used to customize preferences, modify customer folder/plan status, rename customer 
folders/plans and release folder locks. 

3. Microsoft Excel is used to generate and store conservation plan spreadsheets and contract 
spreadsheets (CPA-1155). 

Where Customer Folders Components Reside 

1. National Planning and Agreements Database (NPAD) – The National Planning and Agreements 
Database (NPAD) is a new foundational hub for NRCS data that allows information to be shared 
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across many electronic systems and tools. The central concept is that conservation takes place 
on the land. Therefore, the data related to conservation should be organized around that place 
on the ground. Resource inventory, assessment of resource concerns, development of 
conservation plans, contracting of practices, and reporting of progress are activities that relate 
to the ground over time. Clients associated with the land, and the usage of land, will change 
over time, but the location of that land gives a means to correlate data. It provides a continuum 
in assessing the needs of the land and the conservation undertaken. 

2. Local Field Office Servers – Where customer folders files and spatial data such as resource 
inventories and other customer specific spatial data are stored. 

Applications that Use/Share Toolkit data in NPAD 

1. ProTracts – Practices and land units are linked to ProTracts once a contract application is 
uploaded to ProTracts. 

2. Client Gateway – Producers are able to view and request assistance on practices and land units 
in their conservation plans. 

3. Integrated Data for Enterprise Analysis (IDEA) – Reports are generated from practices planned 
and applied. 

4. Performance Results System (PRS) – Progress is reported from plans and practices entered in 
Toolkit. 

5. Document Management System (DMS) – Documents manually uploaded to DMS by planners, 
or by clients through Conservation Client Gateway (CCG) are associated with NPAD folders at 
the plan and practice level. These docs are viewable through CCG or DMS based on the user’s 
zRoles; They are not viewable though Toolkit since DMS is not linked to Toolkit. 
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Task Guide 4 - Setting Preferences 

Contents: 

Field Office Tab ............................................................................................................................................. 2 

Conservation District Tab .............................................................................................................................. 4 

Practice Narratives Tab ................................................................................................................................. 6 

GIS Tools Tab ................................................................................................................................................. 7 

Choice Lists Tab ............................................................................................................................................. 8 

Custom County Data Management Tab ........................................................................................................ 9 

 

 

 

 

 

 

 

 

Preferences must be set up prior to using Toolkit for the first time and after a new version of Toolkit is 
installed. These instructions describe what preferences can be set and updated as needed. 
 
1. Open Toolkit by selecting Start > All Programs > Customer Service Toolkit > Toolkit or by selecting 

the Toolkit  shortcut.  

2. In the Customer Service Toolkit dialog, click the Start Preferences application  button 

 

3. Follow the specific link for directions to update preferences. 

Toolkit Preferences Tab Explanation 
Field Office  Set the default Field Office for entering Field Office information 

needed in the Plan Map/Plan/Contract Wizard. Requires User 
Authentication 

Conservation District  Set the default Conservation District information that is needed in the 
Plan/Contract Wizard. Requires User Authentication 

Practice Narratives Set the Practice Narratives to be used in your county(ies). 
GIS Tools Select the default map projection for ArcMap, refresh map template. 
Choice Lists  Set the NRCS land use codes and programs. 
Custom County Data 
Management 

Set the default county(ies) available to for use in Toolkit for the 
search dialog on the Check In/Out Tab. Sets the default state and 
county for the Plan Map. Requires User Authentication 

4. Before exiting Preferences, save all data by selecting Preferences > Save All. 
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Field Office Tab 

The Field Office tab is used to enter Field Office information needed in the Plan Map, Plan Wizard and 
Contract Wizard. 
 

NOTE:  If the Field Office information is incorrect, it cannot be updated in Toolkit. To update the 
Field Office information, contact your local Toolkit support person so they can make the necessary 
updates to the Office Information Profile (OIP) database. All offices associated to the county(ies) 
selected in the custom county data management tab should be available to select. 

Initial Use of Toolkit 

If this is the first time in using Toolkit, you must update field office information to download the list of 
offices you have permissions for. 
 
1. Click the Field Office tab. 

2. Click the Update FO Info button. 

NOTE:  If you do not see the “Update FO Info” button at the bottom, then resize the popup window.  
The button may not show unless the computer’s monitor display is set to Smaller - 100%. Often 
computers are set up using Medium - 125% (default) which may cause some mismatch of buttons, 
objects and text elements. 

 

 
 
3. In the Toolkit Warning dialog, answer Yes to “Your field office preferences will be overwritten with 

new data.  Do you wish to continue?” 



Task Guide 4 P a g e  | 3 September 16, 2016 

 

 
 

 

 

 

 

 

 
 
 

If you are not eAuthenticated, you will next be directed to a USDA eAuthentication Login.  
 

Setting/Updating Field Office Preferences after Initial Use Steps 

1. Click the Field Office tab. 

2. Choose the primary Field Office from the Field Office drop-down list. 

3. Check the Default Office checkbox. 

4. Update/Change the Designated Conservationist, if necessary, by typing the correct name. 

5. Click the Save button. 
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6. The Toolkit Information message will display Field Office preferences have been saved. Click OK on 
the Toolkit Information dialog. 

 

 
 

 

 

 

Conservation District Tab 

The Conservation District tab is used to set the default Conservation District information that is needed 
in the Plan Map, Plan Wizard and Contract Wizard. If the Conservation District information is incorrect 
you can update it directly in Toolkit. 

Initial Use of Toolkit 

If this is the first time using Toolkit, you must update the conservation district information to download 
the list of conservation districts that you have permissions for.  
 
1. Click the Conservation District tab. 

2. Click the Update CD Info button. 
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3. In the Toolkit Warning dialog, answer Yes to “Your conservation district preferences will be 
overwritten with new data.  Do you wish to continue?” 

 

 
 

 

 

 

 

 
 

If you are not eAuthenticated, you will next be directed to a USDA eAuthentication Login. 
 

Setting/Updating Field Office Preferences after Initial Use Steps 

1. Click the Conservation District tab. 

2. From the Conservation District drop-down list, choose the primary conservation district 

3. Check the Default District checkbox. 

4. Click the Save button. 
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5. The Toolkit Information message will display “Conservation District preferences have been saved”. 
Click OK on the Toolkit Information dialog.  

 

 
 

 

 

 

 

 

Practice Narratives Tab 

The Practice Narratives tab is used to shorten the list of practices available for your planning needs. All 
practices are checked on by default when opening the first time. To customize the practices narratives 
manually, check and uncheck the practices or use the Select All or Unselect All buttons. When a practice 
is selected the practice narrative(s) are displayed.  
 
1. Click the Practice Narratives tab.  

2. Click the UnSelect All button. 

3. Select the checkbox(s) to select the practices you need. Each practice will display the practice 
narratives in the right-hand window. 

4. Once all the Conservation Practices are selected, click the Save button. 
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5. The Toolkit Information message will display “Practices Narratives preferences have been saved”. 
Click OK on the Toolkit Information dialog. 

 

 
 

 

 

 

 
 

GIS Tools Tab 

The GIS Tools tab is used to setup the default map projection for the county(ies) you will be working in. 
The Update Map Template option allows the user to update their Normal.mxt file. This will refresh the 
map template and remove any customizations saved in the current template and should only be 
checked if the map template has become corrupt. 
 
1. Click the GIS Tools tab. 

2. In the Default Map Projection section, set the projection to your specific county(ies). 

3. Click the Save Button. 
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4. The Toolkit Information message will display the GIS Tools preferences have been saved. Click OK. 
 

 
 

 

 

 

 

 

Choice Lists Tab 

The Choice Lists tab is used to set up the NRCS Land Use and Programs you will use in Toolkit. By default, 
all NRCS Land Uses and Programs are selected. 
 
1. Click the Choice List tab.  

2. To update NRCS Land Uses, unselect any NRCS Land Uses you do not use. This sets up the choice list 
available in the in the Land Unit Attribute Tool. 

3. Click the Save button. 

4. The Toolkit Information message will display “Choice Lists NrcsLandUseList preference changes have 
been saved”. Click OK. 
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5. To update the Programs, unselect any Programs you do not use. Or, use the “UnSelect All” button 
and then check/select the Programs that you do want to use. This sets up choice lists used in the 
Programs column on the Practice Schedule. 

 

 

 

 
 

 

 

 

 

6. Select the Save button. 

7. The Toolkit Information dialog will display “Choice List ProgramsList preference changes have been 
saved”. Click OK. 

Custom County Data Management Tab 

The Custom County Data Management tab is used to set up county(ies) you will use in Toolkit. If you 
have permissions to multiple states/counties, they will be available from the permissible Counties pick 
list. The more counties you select the longer it will take to download customer folders. It is 
recommended that you select only the county(ies) you will use on a regular basis. 
 
1. Click on the Custom County Management tab.  

2. Click the State dropdown list and select a state. 

3. Click one or more counties. 

4. Select the Update/Save button. 
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5. The Toolkit Information message will display the “Custom County Data Management preference 
changes have been saved”. Click OK. 

6. Repeat steps 2-5 if you need to add permissions for multiple states. 
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Task Guide 5 - Managing Customer Data 
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Toolkit uses the customer folder to organize client’s land, conservation plans and documentation. 
Clients may have one or more customer folders in each county and may have customer folders in 
multiple counties and states.  Customer Folder Tabs (Check In/Out Tab and Folders Tabs) allow for 
managing the customer folder between NPAD, the local service center server and Toolkit Users 
computer.  Once a customer folder is checked out, the Toolkit Users can begin working with the 
customer folder to manage customer specific data, i.e. associated customers/decision makers, 
assistance notes, practice schedules, writing plan and contracts, creating maps and setting plan approval 
dates. 

Customer Folder Tabs 

Check In/Out Tab 

The Check In/Out tab allows planners to check in/out customer folders from the National Planning 
Agreements Database (NPAD). 
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Searching NPAD  

A planner can search for specific customer folders by state and county. If multiple counties are available 
in Preferences, they will show up in the county dropdown list. A county must be selected before 
additional criteria can be searched. If the default county checkbox is set on the Field Office Tab in 
Preferences, than that county will the initial county name populated in the dropdown list. 
 

 

 
  

 
Search Options and Descriptions: 

County County where the servicing office is physically located for a customer. The 
choice list is limited by toolkit permissions and your counties selected in 
Toolkit Preferences. 

Cust-Bus Name Customer or business name. To search for a customer or producer, enter all or 
part of a name. For example, entering “Robert” will return a list of all folders in 
the selected county that contain “Robert” in either the Customer or Business 
Name or in the Customer Folder Name. This will also return any/all folders 
where “Robert” is part of the name of the Decision Maker or Associated 
Customer (helpful for finding folders that need to be updated for Conservation 
Client Gateway (CCG)). 

Bus ID Business Identifier. When performing a search on Bus ID, enter all or part of 
the Business ID. For example, a search containing “CSP” will return all 
customer folders for that county whose Business ID contains “CSP”. 

Tract Number Tract number of the Planned Land Unit to be searched. Searching by Tract 
Number will return any and all folders where that specified PLU tract number 
is present in the NPAD database (the Case PLUs layer). 

Clear Clear the search criteria. 
Go Begin a search. 
Advanced Search Query customer files based on program, practices, planned dates and/or 

applied dates. Options for easement folders include search by coorperating 
entity, easement number, easements not reviewed. A query can be based on 
one or more of these criteria. 
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Advanced Search 

Advanced Search allows the user to search for Customer Folders based on one or more criteria. This is 
also a how you could find folders that contain a specific scheduled practice; helpful during CSP renewals 
to find impacted clients. To start the search, select the appropriate county and click the Adv Search 
button. 
 

 

 
 
  

 
The Advanced Search dialog opens. 
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Advanced Search Field Name Descriptions: 
Associated 
Customer 

Search for an Associated Customer that is saved within a customer folder, either as 
decision maker or associated client. If you enter a name and you want to use 
additional criteria, check the box beside “Include Programs, Practices and Dates in 
Query”. 

Programs The Programs list is based on the “Choice Lists” settings in Toolkit Preferences. 
Select a function key to search or remove a program.  

 Search on one or more programs by selecting the program.  
 Remove program(s) from the search criteria. 
 Remove all programs from the search criteria. 

Practices Select one or more practices to include in the query 
then click on the appropriate function key. 

by selecting the practice and 

 Search on one or more practices by selecting the program.  
 Remove practice(s) from the search criteria. 
 Remove all practices from the search criteria. 

Planned Date Search on a Planned Practice Date 
searched at a time. 

or Date Range. Only one date range can be 

Applied Date Search on an Applied Practice Date 
searched at a time. 

or Date Range. Only one date range can be 

Easement 
Options 

Has Cooperating 
Entity 

Check this box to search for easement folders that have a 
cooperating entity. 

Easement Not 
Reviewed 

Check this box to search for easement folders 
easement has not been marked as Reviewed. 

where the 

Cooperating Entity 
Name 

Enter a name or part 
cooperating entity. 

of a name to search for a specific 

Easement Number Enter an easement number or part of the number 
the Easement ID. 

to search by 

Current Query Displays the selected query. 
GO Button that executes the current query. 

returned in the Seach Results. 
A list of folders that match the criteria is 

Clear Clear current search criteria. 
Cancel Close the Advanced Search dialog without running a query of NPAD. 

 

 
  

National Planning and Agreements Database 

A customer folder must be checked out of the National Planning and Agreements Database (NPAD) in 
order to be used in Toolkit. 
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NPAD Field Descriptions: 
Status Shows the current status of a customer folder. Possible statuses are:   

 Locked by another Toolkit user. If you try to check out a file in this 
status it will check out as read-only. 

 Locked by ProTracts. 

 Locked by YOU. 
<blank> File is free for checkout. 

Owner User that has the file checked out. Free indicates the file is available for check out. 
Servicing Office Service Center office that the Customer Folder is administered by. If this shows up 

as “Unknown” you do not have the servicing office county checked on your 
Custom County Data Management Tab in Preferences. 

Last Check In Date the folder was last checked into NPAD. 
Customer Name Customer Name/Decision Maker for the customer folder. 
Customer File Customer Folder Name.  his is comprised of the Customer/Business name and the 

Identifier that was entered at the time of folder creation. The Customer/Business 
name could be different than the current customer name. 

 
Once a search is complete, a list of customer folders is displayed.  
 

Check In/Out Buttons 

After a customer folder is selected, the planner selects the specific button to complete the check in/out 
process: 
 
Check In/Out Button Descriptions: 

 
  

 
Check out customer file(s) from NPAD and the Field Office server. More than one folder 
can be checked out at a time. 

 Check selected file(s) back into NPAD and Field Office server. 

 Check in all customer folders that are in “write” status. 

 Clears the query results from the NPAD window. 

 

Checks out a customer folder from NPAD only (database files only). It will not check out 
files from the Field Office server. A blank Toolkit ArcGIS template is included in the 
check out to open ArcMap and access the ArcMap Toolkit Toolbar. At folder check in, 
the map document or any other files saved in the folder will not be saved to the Field 
Office server. 

 
Cancel a check in or check out that is in progress. This button is only active during an 
active check in/out. 
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My Checked Out Folders 

 
After a customer folder is checked out, the customer is displayed and available for use in Toolkit and 
ArcMap. 
 
My Checked Out Folders Field Name Descriptions: 

Status The current status of a checked out customer folder; The folder may be in read, 
read-only or in write status. 

 Active folder in write status, you have the NPAD lock. A folder must be 
in “write” status to make any changes, and to be able to check the 
folder back into NPAD. 

 Read-only, folder lock was released. ** 

 Read-only, file was locked by another user when checked out. ** 
Owner User that has the file checked out. If you have a read only folder that another user 

had checked out ( ), this column will show that users’ name. 
Servicing Office Service Center office that the Customer Folder is administered by. If this shows up 

as “Unknown” you do not have the servicing office county checked on the Custom 
County Data Management Tab in Preferences. 

Last Check In Date the folder was last checked in. A read-only status folder will display the date 
the folder was checked out as read-only or the date the folder lock was released. 

County County, state, and state abbreviation that the folder is checked out from i.e. This is 
helpful when you have permissions to multiple counties or states. 

Customer Name Customer Name/Decision Maker for the customer folder. 
Customer File Customer Folder Name. This is comprised of the Customer/Business name and the 

Identifier that was entered at the time of folder creation. The Customer/Business 
name could be different than the current customer name. 

 
** Note: Read-only folders cannot be checked back in. To remove a read-only folder from this window, 
use the Delete read-only folder from hard drive button  located on the Folders Tab. 
 

Tutorial:  Check out a Customer Folder 

1. Start Toolkit by clicking on the Toolkit shortcut on your desktop or clicking Start > All Programs > 
Customer Service Toolkit > Toolkit. 
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2. On the Check In/Out tab, select the County from the dropdown list. Enter any other search criteria 
(optional) and click the Go button. 

 

 
 

 

 

 

 
 
 

3. If prompted, log in through USDA eAuthentication. 

4. From the list, locate and highlight the Customer File you want to work with and click the Check Out 
button. 

 
When the check-out process is complete, the folder appears under the “My Checked Out Folders” 
section. 
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Folders Tab 

To work on a folder or access the Toolkit Customer Folder tabs (with the exception of the Check In/Out 
tab and Folders tab), begin by checking out a customer. Once the customer is checked out, select the 
customer from the Folder tab (or double-click from the list of My Checked Out Folders from the Check 
In/Out tab). Then, open the folder in order to view, add, or edit customer information. 
 

 

Folder button descriptions: 

 
Create New Customer 
Folder  

See detailed description 
tutorial. 

in the Create a New Customer Folder 

 Open Customer Folder  Only one customer folder can be open at a time. To open a customer 
folder, select a folder by clicking on the row to highlight it and then 
select Open Customer Folder. You can also open a customer folder by 
double-clicking on the row on the Folders tab or under “My Checked 
Out Folders” on the Check In/Out Tab 

 Redo Check Out 
Folder  

of Use this button with extreme caution. Redo Check Out will overwrite 
the files saved on your computer for this customer folder. 

 Delete a Read-Only 
Folder (from your 
workstation)  

A folder can only be deleted if it is in read-only status . To delete a 
folder, select it by clicking on the row to highlight, then click the 
“Delete a Read-Only Folder” button. 

 Check In a Customer 
Folder (from the 
Folders tab)  

To in a customer folder, select a folder by clicking on the row to 
highlight, then click the Check In a Customer Folder button. You can 
also check in a folder using the Check In button on the Check In/Out 
tab. 

 Rename Customer 
Folder  

You may rename a customer folder if the customer/business name or 
identifier have changed. To rename a customer folder, select a folder 
by clicking on the row to highlight, then click the Rename Customer 
Folder button to open the dialog:  
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Enter changes to the Customer/Business and/or Identifier and click 
OK. Click Cancel if you decide not to rename the folder. 

 Rename Plan  To rename a plan, select a folder by clicking on the row to highlight, 
then click the Rename Plan button to open the dialog:  
 

 
 
Select the plan name you want to change from the drop- down menu 
then type the new plan name below it.  If you want to rename more 
than one plan, click Apply; otherwise click OK to make the change. 
Click Cancel if you decide not to rename the plan. 

 Change 
County/Servicing Office  fold

To change the county the customer folder is managed from, select a 
er by clicking on the row to highlight, then click the Change 

County/Servicing Office button to open the dialog:  
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Select the new county and new servicing office (if applicable) from 
the dropdown menus. (Note:  your selections will be limited by your 
Toolkit preference settings.) Verify the endpoint is correct for the 
new county (i.e. the server name is correct), it should auto-populate 
based on the new county selected. In cases where a county has more 
than one endpoint (i.e. multiple offices service the new county), a 
dropdown menu will appear. Select the appropriate endpoint from 
the dropdown menu. If you have any questions on this setting, 
contact your Toolkit Coordinator. 

 

Features Available on the Folders Tab by User Type 

Users with Read/Write/All permissions will have more buttons available on the Folders Tab than users 
with Read/Write or Read Only permissions: 
 

Read/Write/All         

Read/Write and Read Only       
 

Tutorial:  Create a New Customer Folder  

If a customer does not exist, you must create a new customer folder. 
 
1. Start Toolkit. 
 
2. There are 2 options to open the New Customer Folder dialog: 

a) On the Toolkit Main menu, click File > New Customer 
 

 
 

b) Click the Create New Customer Folder  button which is located at the upper left of the 
Toolkit screen and on the Folders tab. 
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3. Select the Customer Folder type. The default selection is Conservation folder. To create an 
Easement folder, select the Easement radio button. See Task Guide 30 - Easement Land Unit Tool for 
instructions on creating an Easement folder. 

 

 
 

 

 

 
 

 
  

4. The SCIMS Browser opens. If prompted, log in through eAuthentication. 

5. Enter a LastSearch for a SCIMS Client. Select the Appropriate State and County, and additional 
Location information as desired. Under “Name” note there is an option to search by “Starts With” or 
“Exact Match”. 

6. When finished, click Search. 
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7. In SCIMS, select the customer to create a folder.  
Note:  If the customer is not listed in SCIMS, you must have FSA enter the customer information. 

 

 
 

 
 

A new dialog will open to enter the remaining information required to create the folder. 
 

8. Select the County where the servicing office is physically located. 
Note:  If you incorrectly select a county here the folder will be created on a server that you 
potentially do not have access to. 

 
9. The Servicing Office and Customer Root Folder will populate based on the county selection. For 

Counties that have more than one Service Center, verify that the correct Service Center and 
Endpoint are selected. If needed, select the correct option from the dropdown. For the Endpoint, 
the dropdown will only appear if more than one endpoint exists for that county. 

 
10. Name the Customer Folder by entering the Company/Business and Identifier. 
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11. Select the Appropriate ArcGIS Template if applicable (a dropdown list will appear only if more than 
one template is available). 

 

 

 

 
 

 
 

12. Verify the County, Customer Root Folder, Customer/Business and Identifier are correct, then click 
OK. 

13. Once the folder is created it will be added to your list of customer folders. 

Working With a Customer Folder  

General Tab 

The following features are available on the General Tab:  Add Associated Customer, Edit/Delete 
Associated Customer, Change Decision Maker and Add to Outlook Contacts.  
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Note:  In Toolkit, customers (Decision Makers and Associated Customers) can be associated at the plan 
level. However, in order to associate someone to a plan, they must first be added to or associated with 
the customer folder through the General tab. 
 

Add Associated Customer 

The Add Associated Customer button allows you to add an associated customer to a customer folder. 
Typically, an associated customer is someone who has an interest in the land but is not the land owner, 
such as the operator. 
 
1. Click the Add Associated Customer button. 
 
2. The SCIMS Browser will open. If prompteed, log in through eAuthenticate. 
 
3. Search SCIMS to find the appropriate customer. 
 
4. Select the customer from the SCIMS search results. 
 
5. A confimation window opens, select one of the following options: 
 

 
 

 

a. If you selected the wrong customer, click the Return to SCIMS button. 
b. If you do not want to add this person (or any person) click Close. 
c. If you have the correct customer, check the Make this participant Decision Maker if desired, 

then click OK. 

Edit/Delete Associated Customer 

The Edit/Delete Associated Customer button allows you to edit (change the decision maker) or delete an 
associated customer tied to a customer folder.  
 
1. Click the Edit/Delete Associated Customer button. 
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2. The Delete Associated Customer dialog opens, select one of the following options: 
 

 
 

 

 

a. To delete an associated customer, select the customer and click the Delete Associated 
Customer button. In the Toolkit Information window, confirm the delete. 

b. To change the decision maker, select the decision maker by clicking the gray box to the left of 
their name. Click the Change Decision Maker button. This will update the decision maker and 
close the dialog. 

c. Click Close to close the dialog without making changes. 

Add to Outlook Contacts 

This allows you to add the customer contact information to your Outlook Contacts. When you click the 
Add to Outlook Contacts button, you will then be prompted to confirm the addition. 
 

Assistance Notes Tab 

The Assistance Notes tab provides a location to Create, Delete, and Open Conservation Assistance 
Notes, as well as create Reports. Assistance notes can be Sorted for a customer folder. The notes are 
checked into NPAD along with the other tabular data in the customer folder and therefore can be 
viewed or shared with other conservation planners. 
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Create New Note 

1. Click the Create New Note  button to open the New Assistance Notes dialog and enter technical 
notes. The planner’s name and date are populated by default. 

 

 

 
 

 

 

 

 

 

2. In the New Assistance Note dialog, select the appropriate program code from the drop-down list 
(optional). 

3. Type the assistance note in the window. You may add as much text as needed and the text area will 
scroll as needed. 

4. Check the spelling by clicking the Check Spelling button before saving or adding the note to the 
customer file. 

5. If you only have the one note to enter, click Save to finish the note and close the dialog. 

6. If you have multiple assistance notes to enter, click the Add New Note button to save the note to 
the customer file and start a new one. When you are finshed with the final note, click the Save 
button to save and close the dialog. 

Delete Note 

1. Select the assistance note you want to delete and click the Delete Note  button. 
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2. Click Yes to confirm the deletion of the assistance note. 
 

 

 
 

 

 

 

 
 

  

Open Note 

1. Select the note you want to open and click the Open Note  button to open the notes dialog. 

2. Click the Edit button to edit the note. 

3. Edit the assistance note as needed and when finished, click Save. 

Reports 

1. To print assistance notes, click the Report  button. 

2. In the Assistance Notes Report dialog, select the assistance notes that you want to view or print. 
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3. Click the Report button to view the selected notes in the Assistance Notes Report. 
 

 
 

 

 
 

 

 
 

 
 
  

4. Click the Printer  button at the top of the dialog to display the assistance note in Word. 

5. Click File for other printing options. Both the Print and Print Preview options open the report in 
Word. 

Sorting Assistance Notes 

On the Assistance Notes tab, you may have many notes within a given customer folder. To sort the 
notes, click on the heading of the column you want to sort by. 
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Practice Schedule Tab 

The Practice Schedule tab is used to plan new full extent practices, modify practices, apply practices, 
cancel practices and delete alternative practices. After selecting a plan, the Land Units are displayed and 
can be sorted by Tract/Land Unit or by Land Use. The Practice Filter button can be used to select which 
practices are displayed on the Schedule. The Plan Wizard and Contract Wizard buttons open the dialogs 
to create plan or contract documents and the Plan Approval button is used to enter the approval date 
once the plan has been signed. For more information, see Task Guide 32 - Practice Schedule. 
 

 
 

Customer File Tab 

The Customer File tab allows you to view, access, and/or delete the contents of the customer’s file 
(which is saved to the endpoint (Field Office server) when the folder is checked in). Toolkit uses a 
standard customer file directory structure to provide default paths and names for files created using the 
Toolkit tools (e.g., the Plan and Contract Wizards and Toolkit toolbar). 
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Customer File Folder Organization 

To promote consistent management of customer files, Toolkit uses a standard customer file structure.* 
 

 Each customer/business has a customer file. 
 The customer file name is the company name followed by a Business ID. 
 The business ID is padded with leading hyphens to equal 12 characters. 

 
Many Toolkit tools provide default file names and paths that can be changed if needed. The following 
table displays documents and data that are typically stored in the customer file. For additional 
information, see the more detailed explanation of each section following the table. 
 

Subfolder Customer Documents 
ArcGIS_Projects  

 
 

Toolkit ArcGIS map document files 
ToolkitGIS_template.mxd (ArcGIS project template file) 
Map product information specific to maps created for the customer 

Toolkit Symbology  Housed under ArcGIS_Projects, this folder contains the layer (.lyr) files 
that tell Toolkit how to display ArcGIS Toolkit information, such as Case 
PLUs and Active PLUs 

ArcView_Projects  
 

Only present in older Toolkit Folders 
Archived Toolkit/ArcView project files (.apr files) 

Contract_Reports  
 

Contract spreadsheets 
Other contract-related documents 

 Status review documents 
Determinations  

 
Wetland determination spatial data 
Digital photos 
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 GPS data related to determinations 
 Transmittal letters for HEL determinations 
 Other determination-related documents 

Engineering  CAD or survey data and designs 
 Digital photos 
 Engineering-related documents 

GSAT  Grazing land Spatial Analysis Tool (GSAT) Data 
Plan_Maps  Legacy Access databases and shapefiles formerly used for planned, 

alternative or benchmark land units and practices 
Plan  Housed under Plan_Maps, this folder can contain exported Plan Map 

Products Documents (.pdf), legacy Conservation Plan (Access) 
databases, plan shapefiles and attribute files, and other files 

Benchmark  Housed under Plan_Maps, this folder can contain exported Benchmark 
Plan Map Products documents (.pdf), legacy Benchmark Plan (Access) 
databases, benchmark shapefiles and attribute files, and other files 

Alternative  Housed under Plan_Maps, this folder can contain exported Alternative 
Plan Map Products documents (.pdf), legacy Alternative Plan (Access) 
databases, alternative shapefiles and attribute files, and other files 

Plan_Reports  Conservation plan spreadsheets 
 Other conservation planning documents 

Resource_Maps  Soils maps 
 Site-specific resource spatial data 
 GPS data for resource inventory 
 Digital photos 
 Clipped resource maps 
 Exported Layouts from Toolkit/ArcView 3.x Projects 

 
*Additional folders/subfolders may be present under some Customer folders due to local 
customizations. 
 
ArcGIS_Projects 
Map documents must be accessed via the Customer File tab. When the ArcGIS_Projects folder is 
highlighted, available map documents (.mxd files) are displayed on the right. Double click on a .mxd file 
to open it in ArcGIS. 
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ArcGIS_Projects/Toolkit_Symbology 
The Toolkit_Symbology folder stores layer (.lyr) files. These files are used to specify to ArcMap how to 
display the layers in an .mxd project. When you save the symbology within ArcMap, those changes are 
automatically saved to the .lyr file and the next time you use that layer within this customer folder, it 
will be symbolized the same. 
 
Note:  These files may occasionally become corrupt and incorrectly symbolize the data (i.e. Active PLUs 
displays as a single solid color). In these cases you need to delete the corresponding .lyr file and the 
default symbology will regenerate when you re-open the .mxd file. 
 

 
 

 
  

ArcView Projects (Only present in older Toolkit Folders) 
The ArcView_Projects folder is only present in older Toolkit folders.  It stores the legacy ArcView projects 
that were created in earlier versions of Toolkit. 
 
Contract_Reports  
To access contract documents, click the Customer File tab and then select the Contract_Reports folder. If 
the customer has conservation contract documents saved in the file, the Microsoft Excel files will be 
displayed on the right. View a saved contract by double-clicking on a file to open it in Excel. 
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Determinations 
Spatial data, photos and letters about determinations are saved in the Determinations folder. 
 

 
 

 
 

 

Engineering 
The Engineering folder may contain CAD or survey data, engineering-related documents, or digital 
photos. These may be used in ArcGIS as well as other engineering software. 
 

GSAT 
The GSAT folder stores data used by the Grazing land Spatial Analysis Tool (GSAT). 
 
Plan_Maps 
The Plan_Maps folder may contain a variety of data and information about a customer’s conservation 
plan. The Plan_Maps folder is typically used to store exported Map Products Document Plan Maps (i.e., 
“Consplan.pdf” maps). New plan data (including land units and conservation practices) created with 
Toolkit will be stored in NPAD.  
 
The following table lists the three Plan_Maps subfolders folders and their respective contents. 
 

Plan_Maps/Plan folder Contents 
Plan  Legacy Conservation plan Access database 

 Plan shapefiles and attribute files 
 Data, images, text files, etc. 

Benchmark  Legacy Benchmark Access database 
 Benchmark shapefiles and attribute files 
 Data, images, text files, etc. 

Alternative  Legacy Alternatives Access database 
 Alternatives shapefiles and attribute files 
 Data, images, text files, etc. 
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Plan_Maps/Plan 
The Plan_Maps/Plan folder contains the archived database(s) that were created in Toolkit versions 4.1 
and earlier. The databases include land units, planned and applied practices and cost-share program 
information. Other data such as Global Positioning System (GPS) and digital photos related to the 
customer’s conservation plan may also be saved in this folder. 
 
Plan_Maps/Benchmark 
The Benchmark folder contains archived copies of the Microsoft Access database created using Toolkit 
4.1 named benchmrk.mdb. Benchmark land units and practices created in Toolkit 2004 are stored in the 
NCPDB. 
 
Plan_Maps/Alternative 
The Alternative folder contains archived copies of the Microsoft Access database created in Toolkit 
versions 4.1 and earlier. Alternative land units and practices created using Toolkit 2004 are stored in the 
NCPDB. 
 
Plan_Reports 
To determine if a customer has a saved conservation plan, click on the Plan_Reports folder. Existing plan 
documents are displayed in the right pane. To view a saved plan, double-click on the file to open it in 
Excel. Other planning-related information and transmittal letters may also be saved in this subfolder. 
 

 
 
Resource_Maps  
The Resource_Maps folder may contain saved shapefiles, such as soils and soil interpretations, site-
specific resource inventory, or GPS data. The Resource_Maps folder may also be used to store exported 
Map Products Documents (.pdf maps), such as resource maps, soils maps, etc., for Resource Inventory 
purposes. 
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Customer File Tab Buttons 

The Customer File tab buttons allow the user to select how project files are displayed and to delete, 
change, add, or refresh files. 
 

 
These are the buttons available on the Customer File Tab: 
 

 
View Details:  Displays files in 
detail view (this is the default view)  

 
View Icons:  Displays files in icon 
view  

 View List:  Displays files in list view  

 
Delete File(s) or Folder:  Allows the user to delete the selected files or folders. When nothing is 
selected or a file cannot be deleted, the button will not be active (red). 
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Change/Add ArcGIS Template:  Allows the user to change or add a ArcGIS template file (.mxd) 
to the ArcGIS_Projects folder. 

 Refresh Folders:  Refreshes the folder view and collapses the customer file’s subfolders. 

Plan Approval Tab 

The Plan Approval tab was removed in Toolkit 9. This functionality is now accessed using the Plan 
Approval button, located on the Practice Schedule tab. See Task Guide 35 - Plan Approval for more 
information. 
 

Changing Customer Folders with ArcMap Open 

It is possible to move between customer folders when ArcMap is open; however any changes you made 
in the open map document will not be saved when switching folders. The following message will display 
when opening a new customer folder, prompting the selection of a .mxd file from the new customer 
folder. 
 

 

 

 
To change customer folders and leave your current .mxd file without saving: 

1. Select the .mxd file you wish to open. 
2. Click OK. 

 
To return to ArcMap and save the open .mxd file without changing customer folders: 

1. Click Cancel. 
2. Return to ArcMap and Save the .mxd file. 
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Task Guide 6 - Folder and Data Management 
 

 

 

  

Contents: 
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Release Folder Lock .................................................................................................................................... 9 
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Reload Domain Data ................................................................................................................................. 13 
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Main Menu > Tools > Export Customer Data ........................................................................................... 15 

Main Menu > Reports > Customer Folders Report .................................................................................. 16 

Main Menu > Help > Contents ................................................................................................................. 16 

Modify Folder/Plan Status 

The Modify Folder/Plan Status is used to update the status of customer folders and plans and to set plan 
visibility in Client Conservation Gateway (CCG). 
 

 
Business Rules: 

• Customer Folder and Plan status are changed manually. 
• Customer Folder is not checked out to make changes. 
• When a plan is deleted, cancelled or completed, the plan is not available for check out. 
• When a customer folder is deleted, the folder is removed from Check In/Out, but not from the 

field office server. 
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Status Codes Applies to Plan Applies to Customer Folder 

Active Yes Yes 
Completed Yes NA 
Cancelled Yes NA 
Deleted Yes Yes 

 
Status codes marked ‘Yes’ for both plan and customer folder can be applied at both the plan and folder 
level. A plan can be completed without marking the entire folder as complete. A plan can be deleted 
without marking the entire folder deleted, etc. 
 

Plan Status Rules 
Active 

1. Plans shall remain Active as long as the plan is not manually changed to cancelled, completed 
or deleted. 

2. All plans automatically receive an Active status at the time of plan approval. 
3. Plan and practice information are able to be reported. 
4. All active plans are available for check out. 
5. All land units are in the Active or Legacy PLU Layers (if plan was migrated from NCP). 

Completed 
1. No further work is expected on completed plans. 
2. Unable to move plan status to completed when: 

a. Plan is linked to Protracts contract(s) that has an Active contract status. 
b. Plan is linked to a CSP Plan. 
c. There are any practices that are not applied. 

3. Completed plans are not included in the search for the customer folders and are not allowed 
to be checked out. 

Cancelled 
1. No further work is expected on cancelled plans. 
2. Unable to move plan status to cancelled when: 

a. Plan is linked to Protracts contract(s) that has an Active contract status. 
b. Plan is linked to a CSP Plan. 
c. All practices are applied. 

3. Cancelled conservation plans are not included in the search for customer folders and are not 
allowed to be checked out. 

Deleted 
1. Deleting a plan is not allowed if there is a plan approval date. 
2. All practices are deleted from NPAD and not available for reporting. 
3. All land units remain in the Active or Legacy PLU Layers. 
4. Deleted plans are not included when the customer folder is checked out again. 
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Customer Folder Status Rules 
Active 

1. All customer folders default to an Active status at the time they are created. 
2. The customer folder will remain ‘Active’ as long as there are any plans in Active status. 

Deleted 
1. Customer Folders can only be deleted if there are no plans with Active status and no land 

units in the folder’s Case PLU Layer. 
2. Customer Folders data from the Field Office Server are not deleted. 

 
Plan Status Changes 
 
Modify Plan Status 
 
When changing the status of a plan, the customer folder must not be checked out. This is to ensure that 
any changes made to the customer folder have been transferred to NPAD prior to changing the status of 
the plan. 
 
1. Open Toolkit. 
 
2. In the Customer Service Toolkit window, search for Customer Name, Business ID or by Tract Number 

and click Go. 
 
3. Login to eAuthentication. 
 
4. On the Toolkit Main Menu, click the Check In/Check Out tab. 
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5. Click on row containing the customer folder (do not check out folder). From the Toolkit main menu, 
select File>Modify Folder/Plan Status. 

 

  
 

 

 

 
 
  

6. In the Modify Folder or Plan Status dialog, select the Plan, change the plan status to Completed, 
Cancelled, or Deleted as needed, and click the Modify Plan Status button. 
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7. In the Confirm Change dialog, click Yes to continue. 
 

 
 

 

 

8. In the Toolkit Information dialog, click OK to “Plan Status Change Successful”. 

 
Customer Folder Status Changes 
 
Delete a Customer Folder 
 
When changing the status of a Customer Folder the Customer Folder must not be checked out. This is to 
ensure that any changes made to the Customer Folder have been transferred to NPAD prior to changing 
the status of the Folder. 
 
1. Open Toolkit. 
 
2. In the Customer Service Toolkit window, search for Customer Name, Business ID or by Tract Number 

and click GO. 
 
3. Login to eAuthentication. 
 
4. On the Toolkit Main Menu, click the Check In/Check Out tab. 
 
5. Click on row containing the customer folder (do not check out folder). From the Toolkit main menu, 

select File>Modify Folder/Plan Status. 
 
6. In the Modify Folder or Plan Status dialog, click the Delete Folder button. 
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7. In the Remove Folder dialog, click the Yes button to continue. 

8. In the Toolkit Information dialog, click OK. 

 
The Folder should be removed from the Check In/Out tab, but the customer folder on the server should 
still be available. 
 
Note:  The system will alert the user if a folder cannot be deleted because there are Active plans and/or 
Case PLUs in the folder. 
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Conservation Client Gateway Plan Visibility Changes 
Make a Plan Viewable in CCG 
 
When making a plan viewable in CCG from the Modify Folder or Plan Status menu, the Customer Folder 
must not be checked out. This setting can also be changed from the Plan Approval dialog when the 
folder is checked out. 
 
1. Open Toolkit. 
 
2. In the Customer Service Toolkit window, search for Customer Name, Business ID or by Tract Number 

and click GO. 
 

 

 

 

 

 
 
  

3. Login to eAuthentication. 

4. On the Toolkit Main Menu, click the Check In/Check Out tab. 

5. Click on row containing the customer folder (do not check out folder). From the Toolkit main menu, 
select File>Modify Folder/Plan Status. 

6. In the Modify Folder or Plan Status dialog, select the Plan, check the Make Plan Viewable in Client 
Gateway checkbox, and click the Save button. 
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Force Release NPAD Folder Lock 

If for some reason, another person's lock must be released (e.g., someone left for vacation without 
checking in a folder), the lock can be released by the state Toolkit/GIS coordinator or by another person 
who has the “all” permission in zRoles. 
 
Warning:  When a folder lock is released, all updates to the customer folder that were made by the 
person who originally checked out the folder are lost and cannot be restored. Only release a lock if (1) 
you know that the user has not made substantial updates to this customer folders since checking it out, 
or (2) you know what changes have been made but the user will be unavailable for some time and you 
need to work on this folder now. In the latter case, you realize that some work on this customer folder 
(including maps) may need to be re-done. 
 
1. To release another user’s folder lock, select File>Force Release NPAD Folder Lock from the main 

Toolkit menu. 
 

 
 

 
 

2. All locked folders for the county selected are displayed in a dialog box. Select the customer folder, 
and click OK. 
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3. In the Toolkit Warning dialog, click Yes to unlock the customer folder. 
 

 

 
 

 

 
 

 

 
The customer folder status will change to "free" and the folder will be available for check out. 
 

Release Folder Lock 

To release the lock on a customer folder that you have checked out, complete the following steps. 
 
1. From the Folders tab, highlight the customer folder. 
 
2. On the Customer Service Toolkit Main menu, click File>Release Folder Lock. 

3. A Toolkit Information dialog message informs you that this folder cannot be checked in once the 
lock is removed.  Click OK to continue, or Cancel to exit. 
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The status of the customer folder changes from write to read-only. The customer folder status will 
change to "free" and the folder will be available for check out. 
 

Use Local Folders 

There may be situations where the customer file that is on your C:\ drive under “My Customer Files 
Toolkit” has the most current updates, but you are not able to check the folder in. This may occur if your 
computer crashes and you no longer have a lock on the customer folder. Or your lock on a folder was 
released by accident, and you want to preserve those changes that you have already made. In some 
cases, Toolkit may not recognize the customer folder on the endpoint server, and you need to copy that 
to your local server. In these situations, you can employ the Use Local Folder button. 
 
For example:  
 
1. You have the folder on your list of “My Checked Out Folders” tab, but it is read only, and you cannot 

re-establish the lock. 

2. The changes made are significant and you do not want to try to recreate them. Copy the folder from 
your “My Customer Files Toolkit” folder on the C:\Users\username\ path, and paste it somewhere 
else. 
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3. Delete the read only folder from Toolkit.   
 

 

 
 

 

 
 

 

 

 
 

4. Check out the customer folder again. 

5.  Delete the customer folder from your “My Customer Files Toolkit” folder, then copy and paste the 
previously saved customer folder to your “My Customer Files Toolkit” folder. 

6. In Toolkit, open the folder and ensure that the Customer Files documents are there. Click on File > 
Use Local Folder, and it will set the folder. 

7. In the Toolkit Information dialog, click OK to proceed and Toolkit will immediately copy the 
customer file to the endpoint server and check the folder back in. 

Delete Unassigned Folders 

To delete a customer folder on a given endpoint that does not have any associated records in NPAD, 
following these instructions. 
 
1. On the Toolkit main menu click File > Delete Unassigned Folders. 
 
2. In the Delete Unassigned Folder dialog, select the county, then click Go to search for unassigned 

folders. To search for a specific folder, enter the text (e.g. a customer name) in the Find box and 
click Go. 



Task Guide 6 P a g e  | 12 September 16, 2016 

 

 
 

 

 
 

3. To view the unassigned folders for a given endpoint, click the plus sign (+) in front of the server 
name in the search results list. The results list will expand to show all the folders that are not 
associated with an existing record in NPAD. In this example, there was one unassigned folder 
containing the text “demo” found on this endpoint. 

4. To delete an unassigned folder, select the folder by checking the checkbox to the left of the folder 
name and then click the Delete Selected Folders button. 

 
Deleting an unassigned folder will remove the customer file from the endpoint. This should only be done 
after it has been determined that this customer data will not be needed in the future. 
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5. In the Toolkit Information dialog click OK to “Deleted files will be moved to a temporary folder on 
the file share in the toolkit backup location; a system administrator will need to physically delete the 
temporary folder. 

6. The list of folders in the Unassigned Folders List block will refresh and confirms that the selected 
folder has been deleted from its endpoint. Close the Delete Unassigned Folders dialog. 

Reload Domain Data 

Domain data is reference data stored in database lookup tables that is used by Toolkit (and other 
applications). Common examples of domain data include practice narratives and conservation 
standards.  
 
The Reload Domain Data feature allows the latest changes made to your domain data to be downloaded 
to your workstation. For instance, if your practice narratives were recently modified in the Conservation 
Practice Standards (CPS) Web application, you will need to use this feature to see the changes in Toolkit. 
 
To reload your domain data: 
 
1. Click on File > Reload Domain Data on the Toolkit main menu. If prompted, enter your 

eAuthentication user id and password. 
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2. Click OK and allow the synchronization to complete. 
 

 
 

 

 

 

 

 
 

3. After the refresh is complete, click OK in the Toolkit Information window and restart Toolkit to finish 
the update. 

Lock Folder 

1. If you checked out a customer folder and accidently released the folder lock after making changes to 
the folder or if for some reason a customer folder you are working on changes unexpectedly to 
“read only”, you can attempt to relock the folder so that you can check it in to NPAD. 

2. Highlight the read-only folder in your My Checked Out Folders list. Click File > Other Tasks > Lock 
Folder. 
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3. A Toolkit Warning dialog is displayed warning you that the customer file on your computer will 
replace the customer file currently in NPAD. Click the OK button to proceed. 

 

 
 

 

 
 

 

 
 

 
 

4. Another Toolkit Warning dialog may appear if NPAD contains more recent data. Click the OK button 
to proceed or Cancel to stop. 

5. Toolkit will attempt to relock the folder. The read-only folder in your My Checked Out Folders list 
will switch to “write” status if the lock was successful. 

Main Menu > Tools > Export Customer Data 

Customer Service Toolkit 5 allowed a user to export read-only customer data to XML files and to start 
another application. This feature DOES NOT WORK in Customer Service Toolkit version 9. 
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Main Menu > Reports > Customer Folders Report 

This feature was intended as a tool for Toolkit 5 to check migration of Toolkit folders from Toolkit 4.1 to 
Toolkit 5. It is not intended for use within Customer Service Toolkit version 9. 
 

 
 

 
 

Main Menu > Help > Contents 

The Toolkit Task Guides, Training Videos, Lesson Plans, and other documentation can be accessed by 
clicking Help > Contents. This will open the help menu in your web browser. 
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Task Guide 7 – ArcMap Table of Contents  

The ArcMap Table of Contents displays all information added to ArcMap project. The descriptions 
include only the data and data layer symbology that is checked in/out of NPAD. Other layers that are 
added to the project are saved and checked in/out of the customer folder from the local field office 
server. 

Folder and Plan Symbology 

You will see different symbology depending upon the type of folder and plan you are in. While most of 
the symbology is the same, there are changes between Toolkit 8 and Toolkit 9 such as: 

• Easement Symbology has been removed from the Active PLUs layer. 
• Land units in a CSP plan are displayed as locked. 
• The CStwP plan symbology is displayed the same as a Conservation Plan.  
• National Easement Geospatial (NEG) is the national easement layer that contains closed 

easements and is used to find and reconcile easements within Toolkit. 
• Easement PLUs that have been identified within Toolkit for the easement folder you are 

currently working on. 
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Folder and Plan Symbology 

 
 

Practices 
Symbol Feature Class Definition 

 Points Point practices are where the practice unit is in numbers, acre feet, 
cubic feet or animal unit. 

 Lines Line practices are where the practice unit is in feet, mile and linear 
feet/year. 

 Polygons Polygon practices are where the practice unit is in  acres and 
square feet. 

Land Unit Overlap 
Symbol Topology Rule Definition 

 
 

 
Must Not Overlap 

Overlap rule “Must Not Overlap” is applied to geometry. It can be 
edited using the Edit tool and the overlap is validated upon 
checking in the data. 

Plan Layer 
Symbol View Definition 

 
Plan & 
Digitize 

Plan Layer displays all land units from within the plan with a yellow 
outline. 

Case PLUs 
Symbol View Definition 

 

Plan Displays all land units in the Case PLUs layer with a magenta 
outline for the purpose of printing maps, and differentiating 
between the land units in the selected plan and in the Case PLUs. 

 

Digitize Displays all land units geometry status while editing the Case PLUs 
layer. 

Easement PLUs 
Symbol View Definition 

 
Digitize & Plan Displays the land units identified as the Easement for the 

easement folder from Case PLUs and Active PLUs layers after using 
the Easement Land Units tool. 

NEG (National Easements Geodatabase) Layer 
Symbol View Definition 

 

Digitize & Plan Contains all easements in the NEG layer. Arc Map displays the 
boundary of all easements within the current map view by 
easement program. 
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Active PLUs:  Displays the land units in Case PLUs from other customer folders. Layer is not editable. 
Symbol View Definition 

 

Plan & 
Digitize 

Active PLUs Layer contains all land units that have been checked 
into NPAD that are located outside the Case PLUs but are located 
within the AOI. These land units have the same outline for the 
geometry status but are differentiated by a blue fill.  

Legacy PLUs:  These are land units tied to active conservation plans that were migrated to the Legacy PLU 
layer when Toolkit migrated from NCP to NPAD. Land units must be checked in to continue planning new 
practices. Land Units cannot be created or moved to the Legacy PLU layer. Layer is not editable. 
Symbol View Definition 

 

Plan & 
Digitize 

Legacy PLUs Layer contains all Legacy land units in NPAD that are 
located outside the Customer Folder. These land units have the 
same outline for the geometry status but are differentiated by a 
blue fill. This layer can be turned off/on when you are not using 
the land unit editor.   

History PLUs:  This layer contains the land units and practices tied to Cancelled and Completed plans and 
any land units that have been deleted from the Case PLUs layer that have applied practices. Layer is not 
editable. 

 

Plan & Digitize History PLUs Layer contains all historical land units and practice 
information in NPAD that are located within the AOI. 

Land Unit Geometry Status:  The Land Unit Geometry Status displays the current status of the land unit 
in NPAD. The Land Unit Geometry Status can only be seen by using the Digitizing View in Arc Map. Below 
are the symbols, layers and the business rules that apply to each. 

Symbol Layer Geometry 
Status 

Business Rules 

 Case PLUs Plan • Do not have any errors that need corrections. 
• No other PLUs can overlap.  
• When digitizing PLUs adjacent to the Plan PLU the auto-correct 

feature will snap to a Plan PLU but not change the shape of the 
Plan PLU.   

• When a Case PLUs is edited it is automatically changed to the 
Sketch Status and is checked in when you stop editing and 
save changes. If the land unit cannot be checked into Plan 
status the system will revert back to the original land unit 
shape and the changes will not be saved. 

• Can be added to one or more conservation plans as needed 
through the Create/Open/Manage Plans tool. 

 Active PLU Plan • Used to enforce topology when a land unit is created or edited 
in the Case PLUs. 

• Only displayed if they intersect current AOI.  
• These land units can be added to one or more conservation 

plans as needed through the Create/Open/Manage Plans tool. 
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Land Unit Geometry Status – continued 
Symbol Layer Geometry 

Status 
Definition 

 Case PLUs Locked • Land units can be locked by being in a CSP plan, ProTracts 
contract and identified as an easement land unit and 
reconciled through the easement reconciliation tool (ERT). 

• CSP – When a land unit is added to a CSP plan the land unit is 
locked. The land unit cannot be updated through the land unit 
editor and attribute tool. The land unit must be removed from 
the CSP plan to edit. The land unit remains locked as long as it 
in a CSP plan that is active.  

• ProTracts - Cannot be edited in the Case PLU Layer or attribute 
tool unless the contract is modified in ProTracts. The land unit 
remains locked until unlocked by ProTracts. 

• Easement – When the easement land unit is reconciled the 
outer boundaries of the land units are locked but the interior 
boundaries can be split and merge to create and delete land 
units needed within the easement. The attributes are not 
locked. The easement land unit boundaries can be unlocked if 
needed through the ERT tool. 

• Can be added to one or more conservation plans as needed 
through the Create/Open/Manage Plans tool. 

 Active PLU  Locked  • Land Units in the Active PLU layer with the Locked geometry 
status are used to enforce topology (no overlap) when a land 
unit is created or edited in the Case PLUs. 

• Can be added to one or more conservation plans as needed 
through the Create/Open/Manage Plans tool. 

• Only displayed if they intersect current AOI. 
 Active PLU Easement • Reserved for future use. 

 Case PLUs Legacy • These land units must be checked in if new practices are to be 
planned. 

• Any new land units created will not snap to a Legacy Land unit. 
• These land units cannot be added to other plans through the 

Create/Open/Manage Plans tool. 

 Legacy Legacy  • These land units are outside the current customer folder. 
• Not used for topology checks or snapping to land units that are 

created in the Case PLUs. 
• These land units cannot be added to other plans through the 

Create/Open/Manage Plans tool. 

 Case PLUs Draft • Cannot plan practices or add land unit to others plans through 
the Create/Open/Manage Plans tool. 

• Draft PLUs must be corrected and rechecked in and be in the 
Plan geometry status before a practice can be planned. 

 Active PLU Draft  • Cannot plan practices or add land unit to others plans through 
the Create/Open/Manage Plans tool. 
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• Draft PLUs are not used for topology checks or snapping to 
land units that are created in the Case PLUs. 

 Case PLUs Sketch • When creating new PLUs the auto-complete will snap to any 
Sketch land units in the Case PLUs to ensure overlap errors are 
not created. 

• Sketch PLUs must be attributed and Checked In to change the 
geometry status to Plan. 

• If a Sketch PLU fails at check in the geometry status will 
change to Draft. 

• Sketch PLUs remains in Sketch status until checked in from 
ArcMap. 

• Cannot plan practices or add land unit to others plans through 
the Create/Open/Manage Plans tool. 

 Active PLU Sketch  • Sketch Land Units are not used for topology checks or 
snapping to land units that are created in the Case PLUs. 

• Cannot plan practices or add land unit to others plans through 
the Create/Open/Manage Plans tool. 

 History PLU History • Contains all Historical land units and practice information in 
NPAD that are located within the AOI. 

• When a plan is cancelled or completed the land units are 
moved from the Active PLUs layer to the History PLUs Layer. 

• When a land unit is deleted from the Case PLUs layer, if there 
are any applied practices the land unit is moved from the Case 
PLUs Layers to the History PLUs Layer.  

• History Land units are not displayed with the plan layer. 
AOI 
Symbol Layer Business Rules 

 AOI • Quarter-mile buffer created around the Case PLUs or the Consplan PLUs 
when the customer folder is checked out. 

• Used to enforce topology (error checking) when new land units are added 
or existing land units are edited.  

• AOI editor tool allows you to edit or add a new AOI. 
• All land units must be created within the AOI. 
• If the AOI is edited you must select the AOI button to check out any land 

units in the updated AOI area. 
• All land units added to a plan must be within the AOI. 
• All land units in the AOI are available in the Land Unit Quick Report Tool. 

Base Layer:  The base layer is reference only. It contains all the data checked out from NPAD related to 
the customer folder. It should not be used for editing and should be turned off. 

  practice_instance_point  
  practice_instance_polyline  
  practice_instance_polygon  
  land_unit  
  plan_aoi  
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Task Guide 8 - Toolkit Toolbar 
 
The purpose of this section in the task guide is to identify and explain the functions of the buttons on 
the Toolkit Toolbar. Turn on the toolbar by clicking on the Toolkit Toolbar  button. 
 

 
 

Icon Button Description 

 Zoom to Plan Zoom to the extent of the selected plan. 

 Create/Open/Manage Plans Select an existing plan.  Create a new plan.  Add or remove 
plan land units.  Edit the plan decision maker. 

 Feature Summary Calculate geometry for the selection layer, graphics or total 
acres. 

 Map Products Create a map of the project. 

 Map Labels Create map labels for layers. 

 Soils Map and Inventory Create a soils map and inventory. 

 Buffer Create a buffer for point, line, or polygon features or 
graphics. 

 Attribute Tool Attribute selected features. 

 New Toolkit Layer Create a new point, line, or polygon layer. 

 Refresh AOI Check out an AOI (Area of Interest). 

 Check In Features Check in digitized land units into NPAD and ensures 
topology is met.  Check in digitized practices into NPAD. 

 Change Views Switch between Plan View and Digitize View. 

 Modify Land Units in CSP Plan Select land units from the Active Layer for planning CSP. 

 Land Unit Quick Report Tool Displays all practices, decision makers, customer folders 
and plans for selected land unit(s).  Export Land Use Report. 

 Transfer Tool Transfer plans, practices, practices and land units, and 
documents from one customer folder to another. 

 Toolkit Digitizer Create or edit digitized features. 

 Digitize Off Indicates Edit Mode is turned off. 

 Digitize On Indicates Edit Mode is turned on. 
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 Practice Filter 
Filter Practices displayed in ArcMap by Practice Status, 
Planned or Applied Year, Program Code, Contract #, and/or 
Practice Code. 

 Practice Filter On Indicates practices are filtered. 

 Export Features Export NPAD features (land units, practices) to a shapefile 
or web feature service. 

 Easement Land Unit Select land units from the Active or Case PLU Layers to 
associate to an easement. 

 Easement Reconciliation Review and lock easement land units.  Requires Easement 
Reconciliation role in zRoles. 
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Task Guide 9 - Zoom to Plan Tool 

1. Check out a customer folder. 
 
2. Open the customer folder. 

  
3. Select Customer File>Arc GIS Projects>ToolkitGIS_Template.mxd or other template used in your state 

and open Arc Map project. 

4. Select an existing plan from Create/Open/Manage Plans .  
 

5. To zoom to the extent of the land units in the selected plan, click on the Zoom to Plan  button.  
 
The view will automatically adjust to the full extent of the plan layer.   
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Task Guide 10 - Create, Manage or Open Plans 

 
Contents: 
Business Rules: ............................................................................................................................................ 1 

Select an Existing Plan ................................................................................................................................. 2 

Create a New Plan ....................................................................................................................................... 3 

Add Land Units to a Plan Using the Map Selection ..................................................................................... 4 

Add Land Units to a Plan Using Search ........................................................................................................ 7 

Add Land Units to a CSP Plan ...................................................................................................................... 8 

Remove Land Units from a Plan .................................................................................................................. 9 

Remove Land Units from a CSP Plan ......................................................................................................... 10 

Edit Plan Decision Maker and Associated Clients...................................................................................... 11 

 
Beginning in Toolkit 8, land units are no longer created and associated to a single conservation plan 
since land units are created and edited from the Case PLU layer. The Create/Open/Manage Plans tool 
allows you to select an existing plan, create a new plan, add or remove land units from a plan, and edit 
the clients and decision maker associated to a plan. 

Business Rules: 

• Land units can be added to one or more plans. 
• All plans are active as soon as they are created. 
• The plan decision maker is defaulted from the customer folder decision maker and is editable. 
• Plan associated clients can be selected from any clients associated to the folder and is editable. 
• Client associations can be owner, owner/operator or operator. For easement folders only, 

cooperating entity is available for client association. 
• All plans have only one decision maker but can have multiple associated clients. 
• Land units can be deleted from a plan as long as there are no planned, cancelled, or applied 

practices. 
• Land units must be in the Case PLUs or Active PLUs layer in a Plan or Locked status to be added 

to any plan. 
• Plan must be created before land units can be added to the plan. 
• Land units must be within the AOI to be added to a plan. 
• ProTracts uses the plan decision maker for the upload of contract items to an application.  
• ProTracts does not require the plan decision maker to match the ProTracts contract. 
• Client Gateway uses the plan decision maker for who has control of the plan and practices for 

any actions such as applying a practice. 
• Refer to ProTracts land use check for CSP rules. 
• For CStwP plans, only land units with the following eligible CStwP land uses can be added:  

Pasture, Range, Forest, Associated Ag Land, Farmstead, and Crop. 
• Only Easement PLUs can be added to an Easement Plan. Additionally there will be a check when 

the user adds land units to the plan to determine if any of the land units overlap a practice that 
is in a planned state and is linked to a ProTracts contract or a CRP program code. 
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Select an Existing Plan 

1. Start Toolkit and select the Check In/Out tab.  Click Go and login to eAuthentication.  
 

 

 

 
 

 

 
 

 

2. Check out a customer folder or create a new customer folder and open the folder. 

3. Click on the Customer File tab. 

4. Under the customer folder click the ArcGIS_Projects folder. Double-click ToolkitGIS_Template.mxd 
to open in ArcMap, or select another mxd file in the customer folder. 

5. In ArcMap, click the Create/Open/Manage Plans  button on the Toolkit toolbar. 
 
6. In the Create/Manage Plans dialog, click the radio button Select Existing Plan and select a plan from 

the drop-down list and click OK. 
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7. ArcMap automatically zooms to the plan and practice layers. Note:  The plan layer is always 
displayed in a yellow outline. The Change Views  button changes the symbology of the Case PLUs 
layer and turns on/off the NPAD layers except the plan. 

 

 
 

 

 

 

 

  

Create a New Plan 

1. Start Toolkit and click the Check In/Out tab. Click Go and login to eAuthentication.  

2. Check out a customer folder or create a new customer folder and open the folder. 

3. Click on the Customer File tab and under the customer folder click the ArcGIS_Projects folder. 
Double-click ToolkitGIS_Template.mxd to open ArcMap, or select another mxd file in the customer 
folder. 

4. In ArcMap, click the Create/Open/Manage Plans  button located on the Toolkit toolbar. 

5. In the Create/Manage Plans dialog, select the radio button to Create New Plan. 
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6. Select the Plan Type:  Conservation, CSP, or CStwP. If CSP is selected, the contract number is 
required and the application must be in CMT to create the plan. Enter a Plan Name. 

 

 
 

 

 

 
 

7. Click the Create Plan button, then click OK. 

8. New Plan is created and displayed in the Table of Contents 

Add Land Units to a Plan Using the Map Selection 

Before adding land units to any plan, the land units must be in the AOI and the land unit geometry status 
must be “Planned” or “Locked”. For CStwP plans, only land units with the following eligible CStwP land 
uses can be added:  Pasture, Range, Forest, Associated Ag Land, Farmstead, and Crop. Only Easement 
land units can be added to an Easement plan. 
 
1. Start Toolkit and select the Check In/Out tab. Click Go and login to eAuthentication. 
 
2. Check out a customer folder or create a new customer folder and open the folder. 
 
3. Select the Customer File tab and under the customer folder, click the ArcGIS_Projects folder. 

Double-click on ToolkitGIS_Template.mxd, or another mxd file in the customer folder, to open 
ArcMap. 
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4. In ArcMap, click the Create/Open/Manage Plans  button located on the Toolkit toolbar. 
 

 

 

 
 

 

 
 

 

 
  

5. In the Create/Manage Plans dialog, select Existing Plan, then select a plan from the drop-down 
menu and click OK. Or select Create New Plan, select the Plan Type, enter Plan Name (and Contract 
# for CSP plans), and click the Create Plan button. 

6. In the Create/Manage Plans dialog, click the Add/Remove Plan Land Units link. 

7. In the Add/Remove Land Units dialog, any existing land units in a plan will be displayed in the “Land 
Units in Plan” window. The default to add land units to the plan is “Use Map Selection”. 

8. To select land units adjacent to each other hold down the left mouse button and drag your mouse 
over one or more land units from the map.  

9. To select individual land units hold the <Shift> key down on your keyboard and use the left mouse 
button to select individual land units from the map. 
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10. Click the Add button. 
 

 
 

 

 
 
  

11. The selected land units are now listed in the Land Units in a Plan section and appear in the Table of 
Contents plan layer with a yellow outline. The Land Units in Plan section can be sorted by Tract and 
Land Unit or by Land Use. 
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Add Land Units to a Plan Using Search 

Before adding land units to any plan, the land units must be in the AOI and the land unit geometry status 
must be “Planned” or “Locked”. For CStwP plans, only land units with the following eligible CStwP land 
uses can be added:  Pasture, Range, Forest, Associated Ag Land, Farmstead, and Crop. Only Easement 
land units can be added to an Easement plan. 
 
1. Start Toolkit and select the Check In/Out tab. Click Go and login to eAuthentication. 
 
2. Check out a customer folder or create a new customer folder and open the folder. 
 
3. Select the Customer File tab and under the customer folder, click the ArcGIS_Projects folder. 

Double-click on ToolkitGIS_Template.mxd, or another mxd file in the customer folder, to open 
ArcMap. 

 

4. In ArcMap, click the Create/Open/Manage Plans  button located on the Toolkit toolbar. 
 
5. In the Create/Manage Plans dialog, select Existing Plan, then select a plan from the drop-down 

menu and click OK. Or select Create New Plan, select the Plan Type, enter Plan Name (and Contract 
# for CSP plans), and click the Create Plan button. 

 
6. In the Create/Manage Plans dialog, click the Add/Remove Plan Land Units link. 
 

 
 

 

 
  

7. In the Add/Remove Land Units dialog, any existing land units in a plan will be displayed in the “Land 
Units in Plan” window. The default to add land units to the plan is “Use Map Selection”. 

8. Under the Select Land Units section click the Search radio button. The Search button allows you to 
search for land units within the AOI by Tract Number or Farm Number. You can search within the 
Active PLUs layer, the Case PLUs layer, or both. 
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9. Select Tract Number from the Select list. If desired, uncheck Query Active PLUs or Query Case PLUs 
to limit the search. Enter the Tract number in the Filter section and click the Search button. The land 
unit(s) found will appear in the search box, clicking on a result will briefly flash the land unit on the 
map. 

 

 
 

 

 

 
 

10. Select the land unit(s) to add in the results box, holding the <Shift> or <Ctrl> key to select multiple 
land units. 

12. Click the Add button. The land units will be displayed in the Land Units in a Plan section and appear 
in the Table of Contents plan layer with a yellow outline. The Land Units in Plan section can be 
sorted by Tract and Land Unit or by Land Use. 

Add Land Units to a CSP Plan 

See Task Guide 21 – CSP CMT Land Use Check 
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Remove Land Units from a Plan  

Land units can only be removed from a plan if they do not have practices in Planned or Applied status. 
 
1. Start Toolkit and select the Check In/Out tab.  Click Go and login to eAuthentication.  
 

 

 

 

 

 

 
 

  

2. Check out a customer folder or create a new customer folder and open the folder. 

3. Select the Customer File tab and under the customer folder click the ArcGIS_Projects folder. Double-
click on ToolkitGIS_Template.mxd, or another mxd file, to open ArcMap. 

4. On the Toolkit toolbar, click the Create/Open/Manage Plans  button. 

5. In the Create/Manage Plans dialog, select Existing Plan, then select a plan from the drop-down 
menu and click OK. Or select Create New Plan, select the Plan Type, enter Plan Name (and Contract 
# for CSP plans), and click the Create Plan button. 

6. Under the Actions section, click Add/Remove Land Units and click OK. 

7. In the Add/Remove Land Units dialog, any existing land units in a plan will be displayed in the “Land 
Units in Plan” window. 
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8. To remove a land unit select a land unit from the Land Units in plan and click the Remove button. 
 

 
 

 

 
 

9. A message will be displayed removing land units from the plan. 

10. As long as the select land units do not have planned, cancelled, or applied practices, they will be 
removed from the plan and no longer shown in the “Land Units in Plan” window. 

 

Remove Land Units from a CSP Plan  

See ProTracts Land Use Check Task Guide  
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Edit Plan Decision Maker and Associated Clients  

Beginning in Toolkit 8, multiple plans can be created on the same land units. In some cases there are 
different customers associated to each plan as well as different decision makers. Planners can establish 
the specific decision makers and clients association to each plan for the purposes of uploading 
applications in ProTracts and for clients to see and request assistance for the correct planning 
information in Client Gateway. 
 
The decision maker for all plans is defaulted from the decision maker for the customer folder and is the 
only client associated to the plans by default. All clients associated to the customer folder can be 
associated to any plans within the folder. The decision maker and all associated clients for the plan can 
be edited at any time. Customers can only be added to a plan if they are added first from SCIMS using 
the Add Associated Customer button located on the General tab. 
 
For easement folders, the folder decision maker and associated customers are set in NEST and are read-
only in Toolkit. Adding or removing a customer from the folder must be done in NEST. The plan decision 
maker and associated clients can be edited in Toolkit. 
 
1. Start Toolkit and select the Check In/Out tab. Click Go and login to eAuthentication. 
 
2. Check out a customer folder or create a new customer folder and open the folder. 
 
3. Select the Customer File tab and under the customer folder click the ArcGIS_Projects folder. Double-

click on ToolkitGIS_Template.mxd, or another mxd file, to open ArcMap. 

4. On the Toolkit toolbar, click the Create/Manage Plans  button. 
 
5. In the Create/Manage Plans dialog, select Existing Plan, then select a plan from the drop-down 

menu and click OK. Or select Create New Plan, select the Plan Type, enter Plan Name (and Contract 
# for CSP plans), and click the Create Plan button. 

 
6. Under the Actions section, click Edit Plan Decision Maker and click OK. 
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7. The Manage Plan Clients dialog lists the folder clients on the left and the plan clients on the right. 
a. To add a client to the plan, select a folder client (on the left) by clicking the gray box to the left 

of the client’s name, then click the Add button. 
b. To remove a client from the plan, select a plan client (on the right) by clicking the gray box to 

the left of the client’s name and click the Remove button. 
c. Change the decision maker by checking the Decision Maker checkbox for a plan client. 
d. Add or change the client type by selecting Operator, Owner/Operator, Owner, or Cooperating 

Entity (easement folders only) from the dropdown menu. 
 

 
 

 

 

 
 

8. Once all changes are made, click OK. 

9. When the plan decision maker is changed, a Toolkit message will be provided that the plan approval 
date should be updated and a new plan signed for the correct decision maker if needed. 
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Task Guide 11 - Feature Summary Tool 

Contents: 

Use Feature Summary on a Polygon Layer .................................................................................................. 1 

Use Feature Summary on Line Layers ......................................................................................................... 2 

Use Feature Summary on Point Layers ....................................................................................................... 3 

 
Use the Feature Summary  tool, located on the Toolkit toolbar, to display the total acres, perimeter 
and count of selected polygons, the total length and count of lines or the total count of points. The tool 
can be used for shapes created in GIS or for graphics. 
 
Examples are for GIS features. The process is the same for graphics; simply check the “Calculate Selected 
Graphics Only” box for results for graphics. 
 
Use Feature Summary on a Polygon Layer  

An example of a polygon layer is a Land Unit layer. 
 
1. Click the Feature Summary  tool. The Feature Summary dialog opens. 
 
2. In the Feature Summary dialog, select the layer you want to analyze (example: Consplan) from the 

Selection Layer drop-down menu.  
 
3. Click the Select Feature  button and select one or more polygons. 
 
There are two ways acres can be calculated. They can be calculated from the geometry or the program 
acres can be pasted into the dialog. 

Calculated Acres 

 

Program Acres 
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4. To select multiple features, hold down the <Shift> key as you select or drag a box that includes a 
portion of each polygon needed. 

• The sum of GIS-calculated acres for the selected feature(s) is displayed in the Area box. 
• If features overlap, the total acres calculated may be more than the selected area. 
• The sum of the perimeter(s) of the selected feature(s) is displayed in the Perimeter box. 
• The total number of features selected is displayed in the Count box. 

 

 

 

 

 
 

 
  

5. If the polygon layer contains land units, select the Program radio button to toggle to the sum of the 
Land Unit acres as entered in the Land Unit Attribute Tool. 

6. Values displayed may be copied and pasted elsewhere, but the value may not be edited. 
• To copy the value, double-click inside the box to highlight it. 
• Click the right mouse key and select Copy. 
• Paste the value in another location (e.g. the Approximate Acres box on the Map 

Products dialog box or a Word® document). 

Use Feature Summary on Line Layers 

An example of a line layer is a Streambank. 
 
1. Click the Feature Summary  tool. 

2. In the Feature Summary dialog, select the layer you want to analyze from the Selection Layer drop-
down menu. 

3. Located on the ArcMap Tools toolbar use the Select Feature  button to select one or more lines. 
To select multiple features, hold down the <Shift> key as you select features, or drag a box around a 
line or set of lines using the mouse, or select using Selection from the ArcMap Main menu. 

• The total length of the selected feature(s) is displayed in the Length box. 
• The total number of features selected is displayed in the Count box. 
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4. Values displayed may be copied and pasted elsewhere, but the value may not be edited. 
• To copy the value, double-click inside the box to highlight it.  
• Click the right mouse key and select Copy. 
• Paste the value in another location (e.g. the Approximate Acres box on the Map 

Products dialog box or a Word® document). 
 

 

 

 
 

 

Use Feature Summary on Point Layers 

1. Click the Feature Summary  tool. 

2. The Feature Summary dialog opens. The example shows many inventory points in a dataset, with a 
selection based on an attribute. In the dialog, select the layer you want to analyze from the 
Selection Layer drop-down menu. 

3. Use the Select Feature  button to select one or more points, drag a box around a grouping of 
points, or make a selection using Selection > Select by Location or Select by Attributes on the 
ArcMap Main menu. 

4. The total number of features selected is displayed in the Count box. 
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Task Guide 12 - Map Products 
 

 

 

 

 

 
 

 

Contents: 
Create a Plan Map ..................................................................................................................................... 1 

Modify Layout Elements ....................................................................................................................... 4 

Use the Layout Zoom Tools .................................................................................................................. 6 

Print the Layout .................................................................................................................................... 6 

Save the Layout as a PDF or jpg ............................................................................................................ 6 

On the Toolkit toolbar use the Map Products  tool to create a plan map with a heading, legend, scale, 
and North arrow.  
 
General information that the user types in the choice lists in the Map Products dialog box is saved in: 
C:\Users\user.name\Local Settings\Roaming\Application Data\USDA\Toolkit5 directory.  The 
information saved includes map title, agency, district, field office and assisted by values.  The next time 
the user opens the Map Products tool, the previous settings are available as choice lists in the dialog 
box.  
 
Note:  The values entered for approximate acres, date and legal description are not saved.   

Create a Plan Map  

1. Check out a customer folder.   

2. Open the customer folder and select the plan.   
3. On the ArcMap Tools toolbar, use the Zoom In   tool or the Pan tool to get the map view you 

want to print out or save. 

4. On the Toolkit toolbar, click the Map Products  button. 

5. The Map Products dialog box opens, and the view changes from Data View to Layout View. 

6. Add a check mark to each item you want to include in the map header. Text may be added to any 
dialog box/choice list by typing in a blank box. To remove an item from a dialog box/choice list, 
highlight the item and press the <Delete> key. 

a. For Map Title, select a title from the drop-down list or enter a title in the dialog box.   
b. Select customer(s). 
c. Select the Field Office from the drop-down list or enter in a field office name.  
d. Select the Agency from the drop-down list or enter in the agency name.  
e. Select the Conservation District from the drop-down list or enter in the district name.  
f. To include a list of Land Units in the header, add a check mark to the Land Units check 

box and highlight all the land units you want to list on the map (as shown below). 
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g. Select a name from the Assisted By choice list or enter a name. 
h. To include a Date, enter a date in the date field. 
i. To include Approximate Acres, enter an amount. 
j. To include a Legal Description, enter the description. 

 

 
 

 

 

 

7. Click Apply to refresh the header settings in the layout. 

8. If these settings will be the typical settings you want to use for your conservation maps, you can 
select the Save Preferences button. Next time simply click on “Use Preferences” and then fill in any 
additional information needed. 

9. Click on the Layout and Scale tab. 

a. For Size, select a standard page size from the drop-down list. The printer must support 
the selected format. 

b. For Scale, select a standard scale from the drop-down list. If you select user-defined 
scale, another dialog box is displayed. Enter the desired scale in the dialog box. 
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c. Select a Logo from the drop-down list, if a choice list is provided. 
 

 
 

 

  

10. Click Apply. The plan map in Layout View updates with the selections from the Map Products dialog 
box. You can click on the items added to the map to further edit or move them (refer to the Modify 
Layout Elements section below). 
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Modify Layout Elements 

1. To modify an element, use the Select Elements tool to select the item you want to modify. 
 

 
 

 

 

 

 

 

 

2. To change the heading information from the Layout View, use the Select Elements tool to double 
click on a text box. Modify the text in the Text Properties dialog box.  

3. To move the heading information, click on the text and then drag it to another location.  

4. To change the font size, style or color, use the Select Elements tool to double click on a text box. 
Click on the Change Symbol button and change the font size, style or color, then click OK. 

5. To change the north arrow or scale, use the Select Elements tool to double-click on the element 
you wish to modify to open the corresponding properties dialog window. Make changes as needed, 
then click OK to dismiss the dialog window.  

6. You may remove an element (north arrow, scale bar, etc) by selecting it, then pressing the Delete 
key. 

7. To modify the Legend, use the Select Elements tool to double-click on the Legend. The dialog 
box opens and you can add or delete items for the Legend, select a border and/or background color 
for the Legend, etc. 
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Use the Layout Zoom Tools 

1. To zoom in and out on the Layout, use the Zoom Tools on the Layout Toolbar. 
 

 
 

 

 

 

2. If the Toolbar is not displayed, click on the Customize tab in the ArcMap Tools menu and select 
Toolbars and check the Layout option.  

Print the Layout 

1. ArcGIS uses the standard Windows print functionality. From the File menu, select Print. Note that 
the layout appears more centered on the page when it is printed directly from ArcMap. 

 
2. When you are finished working with the layout, you may return to the Data View window, by 

clicking on the Data View icon in the lower left corner of the Layout window. 
 

 Save the Layout as a PDF or jpg 

1. To save a copy of the layout for future reference, click the File tab on the ArcMap Tools toolbar, 
then select Export Map.  
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2. The Export Map dialog box opens. Navigate to the folder where you want to save the map, typically 
in the Resource_Maps folder (be sure it is in the correct customer folder).  Provide a file name and 
select a format – typically pdf or jpeg. Set other Options as needed. Don’t forget to set the desired 
resolution of the file. The larger the file, and the more files in the folder, the longer it takes to check 
out the customer folder.  Click Save. 

3. You can also print the map by opening the saved PDF and clicking File > Print. 
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Task Guide 13 - Map Labels and Annotation 

Contents: 

Task Guide 13 - Map Labels and Annotation .............................................................................................1 

Map Labels .......................................................................................................................................1 

Annotation Layers ............................................................................................................................5 

 
Use the Map Labels tool to label map features. Up to five attributes may be included in a label. The tool 
may be used on all feature layers.  It cannot be used for image layers such as ortho imagery, topographic 
maps, etc.  

Map Labels 

1. To label features on a data layer, use the Select Features  button located on the ArcMap Tools 
toolbar to select one or more features.  

 

 
 

 

 
 

 

 

 

 
 
 
 
 
 
 

 

2. To clear a selection use Clear Selected Features  button located on the ArcMap Tools Toolbar. 

3. Click the Map Labels tool  located on the Toolkit toolbar. 

 
The Toolkit Map Labels dialog opens.  
 
4. In the Map Labels dialog, select the layer you want to label from the drop-down list. 
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5. By default, an annotation layer is created for the labels. If you do not want to create an annotation 
layer, uncheck the Create Annotation Layer check box.  

 

 
 

 

 
 

6. Annotation in ArcGIS is an efficient way to store text to place on your maps. With annotation, 
each piece of text stores its own position, text string, and display properties. Creating an 
annotation layer allows you to edit individual labels, and turn labels on and off (independent of the 
layer being displayed).   

 
The Annotation Groups created with the Map Labels tool can be turned on and off from the 
Properties Tab of the Data Frame. For more information on annotation layers see the section 
on Annotation Layers.  

 
7. For Label Style, accept the default style Text or click the drop-down list to select Bullet Leader or 

Callout from the list. A sample of the selected style appears in the window. The Label Properties 
allows you to resize the text and select a Label Color. Click the Scale Labels check box if you want 
labels to be resized automatically when the view is zoomed in or out. Click the Add Halo if you want 
a Halo around all labels. 

8. Click the check boxes preceding the attribute fields to include up to five attributes in the label.  
 
Land Unit Acres will be displayed on 
the label, with the unit abbreviation 
“ac” following the acreage amount. 
 
Under Decimals, click the drop-down 
list to select the number of decimal 
points (0-4) to display. 
 
Acres are rounded to one decimal 
place (tenths). 
 
 

A. Under Field column, click the drop-down list to select the Field attribute for the first line of the 
label. 
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B. Under Text column, enter a word that you want to precede the attribute in the label.  
C. Select Units for quantity data fields (e.g., acres). Note:  If a unit that is needed is not displayed in 

the drop-down menu, you may enter it manually. 
 
9. Repeat step 8 for each of the attributes you want to include in the labels.  
 
10. Once the labels have been set up, you may save the preferences for future use by clicking the Save 

User Preferences button located at the bottom of the dialog. 
 

 
 

 

 
 

 

 
 

 

 
 
 

11. At any point in the future, you may use the User Preference button to retrieve the preferences 
when creating labels for another layer.   

12. When you are finished setting up the labels, click OK. 

13. If you chose to create an annotation layer, the following dialog window will be displayed. Enter a 
name for the annotation layer in the box, and click OK. 
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The labels are displayed on the map.  
 

 
 

 

 
 
  

14. Some labels may need to be repositioned. Use the Select Elements tool on the ArcMap Tools 
toolbar to click on the labels and drag them to the appropriate location.  (Annotation Layers). 
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Annotation Layers 

If you created annotation layers when you created the labels, you are able to turn the annotation on/off 
at will. You may also edit individual labels or change the font size, style, color or the location of the label. 
To access the annotation layer, complete the following steps. 
 
1. In the ArcMap Table of Contents, right mouse click on the Data Frame name and select Properties. 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 

 

The Data Frame Properties dialog window opens.  
 
2. Click on the Annotation Groups tab.   
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3. Available annotation layers are listed. To turn the display on, check the annotation layer check box. 
To turn the display off, uncheck the annotation layer check box. 

 

 
 

 

 

 
 
  

4. Click OK to close the dialog window.  

5. To edit the font size, style, or color of a label, use the Select Elements tool   from the Drawing 
toolbar located on the ArcMap tools interface. 



Task Guide 13 P a g e  | 7 September 16, 2016 

6. Once a label is selected, it will have a dashed box around it.  Use the Draw toolbar to make changes. 
Alternatively you can right-click on the label, select Properties, and the Properties dialog box will 
open and you can make changes to the label.  
 

 
 
 

 

7. To reposition a label, use the Select Elements tool   to select the label. Hold down the left mouse 
key and drag it to the appropriate location.  
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Task Guide 14 - Soils Map and Inventory and the Soil Data Viewer 

Contents: 

Soils Map and Inventory .............................................................................................................................. 1 

Soil Data Viewer (SDV) ................................................................................................................................ 7 

 
Soils Map and Inventory 

The Soils Map and Inventory  button, located on the Toolkit toolbar, allows the user to create a soil 
map and inventory report for a selected plan layer. The button will not activate without a soils layer in 
the ArcMap project. 
 

 
 

1. Verify that the necessary soil layer is added to your project and that it covers the area you are 
working on. 
 
Note:  If your land units fall in multiple soils survey areas, you will need to run this tool for each soil 
survey. 

 

2. Click the Soils Map and Inventory  button. 
 
3. The Soils Map and Inventory dialog opens. Enter the following information: 
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A. Choose the layer you want to make the soils map for from the “Selected Layer” drop-down 
menu (e.g. plan name). 

 
B. If you have more than one soils layers in your project, select the one you want to make a soils 

map with. 
 

C. To make the soils map for an extent beyond that of the selected layer, use the Buffer Width 
setting.  This will extend the soils map beyond the layer boundaries a specified number of units.  

 
Note:  This is defaulted to “1 foot”, change to “0” (zero) for no buffer. 

 
D. Choose an appropriate name for the soil map. 

 
E. Select the File Browse  button. This should default to the Resource_Maps folder in the 

customer file.  If it does not, navigate to the Resource_Maps folder for the customer. Name the 
shapefile appropriately and click Save. 
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F. Determine if you want to generate a map, a report or both – By default both are checked. 

G. There are several options to include information in the report that is generated. Check the 
appropriate boxes in the “Soil Inventory Report Options” depending on your needs. By default, 
the following options are checked: 

MU Symbol:  Map Unit Symbol 
MU Acres:  Map Unit Acres 
MU Name:  Map Unit Name 
MU Precent:  Map Unit Percent 
Prime Farmland:  Prime Farmland Indicator as defined by the Farmland Protection 
Policy Act (FPPA) 
Customer Information:  Includes the customer name at the top of the report 
Summarized by Tract and Land Unit Numbers:  Groups and summarizes the report 
based on tract and land unit numbers, not just by the map unit for the “Selected Layer” 
Note:  This will only be available to select if your “Selected Layer” contains Tract/Land 
Unit information; otherwise it will be greyed out 
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Example of report without the “Summarized by Tract and Land Unit Numbers” option selected. 

 

 

 

 

 

 
  

Example of report with Prime Farmland option selected: 
 

 
Example of report with the “Summarized by Tract and Land Unit Numbers” option selected. 

H. Click the OK button. 

4. The Soil Inventory Report will be generated and will open in Internet Explorer. It is saved to the 
Resource_Maps folder of the customer. The saved report will have an htm extension. This document 
can be accessed in the future by double clicking on the htm document in the Resource_Maps folder. 

5. A data layer named Soils Map is added to the ArcMap Table of Contents. You can now use the Soil 
Data Viewer to get different reports on the soils as needed. 
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6. Change the soils map symbology by right clicking on the soils map layer and choose Properties. 
 

 
 

 

 
 

7. In the Layer Properties dialog, enter the following information: 

A. Select the Symbology tab. 
B. Choose Unique Values under Categories. 
C. Select MUSYM from the Value Field box. 
D. Select a Color Ramp (optional). 
E. Select Add All Values. 
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F. Select Apply. Each soil type should be displayed with a different color. 
G. To set transparency (optional), select the Display tab in the Layer Properties window. 

i. Set a Transparency Percentage. The higher the value, the more transparent. 
ii. Select Apply and then OK. Your layer should now be “see through”. 
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Soil Data Viewer (SDV) 

Add the Soils Data Viewer button by installing the Soil Data Viewer add-in tool. See Task Guide 38 for 
instructions on installing the add-in. 
 
Using SDV to create Soil Interpretation Maps for your Plan Land Units 
Steps below assume that you have already used the Soil Map and Inventory Button to create a soils layer 
for your plan land units. 
 

1. Click on the Soil Data Viewer  button. 
 
2. Select the soils data base that corresponds to your land unit soils and click Open. 

 
Note:  This dialog will usually only appear the first time you use SDV. 
 

 
 

 

 
 

3. Select the soil map layer you want to use and click OK. This example shows using the soils map layer 
you just created with the Soil Map and Inventory button. 
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4. The SDV dialog opens. 
 

 

 

 

 

 
Common Interpretations and where to find them: 

Interpretation Attribute Folders Location Rating Options 
Ecological Site Names Land Classification Class: NRCS Rangeland Site 
Hydric Rating Land Classification   
Farmland Classification Land Classification  
Hydrologic Soil Group Soil Qualities and Features  
Drainage Class Soil Qualities and Features  

 
Synchronization Status Definitions/Resolutions:  

Status Definition Resolution 

 All map units in sync  

 Some map units in sync This status typically shows up when trying to run a PLU Soils 
layer that was clipped with a soils layer that is not current 
with the database. Use the Soil Map Inventory Button to clip 
the current soils with the PLU.   

 No map units in sync The wrong tabular data is selected.  Pick the appropriate 
county soils tabular data. 

5. Click on Advanced Mode. 
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6. Select the Interpretation you want to run from the tree at the left. Use the table above to help find 
the locations of the common Interpretations needed for Conservation Planning. i.e.: 

 

 
 

 

 
 

 

  
 
  

7. Attribute/Folder Description Tab:  This will give you a description of the report you have selected.  

8. Rating Options Tab: If the report you have selected has different options, they can be set here. I.e. 
Ecological Site Name defaults to “Forage Suitability Groups” and it needs to be changed to “NRCS 
Rangeland Site”: 
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9. Report Options tab: This screen will show all the soils from the soil report from the PLU.  
 

 
 

 

 

10. Click the Aggregation Report button. 

11. The Aggregation Report will generate as a PDF file which can be printed and/or saved in the 
customer file.  
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12. Click the Map button to generate the map. 

13. The following is an example of the generated map. This is a temporary layer, if you want to save it as 
a permanent file, use steps 14-19. 
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14. Right click on the new layer and click Data>Export Data.  
 

 
 

 

 

15. Click on the Open folder  button to change the location to save and the file name. 
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16. Navigate to C:\Users\your.name\My Customer Files Toolkit\Customer Folder Name\Resource Maps. 
Enter an appropriate file name and change the “Save as type” to shapefile. 

 

 
 

 

 

 

 
 
  

17. Click Save. 

18. Click OK. 

19. In the ArcMap dialog, click Yes to add the layer to the map. 
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Map Unit Description Report (Non-Tech Descriptions) 
 
1. While in SDV, click the Map Unit Desc. Report button. This will open a PDF file which can be printed 

and/or saved in the customer file.  
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Task Guide 15 - Buffer Tool 

Contents: 

Points ........................................................................................................................................................... 2 

Using Features of a Layer ........................................................................................................................ 2 

Using Graphics ......................................................................................................................................... 2 

Lines ............................................................................................................................................................. 4 

Using Features of a Layer ........................................................................................................................ 4 

Using Graphics ......................................................................................................................................... 4 

Polygons ...................................................................................................................................................... 9 

Using Features of a Layer ........................................................................................................................ 9 

Using Graphics ......................................................................................................................................... 9 

 
 
The Buffer tool can be used to create buffered areas around a point, line, or inside/outside of a polygon. 
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Points 

To buffer a point, complete the following steps. 
 

 

Using Features of a Layer 

1. Use the Select Features  button on the 
ArcMap Tools toolbar to select the feature(s) 
you want to buffer. 

 
 
2. On the Toolkit toolbar, click the Buffer tool 

 button.  
 
3. The Create Buffer dialog opens, in the dialog: 

A. Click “The features of a layer” radio 
button. 

B. Choose the data layer the features are in. 
C. Click the “Use only the selected 

features/graphics” radio button. If the 
box is unchecked, all features/graphics 
are included in the buffer layer.  

D. Click the Next button. 
 

 

Using Graphics 

1. Use the Select Elements  button on the 
ArcMap Tools toolbar to select the graphic(s) 
you want to buffer. 

 
 
2. On the Toolkit toolbar, click the Buffer tool 

 button.  
 
3. The Create Buffer dialog opens, in the dialog: 

A. Click “The graphics in your view” radio 
button. 

B. Choose the Graphic Type as Points. 
C. Click the “Use only the selected 

features/graphics” radio button. If the 
box is unchecked, all features/graphics 
are included in the buffer layer.  

D. Click the Next button. 
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Regardless of using a layer or a graphic the following steps are the same: 
 
4. Enter the settings in the Create Buffer dialog: 
 

 
 

 
  

A. Enter the width of the buffer in feet. Entries are limited to a maximum of 9999’ and feet is the 
only option for units. 

B. Dissolving barriers will result in one polygon where overlapping polygons are created in the 
buffer process. 

C. Select the location in which to save the created buffers. 
 The buffers may be saved as a graphics layer, added to an existing layer or create a new 

layer in the view. 
 Make your selection, and name the file with a descriptive name; otherwise resulting 

buffers will be named Buffer_Output.shp, Buffer_Output1.shp, etc. 
D. Click Finish. 

 The new buffer layer is added to the View. 
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Lines 

To create a buffer around a line, complete the following steps. 

Using Features of a Layer  

1. Use the Select Features  button on the 
ArcMap Tools toolbar to select the feature(s) 
you want to buffer. 

 
 
2. On the Toolkit toolbar, click the Buffer tool 

 button.  
 

3. The Create Buffer dialog opens. In the Create 
Buffer dialog: 
A. Click “The features of a layer” radio 

button.  
B. Choose the data layer the features are in. 
C. Click the “Use only the selected 

features/graphics” radio button. If the 
box is unchecked, all features/graphics 
are included in the buffer layer. 

D. Click the Next button. 
 

 

Using Graphics 

1. Use the Select Elements  button on the 
ArcMap Tools toolbar to select the graphic(s) 
you want to buffer. 

 
 
2. On the Toolkit toolbar, click the Buffer tool 

 button.  
 
3. The Create Buffer dialog opens. In the Create 

Buffer dialog: 
A. Click “The graphics in your view” radio 

button. 
B. Choose the Graphic Type as Lines. 
C. Click the “Use only the selected 

features/graphics” radio button. If the 
box is unchecked, all features/graphics 
are included in the buffer layer. 

D. Click the Next button. 
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Regardless of using a layer or a graphic the following steps are the same: 
 
4. Enter the settings in the Create Buffer dialog:   
 

 
 

 
  

A. Entries are limited to a maximum of 9999’ and feet is the only option for units. 
B. Dissolving barriers will result in one polygon where overlapping polygons are created in the 

buffer process. 
C. If you are working with lines, select the type of buffer you want to create: 
 on both sides of the line(s)  
 on the left side of the line(s) 
 on the right side of the line(s) 
Note:  If the buffer input is a feature, the output will always be on both sides of the line. The tool 
will create a buffer on one side of the line when the buffer input is a graphic. 

D. Select the location to save the created buffers. 
 You may save them as a graphics layer, add them to an existing layer or create a new layer 

in the view. 
 Make your selection, and name the file with a descriptive name; otherwise resulting buffers 

will be named Buffer_Output.shp, Buffer_Output1.shp, etc. 
E. Click Finish. 

 The new buffer layer is added to the view. 
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Buffer Line, Example One:   
 
Use the Buffer tool to create a 100 foot buffer along a stream. 
 

 

 
  

 
Note that buffer will be created on both sides of the line. The tool was not enhanced to create a one-
side buffer only when the input is a feature. To create a one-side buffer, use a graphic as the input, or 
after creating the buffer shape, use the edit tools to split and delete the portions not needed. 
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The resulting shapefile shows a 100 foot buffer along the stream. 
 

 

 

 

 
Buffer Line, Example Two: 
 
Use the Buffer tool to create a 33 foot buffer along multiple stretches of fence installation; perhaps for a 
cultural resources investigation in area that may be disturbed. 
 
1. Select features in map before initiating the Buffer tool. 
2. Click on the Buffer tool and select GIS layer (Fence) and check the box to use selected features.  

Click the Next button. 
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3. In the second window, enter the buffer distance (33 ft) and select dissolve barriers between 
(prevents creating overlapping polygons). Select “Both sides of the lines” and enter a descriptive 
shapefile name. The Buffer tool automatically sets the output folder path to the Resource Maps 
directory within the current Toolkit customer folder. 

 

 
 

 

 

 
 

 

4. To locate the buffer area (acres), use the Feature Summary  tool or work with a GIS Specialist 
to calculate acres within the attribute table. 

5. Open the attribute table by right clicking on the data layer in the ArcMap Table of Contents and click 
Open Attribute Table. Note that the buffer distance is in meters (33 ft = 10.0584 meters). 
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Polygons 

To create a buffer around a polygon, complete the following steps. 

Using Features of a Layer  

1. Use the Select Features  button on the 
ArcMap Tools toolbar to select the feature(s) 
you want to buffer. 

 
 
2. On the Toolkit toolbar, click the Buffer tool 

 button.  
 
3. The Create Buffer dialog opens. In the Create 

Buffer dialog: 
A. Click “The features of a layer” radio 

button.  
B. Choose the data layer the features are in. 
C. Click the “Use only the selected 

features/graphics” radio button. If the 
box is unchecked, all features/graphics 
are included in the buffer layer. 

D. Click the Next button. 

 

Using Graphics 

1. Use the Select Elements  button on the 
ArcMap Tools toolbar to select the graphic(s) 
you want to buffer. 

 
 
2. On the Toolkit toolbar, click the Buffer tool 

 button.  
 
3. The Create Buffer dialog opens. In the Create 

Buffer dialog: 
A. Click “The graphics in your view” radio 

button. 
B. Choose the Graphic Type as Lines. 
C. Click the “Use only the selected 

features/graphics” radio button. If the 
box is unchecked, all features/graphics 
are included in the buffer layer. 

D. Click the Next button. 
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Regardless of using a layer or a graphic the following steps are the same: 
 
4. Enter the settings in the Create Buffer dialog: 
 

 
 

A. Enter the width of the buffer in feet. 
 Entries are limited to a maximum of 9999’ and feet is the only option for units. 
 If a buffer distance greater than 9999’ is needed, use the Geoprocessing tools in the ArcMap 

Main Menu. 
B. Dissolving barriers will result in one polygon where overlapping polygons are created in the 

buffer process. 
C. Select the type of buffer you want to create. 

 inside and outside the polygon(s) creates a buffer on both sides of the polygon (boundary). 
If you chose a buffer width of 25 feet, the buffer actually will be 50 feet wide. 

 only outside the polygon(s) creates a buffer around the selected polygon(s). 
 only inside the polygon(s) creates a buffer inside the selected polygon(s). 
 outside polygon(s) and include inside creates a buffer around the outside of the polygon 

and adds it to the polygon area. 
D. Select the location to save the created buffers. 

 You may save them as a graphics layer, add them to an existing layer or create a new layer 
in the view. 

 Make your selection, and name the file if necessary. 
E. Click Finish. 

 The new buffer layer is added to the view. 
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Task Guide 16 - Attribute Tool  
 
Contents: 

Case Planning Land Units (PLUs) ............................................................................................................... 1 

Link Land Unit to Tabular .......................................................................................................................... 2 

Attribute a Practice ................................................................................................................................... 2 

Create New Practice from Existing Practice .............................................................................................. 6 

Schedule Practice for Multiple Years ........................................................................................................ 8 

 

The attribute tool is used to attribute Case PLUs and Practices in ArcMap. Case PLUs can only be 
attributed in ArcMap while Practices can be attributed in ArcMap and the Practice Schedule. 

Case Planning Land Units (PLUs) 

Once land units are created in the Case PLUs layer they must be attributed from the Attribute Tool and 
checked in to the National Planning and Agreements Database (NPAD) before the land unit can be 
added to a plan and practices scheduled. 
 
1. On the Toolkit toolbar, click the Attribute Tool  button. 
 
2. In the Attribute Tool dialog, select Case PLUs from the Select Layer dropdown. 
 
3. Click in the map view to select the land unit to attribute from the Case PLUs layer. 
 
4. Enter the land unit attributes in the Attribute Tool dialog: 

a. The Tract, Land Unit, and Acres are automatically populated if the land unit was imported 
from the CLU Layer. 

b. If the land unit was not imported from the CLU Layer, enter the Tract and Land Unit number. 
The acres should default from the land unit calculated acres and can be changed if needed. 

c. Select the NRCS Land Use. 
d. Select one or more Land Use Modifiers (optional). 
e. If more land units need attributed, click Apply. 
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5. Repeat steps 3-4 until all land units are attributed, then click OK to close the dialog. 
 
6. Land units are automatically checked in to NPAD when the Apply or OK button is selected. 
 

Link Land Unit to Tabular 

Link to Tabular has been moved to the Land Unit Editor Tool and renamed the Replace Tool. 
 

Attribute a Practice 

Once practices are created in the practice layer they must be attributed. The following steps show how 
to attribute all practice layers. 
 
1. On the Toolkit toolbar, click the Attribute Tool  button. 
 
2. In the Attribute Tool dialog, select the appropriate practice layer (points, lines, or polygons) from 

the Select Layer dropdown menu. 
 
3. Click in the map view to select the practice to attribute. 
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4. If multiple practices overlap, the Select Feature window will appear. New practices that are not 
attributed are displayed as “Undefined”. Select the practice to attribute and click OK. 

 

 
 

 

  
 

5. In the Attribute tool dialog, enter the practice information. The Tract and Land Unit are defaulted 
and can be edited if needed. The practice amount is automatically calculated and can be edited if 
needed. For Conservation type plans, the Practice Code and Practice Name choice lists will default to 
show practices only. For CStwP type plans, the choice lists default to show enhancements only. This 
selection can be changed using the Practices Only and Enhancements Only checkboxes. 
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6. The practice narrative will default to the national narrative (00N). If needed, click Select Narrative to 
open the Practice Narrative window to change or customize the narrative. 

 

 
 

 

 
 

7. If applicable, click Select Priorities and select the species from the Identified Priority list. Enter the 
priority information, click Add Priority then click OK to close the Select Priorities dialog. 
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8. On the Attribute Tool dialog, select the Planned Month and Year. To schedule practices for multiple 
years, select the Interval (years) and End Year. The number in parentheses () on the Schedule Years 
button indicates the number of times the practice will be scheduled. Click the Schedule Years 
button to schedule the practice. 

 

 
 

 

 
 

 

9. If you are scheduling practices for multiple years you will see the following Toolkit Information 
message. Click Yes to continue or select either No or Cancel to not schedule the practices. 

10. If the planned amount is not within 10% of the calculated amount a warning message will display. 
Click Yes to proceed or No to return to the Attribute Tool dialog. 
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11. If the Planned Amount is greater than the land unit acres a warning message will display. Click OK to 
return to the Attribute Tool dialog and adjust the Planned Amount. 

 
The practice(s) are saved to the Practice Schedule.  
 

Create New Practice from Existing Practice  

New practices can be created by copying an existing practice shape using the Make Copy button on the 
Attribute Tool dialog. 
 
1. On the Toolkit toolbar, click the Attribute Tool  button.  
 
2. In the Attribute Tool dialog, select the Practice layer with the existing practice that will be copied to 

create a new practice from the Select Layer dropdown. 
 
3. Click in the map view to select the practice that will be copied. 
 
4. If multiple practices overlap, the Select Feature window will appear. Select the practice to copy and 

click OK. 
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5. Once the practice is selected the Make Copy button is activated. Click the Make Copy button to 
create the new practice. 

 

 
 

 

 
 

 

6. A new practice is created with the same Tract, Land Unit, Planned Amount, Planned Month and 
Year. Click OK to continue. 

7. In the Attribute Tool dialog, enter the following for the new practice: 
a. Select the Practice Code or Practice Name. 
b. If needed, select a Practice Narrative and Priorities. 
c. If needed, update the Planned Amount, Month, and Year. 
d. If applicable, enter the Interval (years) and End Year. 
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8. Click the Schedule Years button. 
 
9. In the Attribute Tool dialog, Click Apply to continue copying or attributing practices or click OK if 

finished. 

Schedule Practice for Multiple Years 

Practices created through the practice editor tools can be scheduled for multiple years if needed. These 
steps walk through attributing a practice in ArcMap to schedule multiple years. 
 
1. On the Toolkit toolbar, click the Attribute Tool  button. 
 
2. In the Attribute Tool dialog, select the appropriate practice layer (points, lines, or polygons) from 

the Select Layer drop-down menu. 
 
3. Click in the map view to select the practice to attribute. 
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4. If multiple practices overlap, the Select Feature window will appear. New practices that are not 
attributed are displayed as “Undefined”. Select the practice to attribute and click OK. 

 

 
 

 

 

5. In the Attribute Tool dialog: 
a. If needed, update the Tract and Land Unit. 
b. Select the Practice Code or Practice Name. 
c. If needed, select a Practice Narrative and Priorities. 
d. Enter the Planned Amount, Month, and Year. 
e. Enter the Interval (years) and the End Year. The interval is the number of years between 

practice occurrences:  1 year means the practice will be scheduled each year, 2 years 
means the practice will be scheduled every other year and so forth. 

6. Click the Schedule Years button to schedule the practice. The number in parentheses () on the 
Schedule Years button indicates the number of times the practice will be scheduled.  
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7. Review the Toolkit Information message, if the displayed years are correct, click Yes to continue. If 
the years are not correct, click No to return to the Attribute Tool dialog. 

8. In the Attribute Tool dialog, Click Apply to continue attributing practices or click OK if finished. 
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Task Guide 17 - New Toolkit Layer 

Contents: 

Practices ...................................................................................................................................................... 1 

Tract Boundaries ......................................................................................................................................... 1 

Resource Inventory ..................................................................................................................................... 2 

Build Your Own ............................................................................................................................................ 3 

 
The New Toolkit Layer is no longer used in Toolkit 8 to create plans and add land units to a plan. The new 
purpose of the New Toolkit Layer is to create tract boundaries, practice, resource inventory and build your 
own layers.  Land Unit boundaries are created by editing the CasePLUs, see Task Guide 24. 
 

 

Practices 

The New Toolkit Layer button is used to create a point, line or polygon practice (partial field practice). 
Refer to Practice Layers for detailed steps on creating practices. 

Tract Boundaries 

The Tract Boundaries layer creates a shapefile that is based on the boundaries defined by the 
Conservation Plan that you have selected.   
 
Creating Tract Boundary Layer:  
 
1. A Plan must first be selected and available in the Table of Contents (TOC); if not, follow steps a-c. 

a. Click the Select a Plan button. 
b. Select the appropriate conservation plan from the drop-down list. 
c. Click OK. 

 
2. Click the New Toolkit Layer  tool located on the Toolkit toolbar. 
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3. Select the Tract Boundaries option in the upper right of the New Toolkit Layer dialog window. 
 
4. Click OK. 
 
5. A new Tract Boundaries layer is added to the top of the Table of Contents. The polygon created 

represents the outer boundary of the PLUs in your plan. 
 

Resource Inventory 

Use the New Toolkit Layer tool to create a point, line, or polygon layer to locate soil samples, existing 
pipelines, fences, weed-infested areas, or other problem areas. Resource Inventory shapefiles have a 
pre-defined set of attributes that can be used to attribute the features for sorting, labeling, or 
symbology purposes. Unlike the practice layers, the Resource Inventory shapefiles are not checked in to 
the NPAD. 
 
1. Create an inventory point. The point editor allows you to create or select a point, and to edit a point 

(moves it to a new location). 
 

 
 

 

 
 

 

 

2. Create an inventory line. The line editor allows you to create or select a line, split or reshape a line, 
and merge separate lines together. It also allows you to edit a line (moves the line to a new location, 
but cannot change the shape or rotate). 

3. Create  an inventory polygon. The polygon editor allows you to create or select a polygon, split or 
reshape a polygon, and merge separate polygons together. You can also create a circular polygon. 

 
The line, point, and polygon editors do not have a copy and paste function. If you want to copy and 
paste a similar shape into the layer, you need to use the ArcGIS copy and paste buttons on the main 
ribbon. 
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Build Your Own 

Use the New Toolkit Layer tool to create a point, line, or polygon layer and to define your own 
attributes.  This feature works in the same way as the Resource Inventory Layer. It is very useful to 
create draft point, line and polygon practice shapes while you are still in the planning stage. The final 
practice shapes can be copied and pasted into the Practice Layers.  Unlike the practice layers, the Build 
Your Own shapefiles are not checked in to the NPAD. 
 
1. Create a build your own point. The point editor allows you to create or select a point, and to edit a 

point (moves it to a new location). You can also define the point attributes. 
 

 
 

 

 
 

 

 

2. Create a build your own line. The line editor allows you to create or select a line, split or reshape a 
line, and merge separate lines together. It also allows you to edit a line (moves the line to a new 
location, but cannot change the shape or rotate). You can also define the line attributes. 

3. Create a build your own polygon. The polygon editor allows you to create or select a polygon, split 
or reshape a polygon, and merge separate polygons together. You can also create a circular polygon, 
and define the polygon attributes. 

 
The line, point, and polygon editors do not have a copy and paste function. If you want to copy and 
paste a similar shape into the layer, you need to use the ArcGIS copy and paste buttons on the main 
ribbon. 
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Task Guide 18 - Area of Interest (AOI) 
 
 

 
 
  

Contents: 

AOI Editor Toolbar ........................................................................................................................................ 2 

Edit an Existing AOI ....................................................................................................................................... 3 

Import Land Units in AOI by Selecting from a Source Layer ......................................................................... 6 

Import Land Units in a Source Layer Using Search By Function ................................................................... 7 

Create a New AOI .......................................................................................................................................... 9 

 
 
Area of Interest (AOI) in Toolkit: 

• All Case PLUs must be created and edited within an AOI.   
• A 0.25 mile buffer is automatically created around each existing Case PLU and plans when the 

customer folder is checked out.  
• One to many AOI boundaries are permitted. 
• User may change existing AOI or add AOIs as needed in order to edit/add Case PLUs or to add 

Active PLUs to a new/existing plans. 
• AOI editor enables planner to import selected polygon features to create and update the AOI. 
• Allows History and Legacy Land Units to be checked out for viewing land units and practices in 

the Land Unit Quick Report Tool. 
 
View of a system generated AOI layer: 
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AOI Business Rules 
 
1. A system generated AOI Layer is included for all Case PLUs and plans at the checkout of a customer 

folder in Toolkit. 
 
2. The system generated AOI Layer is created by selecting all land units in the Case PLUs and Plans in 

the Customer Folder and buffering 0.25 mile to return all other PLUs from the Active PLU Layer. 
 
3. If the AOI Layer is edited, the AOI is not retained when the customer folder is checked in/out unless 

new Case PLUs or plans are created within 0.25 mile of the AOI. 
 
4. When a new customer folder is created there are no AOI Layer boundaries. A planner must create 

and check-out AOIs before Case PLUs can be created and/or Case or Active PLUs can be added to 
plans. 

 
5. The AOI size should be limited to the area where planning is needed. 
 
6. All Case PLUs are required to be fully created within the AOI. 
 
7. AOI is editable from Arc Map by using the AOI Editor Tool. 
 
8. AOI Editor Tool enables a planner to import polygon data from a source layer or draw/edit AOI 

polygons. 
 
9. When a planner tries to digitize or import a PLU outside the AOI, system will return a message to 

planner informing them to draw or expand the AOI. 
 
10. The Check-out AOI tool returns additional land units requested from NPAD that are not already 

checked out with the customer folder. 
 
11. After completing the Check-out AOI any Active PLUs, Legacy PLUs and History PLUs are returned 

from NPAD in a read only status. 
 

AOI Editor Toolbar 

 
 

 
  

 Undo 
 Redo  
 Create/Update AOI 

 Select Polygon Features 
 Reshape AOI 
 AOI Vertex Edit 



Task Guide 18 P a g e  | 3 September 16, 2016 

Edit an Existing AOI 

This example shows how to edit the AOI to extend it to encompass areas to digitize land units that are 
outside of the system generated AOI. 
 
1. Check out the customer folder. 
 
2. Open the customer folder. 
 
3. Select the Customer File>ArcGIS Projects>template.mxd. 
 
4. To begin, click the Toolkit Digitizer Tool  button located on the Toolkit toolbar. 
 
5. In the Select a Layer to Edit dialog, select AOI from the drop-down menu and click OK. 
 

 

 
 

 

 
 

 

 

 
The AOI Editor toolbar is added to ArcMap. 
 

6. Select the existing AOI shape by clicking the Select Polygon Features button, then click the AOI 
polygon to select in the map view. 

7. To redraw an existing AOI shape, click the Reshape AOI tool button. 

 
Begin by clicking inside the current AOI. Click your left mouse button to set the vertices. For the last 
vertex click inside the AOI and double click to finish. 
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8. On the AOI Editor toolbar, click the Editor drop-down menu and select Stop Editing. 
 

 
 

 

 
 

 

 
 

 

 

9. Save your Edits by clicking Yes. 

10. The AOI will automatically check out. 

11. By default, the AOI check out does not include Legacy or History Land Units. If you need to check out 
Legacy or History Land Units, click the AOI button on the Toolkit toolbar. 
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12. Select the type of AOI to check out and click OK. 
 

 
 

 

 

 
 

  

Check-out AOI Includes all Active PLUs in the AOI. 
Check-out AOI for 
the selected Plan 

Includes Active PLUs within a quarter mile of the selected plan. (Fastest) 

Include Legacy 
Land Units 

Includes all Legacy PLUs from outside customer folder within AOI. The 
default check out does not include Legacy Land Units. 

Include History 
Land Units 

Includes all History land units from cancelled and completed plans within 
AOI. The default check out does not include History Land Units. 

13. You can now add new Case PLUs or Active PLUs to a plan within the updated AOI. 
 

Import Land Units in AOI by Selecting from a Source Layer 

1. Start editing and select AOI as the layer to edit. 
 
2. To import data from any selectable layer in the Table of Contents (TOC) select the Create/Update 

AOI button from within the AOI Editor toolbar. 

3. In the Create/Update AOI dialog, select the source layer that will be used to create the AOI. 
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4. Use the Select Features tool  to select the features from the source layer that will be used to 
create the AOI. To select multiple features, click and drag on the map or hold the <Shift> key and 
click within each feature. In this example, CLUs from the CLU layer have been selected. 

 

 
 

 

 

 

 

 
 

  

5. When finished selecting features, click OK in the Create\Update AOI dialog. 

6. The AOI Layer is created by buffering the selected features 0.25 miles and returning all other PLUs 
from the Active PLU Layer. 

Import Land Units in a Source Layer Using Search By Function  

1. Start editing and select AOI as the layer to edit. 

2. To import data from any selectable layer in the Table of Contents (TOC) select the Create/Update 
AOI button from within the AOI Editor toolbar. 

3. In the Create/Update AOI dialog, select the CLU source layer that will be used to create the AOI. 
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When the selected source layer is a valid CLU layer, you can search by tract number or farm number to 
select features in the AOI that will be used to create the AOI.  
 

 
 

 

 

4. To search for a tract enter the tract number in the Filter Results field. To select multiple tracts, enter 
the tract numbers separated with a comma (,). 

 
Notes: 
• Because the system presents all available tract numbers you may need to scroll up or down in order 

to find a specific tract. 
• Notice the number of selected features in the lower right of the dialog. This is the total number of 

selected land units system that will be used to create the AOI.  
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5. In the Create/Update AOI dialog, click the OK button to create the AOI from the selected tracts. 
 

 

 

 

 
 

 

 
 

 

 
 

6. The AOI Layer is created by buffering the selected features 0.25 miles and returning all other PLUs 
from the Active PLU Layer. 

Create a New AOI  

1. Start editing and select AOI as the layer to edit. 

2. The AOI Editor Toolbar is added to ArcMap. 

3. Select the Add AOI tool to digitize a new area of interest. 

4. Digitize the new AOI(s). 
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5. On the AOI Editor toolbar, click the Editor drop-down menu and select Stop Editing. 
 

 
 

 

 
 

 

 
 
  

6. Save your Edits by clicking Yes. 

7. The AOI will automatically check out. 
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8. By default, the AOI check out does not include Legacy or History Land Units. If you need to check out 
Legacy or History Land Units, click the AOI button on the Toolkit toolbar. 

 

 
 

 

 
 

 

9. Select the type of AOI to check out and click OK. 

10. You can now digitize Case PLUs or add new Case or Active PLUs to a plan within the updated AOI. 
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Task Guide 19 - Check In Features 

Contents: 
Check In Land Units Using the Selected Features Option ......................................................................... 1 

Check In Land Units Using the Query By Option ....................................................................................... 2 

Check In Practices ..................................................................................................................................... 3 

 
Land units and practices must be checked in to the National Planning and Agreements Database (NPAD) 
in order to save changes and update the land unit geometry status. Land units are created in sketch 
status and must be attributed and checked in added to a plan. Land units may need to be checked in if 
the attributes have been updated or if the land unit is in Draft or Legacy status and new practices need 
to be scheduled. Land unit check in validates if the land unit meets topology rules and updates the land 
unit attributes. Practices can be checked in to save changes to the practice geometry or attributes 
without having to check in the entire customer folder. 
 

Check In Land Units Using the Selected Features Option 

1. On the Toolkit toolbar, select the Check-In Features  button. 
 
2. In the Check-In Feature(s) dialog, select the Land Unit(s) tab. For Check-In Options, select Use 

Selected Features. Click in the map view to select the field(s) to check in. To select multiple fields, 
click and drag or hold down the <Shift> key. Click OK. 

 

 
 
If the land unit was in Sketch status it should have updated to Plan status  and can now be added 
to a plan. If the land unit update to Draft status  check for overlap with other land units in the Case 
or Active PLUs. 
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Check In Land Units Using the Query By Option 

1. On the Toolkit toolbar, click the Check-In Features  button. 
 

 

 

2. In the Check-In Feature(s) dialog, select the Land Unit(s) tab. For Check-In Options, select Query By 
and select Tract Number or Land Unit Number from the dropdown. The query results window will 
list the tract number(s) or land unit number(s) for any Case PLUs in Sketch status. Select the tract(s) 
or land unit(s) to check in and click OK. 

 
If the land unit was in Sketch status it should have updated to Plan status  and can now be added 
to a plan. If the land unit update to Draft status  check for overlap with other land units in the Case 
or Active PLUs. 
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Check In Practices 

1. On the Toolkit toolbar, click the Check-In Features  button. 
 

 

 
 

 

 
 

2. In the Check-In Feature(s) dialog, select the Practice Instance(s) tab. Click in the map view to select 
the practice(s) to check in. In the dialog window, highlight the row for each practice you want to 
check in, using the <Ctrl> or <Shift> key to select multiple rows. Click OK. 

3. A Toolkit Information window will confirm that the practices were successfully checked in, click OK. 
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Task Guide 20 – Change Views 

Plan View 

This view is primarily used for viewing plans, printing maps and displaying the plan boundaries and all 
associated land units in the Case PLUs Layer. In this view, land units associated with the selected plan 
are displayed with yellow borders. Land Units in the Case PLUs Layer are displayed with a magenta 
border in order to show all other land units that are part of the customer folder but not in the selected 
plan. When switching to the Plan View all layers except the Plan Layer and any local layers are turned 
off in the Table of Contents. 
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Digitize View  

This view displays the Case PLUs Layer using the geometry status codes of Sketch, Plan, Locked, Draft 
and Legacy. The land units associated with the selected plan are always displayed with yellow borders. 
This view is primarily used when using the Toolkit Digitizer tool and the Check-In Feature tool. This view 
is helpful in determining land unit locations and the geometry status of all land units within and nearby 
the customer folder. This view also toggles on the Active PLUs, Legacy PLUs, History PLUs and AOI layers 
which are off when switched to the Plan View. 
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There are two ways to change views: 
 
1. On the Toolkit toolbar, click the Toolkit Digitizer tool  button to go to from the Plan View to the 

Digitizing View.   
 
2. To toggle back and forth from the Digitizing View to the Plan View, click the Change Views  

button on the Toolkit toolbar. 
 

Plan View 

 

Digitize View 
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Task Guide 21 - CSP CMT Land Use Check 

This tool is used in a CSP plan to add/remove land units and summarize the land use acres totals 
between Toolkit and CMT (Conservation Measurement Tool). The Acreage Difference is displayed to 
ensure the acres match as close as possible before practices are scheduled. 
 

Create an AOI and Add Land Units to a CSP Plan ..............................................................................1 

Remove Land Unit from a CSP Plan .................................................................................................7 

 
Business Rules:  
1. Application must be in CMT to create CSP plan and add land units to CSP plan. 
2. All land units must be in Planned or Locked Status. 
3. All land units must have the land use of pasture, range, crop or forest. 
4. Only one CSP plan can be created per contract.  
5. Multiple CSP plans on different contracts can be created for the same customer folder. 
6. Land units are grouped by land use into a Conservation Management Unit (CMU) for the purposes of 

minimizing the practice schedule and plan. 
7. Practices/activities must be entered in CMT before practices can be planned in Toolkit. 
8. All practices/activities must be created using existing Toolkit practice tools. 
9. All practices/activities in CMT must be planned in Toolkit before the Plan Approval Date can be 

entered and Stewardship Plan progress can be counted for performance measures. 
10. Practices are displayed in the CSP plan and practice schedule by CMU and not by Tract and Land 

Units. 
11. Once a land unit is part of a CSP Plan the land unit is “Locked” and the geometry and attributes 

cannot be edited. 
12. To edit the land units they must be removed from the Conservation Management Unit from the CSP 

Plan. Once the land units have been removed, and if the land units are not locked by ProTracts or an 
easement, the geometry status will update to “Planned” and the land units can be edited. 

13. If the land units are locked by a ProTracts contract, a contract modification must be completed. 
14. When a CSP plan is “Completed” or “Cancelled”, and if the land units are not locked by ProTracts or 

an easement, the geometry status will update to “Planned” and the land units can be edited. 
 

Create an AOI and Add Land Units to a CSP Plan 

1. Start Toolkit and select the Check In/Out tab.  Click Go and login to eAuthentication (eAuth).  
 
2. Check out a customer folder or create a new customer folder and open the folder. 
 
3. Click on the Customer File tab. 
 

 



Task Guide 21 P a g e  | 2 September 16, 2016 

4. Under the customer folder click the ArcGIS_Projects folder. Double-click ToolkitGIS_Template.mxd 
(or another mxd file) to open the ArcMap document. 

 

 
 

 

5. If needed, add the local copy of the CLU Layer to ArcMap using the Add Data Button.  
 

6. On the Toolkit toolbar, click the Toolkit Digitizer.  
 
7. In the Select Layer to Edit dialog, select AOI. 
 

8. On the AOI Editor toolbar, select the Create/Update AOI button.  
 
9. In the Create\Update AOI dialog, select the CLU Layer for the Source Layer and Tract Number for 

Search By. Enter the Tract number(s) in the Filter Results box. To enter multiple tracts in the Filter 
Results box, type each tract number followed by a comma (,) then enter the next tract number.  

 
All CLUs within the Tract will be selected on the map and the total number of selected features will 
be shown at the bottom of the Create\Update AOI dialog. 

 



Task Guide 21 P a g e  | 3 September 16, 2016 

10. Select OK when all Tracts are added to the AOI. The AOI layer will automatically be created with a ¼-
mile buffer around the selected Tracts. Land units within the AOI will be checked out of NPAD and 
displayed in the Active PLUs layer. 

 

 

 

 

 

 
 

 

 

 
  

11. On the AOI Editor toolbar, save the edits and stop editing. 

12. On the Toolkit toolbar click the Create/Open/Manage Plans button.  

13. Select Existing Plan, select a plan from the drop-down menu and click OK. Or, click the Create New 
Plan radio button, select CSP for the Plan Type, enter Plan Name and Contract Number and click the 
Create Plan button. Note:  It is recommended to use the CSP contract number as the plan name. 

14. There are two ways to add land units to a CSP Plan:  
a. On the Create/Open/Manage Plans dialog, select Add/Remove Plan Land Units and click OK. 

b. From the Toolkit Toolbar Select CSP 

 
The CSP Protracts Land Use Check dialog opens. 
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Explanation of CSP Protracts Land Use Check 
Land use:  CSP Land Use list of Crop, Forest, Range or Pasture 
Selected Acres:  Land Unit acres from PLUs selected from the map 
Calculated Acres:  Calculated acres from PLUs selected from the map 
Program Acres:  Land Use acres from the CMT 
Acreage Difference:  Selected Acres (Land Unit acres) – Program Acres 
Total Acres Sum of all Land Unit acres for all Land Uses 
 
15. Select land units you want to add from the Case or Active PLUs Layers. 
 

 
 

 

  

16. In the CSP Protracts Land Use Check dialog, click the Add button. Continue adding land units until 
the Acreage Difference is as close to 0.0 as possible. 
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Possible Error Message: Land Units must in the Plan or Locked geometry status and must have the land 
use of Crop, Range, Pasture or Forest to be added to the CSP Plan. If you selected one or more land units 
that are not valid for the CSP Plan you will receive a message similar to the following and the land units 
will not be added to the plan.  
 

 

 
  

 
If you get this error message, you must edit the land units in the existing Case PLU Layer(s). 
 
A CMU is created for each land use within the CSP Plan. The CMU name is the NRCS Land Use name. A 
CMUs data layer has been added to the Table of Contents in the Digitize View so you can see each land 
use. The symbology can be changed as needed. When the land units are added to CSP Plan, the 
geometry status, as shown in the Case or Active PLU Layers, will be Locked. 
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To toggle back and forth from the Digitizing View to the Plan View, click the Change Views  button on 
the Toolkit toolbar. Plan View will turn off all NPAD layers except the plan, and for CSP plans the CMU 
symbology changes from a solid fill symbol by land use to a yellow outline. 
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Remove Land Units from a CSP Plan 

Once you add land units to a CSP plan, the land unit is linked to the CMU, the geometry status is 
“Locked” and the land unit is no longer editable from the Case PLUs unless you first remove the land 
unit from the CSP Plan. Once the land unit has been removed from the CSP Plan and if the land unit is 
not locked by ProTracts or an easement, the geometry status will update to “Planned”. The land unit can 
then be edited and added back into the CSP plan if needed. 
 
If there are practices planned on a CMU and one or more land units are removed, the practice schedule 
and practice layers will need to be manually updated to reflect the changes made by removing a land 
unit from a CMU. 
 
1. In the Table of Contents, turn on CMU, Case PLUs and Active PLUs layers. 
 

 
 

 

 
 
  

2. Click the CSP button on Toolkit Toolbar. 



Task Guide 21 P a g e  | 8 September 16, 2016 

3. In the map area, click on the land unit from the Case PLUs or Active PLUs layer you want to remove. 
 

 
 

 

 
 

 

4. In the CSP Protracts Land Use Check dialog, click the Remove button. 

5. You will see a warning message that practices may need to be updated. Select OK and the land unit 
should be removed from the CSP plan. 
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The CMUs layer no longer displays the removed land unit as part of the CSP Plan and the land unit 
geometry status is now “Planned”. The practice layers and practice schedule do not change and may 
need to be updated manually.  
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Task Guide 22 - Land Unit Quick Report Tool 

Contents: 

Find Information for selected Land units ........................................................................................................ 1 

Export Practice Report to Excel ....................................................................................................................... 3 

Export Land Use Report to Excel ..................................................................................................................... 4 

 
The Land Unit Quick Report Tool enables a user to: 

• Select specific land units and view all practices that are associated with the land unit 
across multiple plans. 

• Select all land units from an existing layers such as the Case PLUs or an existing plan and 
view all practices associated to the selected data layer. 

• Export Practice Report tied to land units to an Excel workbook. 
• Export Land Use Report tied to land units to an Excel workbook. 

 

Find Information for selected Land units 

1. Click the Quick Report (QR) button located on the Toolkit toolbar. 
 

 

 

 
The Quick Report Tool dialog opens. 
 

 
Selecting Features 
2. The system allows the user to open the Quick Report Tool first and then select land units from the 

Case PLUs, Active PLUs, Legacy PLUs, and/or History PLUs. 
 

On the Land Unit Quick Report dialog under Selection Method, click the Use Selected Features radio 
button. In the map view, select the land unit(s) to include in the report. The Land Unit Quick Report 
dialog automatically updates as land units are selected or unselected. 
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OR 

On the Land Unit Quick Reports dialog under Selection Method, click the Select All Land Units From 
radio button and then select the data layer from the dropdown list. 

 

3. To view changes that have been made to the practices listed in the data grid that have not been 
checked into NPAD, check the Show Legend in Grid checkbox. A color-coded legend shows the 
changes that have been made locally. 
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4. Close or minimize the Land Unit Quick Report dialog when finished. 
 

Export Practice Report to Excel 

1. Select the land units to include in the report. 
 
2. In the Land Unit Quick Report dialog, select Practice Report from the Select Report Type dropdown 

and click the Export to Excel button. 
 

 

 
  

 
An Excel Workbook is opened with the information from the table populated into a sheet within the 
Workbook as shown below. Excel enables the user to sort and filter for additional views of the data. 
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Export Land Use Report to Excel 

1. Select the land units to include in the report. 
 

 

 

 
 

2. In the Land Unit Quick Report dialog, select Land Use Report from the Select Report Type dropdown 
and click the Export to Excel button. 

 
The Land Use Report is opened in Excel as shown below. 
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Task Guide 23 - Transfer Tool 
 
Contents: 

Plan Transfer .............................................................................................................................................. 3 

Land Unit Transfer ...................................................................................................................................... 6 

Practice Transfer ........................................................................................................................................ 9 

Land Units and Practices Transfer ............................................................................................................ 10 

Document Transfer and Document Copy ................................................................................................. 12 

 
The transfer tool allows the transfer of parts of customer folders to different customer folders. Below 
are examples of the needs that each item addresses. Note that both the sending and receiving customer 
folders must be checked out. 
 

Transfer Type Function Examples 
Plan Transfers a plan 

(including all 
practices in the 
plan) to a different 
customer. 

 

 

 

An example would be if an owner still owns the land but 
no longer operates it and no longer needs a plan on the 
land. 
Another example would be that an operator no longer 
operates the land and a new operator now operates the 
land (operator change) or 

The owner now operates the land. 
Land Units 
(Case PLU) 

Transfers land 
to a different 
customer. 

units  

 

An example would be that the owner sells the land to a 
different customer and no longer owns the land. Note: 
any plans tied to the land will remain in the original 
owner’s folder unless they are transferred (see Plan 
above). 
Practices will also remain in the original owner’s folder 
but could be 

• transferred to the operator if needed in the 
operator’s folder (see Land Units and Practices 
below) 

• remain in the owner’s folder or  
• cancelled in the owner’s folder. 

Practices Transfers selected 
practices to a 
different customer 
folder or plan. 

 An example would be that the owner no longer operates 
the land and the management practices need to be 
transferred to the operator. Note that structural practices 
could remain in the owner’s customer folder and the 
owner will still have the plan. 

Land Units 
(Case PLUs) 
and Practices 

Transfers both Land 
Units and Practices 
to a different 
customer folder. 

 An example would be that the owner sells the land to a 
different customer and no longer owns the land. The 
original owner no longer needs the practices and the 
practices need to be included in the new owner’s folder. 
Note that any plans tied to the land units will remain in 
the original owner’s folder unless transferred (see Plan 
above).  
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Documents Transfers or copies  An example would be that the HEL documents need to be 
selected documents transferred to a new operator from the owner’s folder.  
to a different 
customer folder. 

 
The Transfer Tool  allows the user to transfer Plans, Land Units, Practices, Land Units and Practices, or 
Documents between customer folders. 
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Plan Transfer 

Plan Transfer functionality provides field offices an efficient method to move plan(s) from one customer 
folder to another. 
 
Plan Transfer Business Rules:  

a. All plan types are allowed to be transferred. 
b. CSP plans are eligible to be transferred from one customer folder to another. 
c. Plans cannot be transferred to or from an easement type folder. 
d. Any plans with practices associated to an active contract will need to be put in modification 

from ProTracts prior to checking the customer folder out and performing a plan transfer. 
e. Toolkit will add new client’s names from the transferred plan to the customer folder if 

necessary. 
f. Both customer folders must be checked out in Write status for the transfer to be allowed. 

 
1. Check out two or more customer folders. Identify one customer folder to transfer the plan from and 

one customer folder to receive the transferred plan. 
 
2. Open the customer folder that you will transfer the plan from. 
 
3. Select the Practice Schedule tab. Select the plan to transfer and review the plan to verify it is the 

correct one to transfer. 
 

 
 

 

 

 
  

4. Select the Customer File tab and click the ArcGIS_Projects Folder. Double-click on 
ToolkitGIS_Template.mxd, or select another template to open in ArcMap. 

5. In ArcMap, click the Transfer Tool located on the Toolkit toolbar. 
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6. In the Transfer Tool dialog, select Plan for transfer type. The Select Customer Folder to Transfer to 
dropdown menu will list the valid folders from your currently checked out folders. Select a customer 
folder to transfer to and click Next. 

 

 
 

 

 
 

  

7. Select a plan from the Select the Plan to Transfer drop-down menu. 

8. Click the Transfer button to initiate plan transfer. 
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9. Click OK in the Toolkit Information window to confirm the transfer was successful. 
 

 
 

 

 
 

 

 

 

 

 
 

10. The system will alert you when there are folder clients that are no longer associated to a plan after 
the transfer. Click OK. 

11. Click Cancel to close the transfer tool dialog. 

12. Close ArcMap and close the customer folder that the plan was transferred from. 

13. Open the customer folder that the plan was transferred to. 

14. Select the Practice Schedule tab. Select the transferred plan and review to verify it is displayed 
correctly. 
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Land Units Transfer 

Land Unit transfer allows field offices to transfer land units when the land is sold or is currently in the 
wrong customer folder. The land units are transferred from one folder’s Case PLUs layer to another 
folder’s Case PLUs layer. The transferred land units will continue to reside in all plans. 
 
Land Transfer Business Rules:  

a. Transferring land units does not transfer the plans and/or practices. 
b. All land units can be transferred. 
c. Locked land units do not have to be in a contract modification to complete a land transfer. 
d. Land units are transferred to the transfer to customer folder’s Case PLUs layer. 
e. Both customer folders must be checked out in Write status for the transfer to be allowed. 

 
1. Check out two or more customer folders. Identify one customer folder to transfer the land units 

from and one customer folder to receive the transferred land units. 
 
2. Open the customer folder that you will transfer the land units from. 
 
3. Click the Practice Schedule tab and select any plan. From the Land Unit directory tree view, decide 

which tract(s) and/or land units you will transfer to the other customer folder. 
 
4. Select the Customer File tab and click the ArcGIS_Projects Folder. Double-click on 

ToolkitGIS_Template.mxd, or select another template to open in ArcMap. 
 
Note:  It is not necessary to open a plan because the Transfer tool is transferring land units from the 
Case PLUs layer to another folder’s Case PLUs layer. 
 
5. In ArcMap, click the Transfer Tool located on the Toolkit toolbar. 
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6. In the Transfer Tool dialog, select Land Units for transfer type. The Select Customer Folder to 
Transfer to dropdown menu will list the valid folders from your currently checked out folders. Select 
a customer folder to transfer to and click Next. 

 

 
 

 

 
 
  

7. In the Select Land Units to Transfer window, click on the triangle to the left of each listed tract to 
expand and select the land unit(s) to transfer. If desired, click the Quick Report button to view plans 
and practices for the selected land units or Zoom to Features to view on the map. Click Transfer. 



Task Guide 23 P a g e  | 8 September 16, 2016 

8. Click OK in the Toolkit Information window to confirm the transfer was successful. 
 

 
 

 

 
 

 

 

9. Click Cancel to close the transfer tool dialog. 
 
The transferred land units will move from the Case PLUs layer to the Active PLUs. 
 
10. Close ArcMap. 
 
11. Select the Practice Schedule tab and select the plan that contains the transferred land units. The 

land units are now shown under the customer folder they were transferred to. 

12. Close the customer folder that land was transferred from and open the customer folder the land 
units were transferred to. 

13. Select the Customer File tab and click the ArcGIS_Projects Folder. Double-click on 
ToolkitGIS_Template.mxd, or select another template to open in ArcMap project. 

14. The transferred land units are now displayed in the Case PLUs layer. Click the Land Unit Quick 
Report Tool and select all land units from the Case PLUs layer. Any plans and practices remain 
associated to the customer folder the land units were transferred from. 
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Practice Transfer  

Practice Transfer allows users to transfer practices from one plan to another. The plans may be in the 
same customer folder or in different folders. 
 
Business Rules:  

a. Practices associated to an active ProTracts agreement must be in “modification” status in 
ProTracts prior to customer folder check out in order to be eligible for transfer. 

b. Practices that are in a CSP plan type are ineligible for transfer. 
c. CSP Plans are unavailable as a target plan for transfer of practices. 
d. Practices are transferred to an existing plan in the transfer to customer folder. 
e. Both customer folders must be checked out in Write status for the transfer to be allowed. 

 
1. Check out one or more customer folders. Identify one customer folder or plan to transfer the 

practices from and one customer folder or plan to receive the transferred practices. 
 
2. Open the customer folder that you will transfer the practices from. Select the Customer File tab and 

click the ArcGIS_Projects Folder. Double-click on ToolkitGIS_Template.mxd, or select another 
template to open in ArcMap. 

 
3. In ArcMap, click the Transfer Tool located on the Toolkit toolbar. 
 

 
 

 

 

4. In the Transfer Tool dialog, select Practices for transfer type. The Select Customer Folder to Transfer 
to dropdown menu will list the valid folders from your currently checked out folders, select a 
customer folder to transfer to. The Select Plan to Transfer to dropdown menu will list the valid plans 
from the selected folder, select a plan to transfer to and click Next. 
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5. In the Select Practices to Transfer window, view and select practices by tract or plan. Click on the 
triangle to the left of each tract, plan, or land unit to expand and select the practice(s) to transfer. If 
desired, click Zoom to Features to view the selected practices on the map. Click Transfer. 

 

 
 

 

 

6. Click OK in the Toolkit Information window to confirm the transfer was successful. 

 
7. Click Cancel to close the transfer tool dialog. 
 

Land Units and Practices Transfer 

Land Units and Practices transfer provides field offices an efficient method to move selected land units 
and practices from one customer folder and plan to another customer folder and plan. 
 
Land Units and Practices Transfer Business Rules:  

a. Practices that are in a CSP plan created since 2014 are not eligible and should not be available 
for selection by the planner to transfer. 

b. CSP Plans are not available as a target plan for transferring practices to. 
c. Obligated practices are allowed to be transferred but only when the contract has been put in a 

modification in ProTracts prior to starting the transfer. 
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d. Land and practice transfer can occur on practices with status of alternative, planned, or applied. 
e. When planned or applied practices are being transferred to a plan that does not have a plan 

approval date, Toolkit shall present the planner a dialog box giving the planner the option to 
update the plan approval date on the target plan at the time of transfer. If the planner chooses 
not to update the plan approval sate at the time of transfer then the transfer will continue and 
the status of the practices remain planned or applied. 

f. All land units are eligible to transfer. 
g. Locked land units can be transferred without a contract modification. 
h. Practices are transferred to an existing plan in the transfer to customer folder. 
i. Both customer folders must be checked out in Write status for the transfer to be allowed. 

 

 

 

 

 
 

 

 

1. Check out two or more customer folders. Identify one customer folder and plan to transfer the land 
unit(s) and practice(s) from and one customer folder and plan to receive the transferred land unit(s) 
and practice(s). 

2. Open the customer folder that you will transfer the land unit(s) and practice(s) from. Select the 
Customer File tab and click the ArcGIS_Projects Folder. Double-click on ToolkitGIS_Template.mxd, 
or select another template to open in ArcMap. 

3. In ArcMap, click the Transfer Tool located on the Toolkit toolbar. 

4. In the Transfer Tool dialog, select Land Units and Practices for transfer type. The Select Customer 
Folder to Transfer to dropdown menu will list the valid folders from your currently checked out 
folders, select a customer folder to transfer to. The Select Plan to Transfer to dropdown menu will 
list the valid plans from the selected folder, select a plan to transfer to and click Next. 
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5. In the Select Land Units and Practices to Transfer window, click on the triangle to the left of each 
tract, land unit, or plan to expand and select the land unit(s) and practice(s) to transfer. If desired, 
click Zoom to Features to view the selected land unit and practices on the map. Click Transfer. 

 

 
 

 

 
 

6. Click OK in the Toolkit Information window to confirm the transfer was successful. 

7. Click Cancel to close the transfer tool dialog. 
 

Document Transfer and Document Copy 

Document Transfer and Document Copy provides field offices an efficient method to move documents 
from one customer folder to another or copy a document which may need to reside in more than one 
customer folder. 
 
Document Transfer Business Rules:  

a. Transferring documents does not transfer the land units, plans and/or practices. 
b. All documents can be transferred or copied except for the following types: .mxd, .lyr and .ini. 
c. A Document transfer is between two customer folders. 
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i. Documents from one customer folder can be transferred or copied to one or more 
customer folders. 

ii. To transfer documents to multiple folders the specific documents/files are selected and 
one customer folder is selected to transfer to. Continue selecting documents and the 
appropriate folder to transfer or copy to until all documents are transferred to the 
correct folders. 

d. Both customer folders must be checked out in Write status for the transfer to be allowed. 
e. If there is an existing document or file with the same name the transferred file will be renamed 

by adding “-transfer” to the file name. Example: consplan-transfer.xlsx 
f. If there is an existing document or file with the same name the copied file will be renamed by 

adding “-copy” to the file name. Example:  consplan-copy.xlsx 
 

 

 

 

 
 

 

 
 

1. Check out two or more customer folders. Identify one customer folder to transfer or copy the 
documents from and one customer folder to receive the transferred or copied documents. 

2. Open the customer folder that you will transfer or copy the documents from. Select the Customer 
File tab and click the ArcGIS_Projects Folder. Double-click on ToolkitGIS_Template.mxd, or select 
another template to open in ArcMap. 

3. In ArcMap, click the Transfer Tool located on the Toolkit toolbar. 

4. In the Transfer Tool dialog, select Documents for transfer type. The Select Customer Folder to 
Transfer to dropdown menu will list the valid folders from your currently checked out folders. Select 
a customer folder to transfer to and click Next. 
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5. Select file folder that contains the document(s) to transfer and click Copy. 

6. In the Select Documents to Transfer window, click on the triangle to the left of folder to expand it 
and select the documents or files to transfer or copy. Click Transfer to move the file to the selected 
customer folder or Copy to copy the file to the selected customer folder and retain a copy in the 
original folder. 

7. Click Cancel to close the transfer tool dialog and close ArcMap. 

8. You can verify the transfer or copy was successful by checking for the files on the Customer Folder 
tab. 
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Task Guide 24 - Case PLUs - Land Unit Editor 
 
Beginning in Toolkit 8, the New Toolkit Layer tool is no longer used to create plans and add land units to 
a plan. Land units now reside in a separate layer called the Case PLUs layer. The Case PLUs Land Unit 
Editor toolbar is used to create or modify land units in the Case PLUs Layer.  
 
Contents: 
CASE PLANNING LAND UNITS (PLUS) ..................................................................................................................................... 2 
LAND UNIT EDITOR TOOLBAR................................................................................................................................................ 4 
Import Land Units to the Case PLUs using the CLU Layer Query by Farm or Tract Number ........................ 4 
Import Land Units from Another Polygon Layer in the ArcMap Table of Contents ..................................... 6 
Digitize a New Land Unit ............................................................................................................................... 7 
Digitize a New Land Unit Using Autocomplete ............................................................................................. 9 
Edit a Draft Land Unit Using the Vertex Edit Tool ....................................................................................... 10 
Edit a Draft Land Unit Using the Reshape Editor ........................................................................................ 14 
Edit a Shared Boundary ............................................................................................................................... 18 
Replace Land Units in the Case PLU Layer .................................................................................................. 20 
Collapse Land Units in the Case PLU ........................................................................................................... 22 
Split Land Units in the Case PLU Layer ........................................................................................................ 23 
Merge Land Units in the Case PLUs Layer ................................................................................................... 24 
Explode Multi-Part Land Units in the Case PLUs Layer ............................................................................... 25 
Delete Land Units in the Case PLUs Layer ................................................................................................... 26 
Circle Tool and Center Pivot Tool ................................................................................................................ 28 
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Case Planning Land Units (PLUs)  
A Planning Land Unit (PLU) is a unique geographic area defined by a polygon that has common land use 
and land use modifier. The Case PLUs is a collection of PLUs that typically represets the lands associated 
with a single operation that is owned or operated by one client, although those lands may be leased or 
managed by others at times. This is the “land-centric” approach to conservation planning introduced in 
Toolkit 8. It is recommended that as new land units are created, Case PLUs are located in the owner’s 
customer folder. Below is an example of Case PLUs – the PLUs are in different land unit status, and all 
are located in the current customer folder. These land units are owned by the customer, but may be 
leased or managed by other operators. 
 

 
 
 
Case PLU Business Rules 
 

1. A Case PLU must be created and attributed in ArcMap and checked in before the land unit can 
be added to a plan and practices can be planned. 

2. A Case PLU in the Plan or Locked or status can be associated with zero, one or multiple 
conservation plans. 

3. A Case PLU cannot be deleted if the PLU is Locked, is in a CSP plan or has any practices in 
“planned” status. 

4. A Case PLU may be a single or multi-part polygon. 
5. A Case PLU is created using the following methods: 

a. Check in Legacy NCP land unit data and geometry into NPAD. 
b. Digitize heads-up on an acceptable base image.  
c. Import from any polygon sources layer in the Table of Contents. 

6. Horizontal overlap will be enforced for the Active PLU layer geometry status of Plan and Locked.   
7. A Case PLU has only one land use. 
8. A Case PLU may have zero, one or many land use modifiers. 
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9. Each time a PLU is edited the geometry status is updated to Sketch which requires the land unit 
to be checked back into NPAD to ensure topology rules are met. 

 
Case PLU Work Flow 
 

 

Create AOI Add/Edit/ 
Import Land Unit

Attribute Land 
Unit

Check In Land 
Unit

 
 
  

 
Overlap 
 
Overlap is how point, lines and polygons share geometry. Overlap rules are topology rules used to 
ensure data quality and to allow your geodatabase to represent your features in a more realistic way. 
The following diagram demonstrates how the rule “Must Not Overlap” is applied to Land Unit polygons. 
Toolkit enforces these rules on land units located within an AOI (Area of Interest). 
 
The rule “Must Not Overlap” guarantees that no point, line or polygon can overlap another polygon that 
is in the same feature class or subtype. However, they can share edges or vertices. If an error occurs 
(shown in red) it must be corrected before it can be checked into the database. 
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Land Unit Editor Toolbar 
There are several new functions on the Land Unit Editor toolbar.  
 
 

 
 
 

 

 
  

Import Land Units to the Case PLUs using the CLU Layer Query by Farm or Tract Number  
This example shows how to query the CLU layer by farm or tract number to select land units and import 
to the Case PLUs Layer. 
 
1. Turn on the AOI layer and verify the AOI is large enough to include the land units you want to add 

from the CLU Layer. If needed, edit the AOI to enlarge it, then save the edits and stop editing the 
AOI layer. 

 

2. From the Toolkit Toolbar, click the Toolkit Digitizer tool  and select Case PLUs for the layer to 
edit. 

 
3. Select the Import Land Unit(s) button from the Land Unit Editor toolbar. 



Task Guide 24 P a g e  | 5 September 16, 2016 

4. In the Import Land Units(s) dialog, select the CLU Layer as the source layer. Select Tract Number or 
Farm Number from the Search By dropdown. In the Filter Results text box, enter the tract or farm 
number to import. To select multiple tracts, enter the tract numbers in the text box separated with 
a comma. The selected tract or farm number(s) will be highlighted in blue in the results window and 
in the map view. The Import Land Unit(s) dialog will also display the number of selected features at 
the lower right corner of the dialog. Click OK to import the selected land units. 

 

 
 

 

 

 
 

5. If the selected tract is within the AOI, the land units will be added to the Case PLUs layer in Sketch 
status. Save the edits and stop editing. 

6. If there are any land units from the selected tract or farm that are not completely within the AOI, 
the land units will not be added to the Case PLUs and the following Toolkit Information message will 
be displayed. Repeat steps 1-6 to add land units from the CLU layer. 

7. Attribute the land unit(s). As each land unit is attributed, the land unit will automatically check into 
NPAD and the Geometry status will update to Planned if the land unit does not overlap with an 



Task Guide 24 P a g e  | 6 September 16, 2016 

existing Planned or Locked land unit in NPAD. If the land unit updates to Draft status, check for 
overlap with other land units in the Case or Active PLUs layers. 

 
Import Land Units from Another Polygon Layer in the ArcMap Table of Contents 
The Import Land Unit(s) tool allows the user to select any polygon layer in the ArcMap Table of Contents 
as the import source layer, including the Legacy and History PLUs layers. 
 
1. Turn on the AOI layer and verify the AOI is large enough to include the land units you want to add 

from the Source Layer. If needed, edit the AOI to enlarge it, then save the edits and stop editing the 
AOI layer. 

 

2. From the Toolkit Toolbar, click the Toolkit Digitizer tool  and select Case PLUs for the layer to 
edit. 

 
3. Select the Import Land Unit(s) button from the Land Unit Editor toolbar. 
 

 
 

 

 
 

4. In the Import Land Units(s) dialog, select the import Source Layer from the dropdown list. The Source 
Layer list will show all valid polygon layers from the ArcMap Table of Contents. In this example, the 
Legacy PLUs layer is selected. 

5. In the map view, select the land unit(s) using the Select Features  button located on the ArcMap 
Tools Toolbar. Click OK in the Import Land Unit(s) dialog. 

6. The land unit(s) are added to the Case PLUs in Sketch status from the selected source layer. Save the 
edits and stop editing. 
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7. Attribute the land unit(s). As each land unit is attributed, the land unit will automatically check into 
NPAD and the Geometry status will update to Planned if the land unit does not overlap with an 
existing Planned or Locked land unit in NPAD. If the land unit updates to Draft status, check for 
overlap with other land units in the Case or Active PLUs layers. 

 
Digitize a New Land Unit  
This example demonstrates how to digitize a new land unit located completely within the AOI. 
 
1. Turn on the AOI layer and verify the AOI is large enough to include the land unit(s) you want to 

digitize. If needed, edit the AOI to enlarge it, then save the edits and stop editing the AOI layer. 
 

2. From the Toolkit Toolbar, click the Toolkit Digitizer tool  and select Case PLUs for the layer to 
edit. 

 
3. Select the Add Field button from the Land Unit Editor toolbar. 
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4. Digitize the new land unit(s) in the map view, double-clicking to finish the sketch. 
 

 
 

 

 
 

  

5. The new land unit(s) are added to the Case PLUs in Sketch status. Save the edits and stop editing. 

6. Attribute the land unit(s). As each land unit is attributed, the land unit will automatically check into 
NPAD and the Geometry status will update to Planned. 
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Digitize a New Land Unit Using Autocomplete 
Rules for digitizing new land units: 

• New land units are created as Sketch status 
• Sketch land units should snap to other sketch land units from the Case PLUs layer and snap to 

any Locked/Plan land units in the Active PLUs Layer 
• Sketch land units should overlap any Sketch or Draft land units from the Active PLUs Layer and 

any Legacy Land Units 
 
This example demonstrates how to create a new land unit completely within the AOI using the 
Autocomplete function. Autocomplete allows the system to create the coincident boundary for you, 
eliminating overlap errors. 
 
Auto Complete Polygon 
 
 

                                               

Coincident boundary not digitized… 

         

…but still created by edit task 

 
Note:  The Autocomplete function only works when digitizing next to a  Locked or  Plan status 
land unit in the Active or Case PLUs layer or a  Sketch land unit in the Case PLUs. It does not snap to 
History, Legacy, or Draft polygons, or to Sketch polygons in the Active PLUs layer. 
 
1. If needed edit the AOI or create a new AOI. 
 

2. From the Toolkit Toolbar, click the Toolkit Digitizer tool  and select Case PLUs for the layer to 
edit. 

 
3. On the Land Unit Editor toolbar, click the Add Field  button. Click once inside the boundary of an 

existing PLU to start digitizing the adjacent land unit. 
 

 
 
4. Continue digitizing the boundary. To set the last vertex, double-click inside the  Sketch,  
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 Locked, or  Plan status land unit to finish the sketch. Ensure that the ‘trailing line’ following 
back to the first vertex crosses into the adjacent boundary. When you double-click to finish the 
sketch, the overlap area will be removed and the line will snap to the adjacent boundary. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
5. The new land unit(s) are added to the Case PLUs in Sketch status. Save the edits and stop editing. 
 

 

6. Attribute the land unit(s). As each land unit is attributed, the land unit will automatically check into 
NPAD and the Geometry status will update to Planned. 

Edit a Draft Land Unit Using the Vertex Edit Tool 
If a land unit overlaps with another Locked or Plan status land unit, it will be shown as  Draft status. 
Draft land units cannot be added to a plan, the overlap error must be corrected and the land unit 
checked into NPAD and updated to Planned status before proceeding. 
 

1. From the Toolkit Toolbar, click the Toolkit Digitizer tool  and select Case PLUs for the layer to 
edit. 

 
2. In the Table of Contents, turn on the Land Unit Topology layer and turn off all layers except for the 

Case PLUs and the imagery layer. 
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3. A land unit shown as  Draft denotes that the PLU has failed overlap rules. If you want to 
determine exactly where the overlap errors exist, add the Topology toolbar and validate the overlap. 

 

 

 

 
 

 

 
  

 
Identify the Overlap Error 
 
1. On the ArcMap Main menu, click Customize > Toolbars and select Topology from the list of 

available toolbars. 

2. On the Topology toolbar, click the Select Topology button. 
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3. In the Select Topology dialog, select the Geodatabase Topology radio button, select Land Unit 
Topology and click OK. 

 

 
 

 

 

 

4. On the Topology toolbar, click the Validate Topology in Current Extent button. 

 
The areas shown in red  are overlap errors. If needed, zoom in to examine the areas. Do not use the 
Topology tools to correct the overlap errors, use the Toolkit editing tools. For pancaked land units (2 or 
more copies of the same land unit in the Case or Active PLUs layers), determine which land unit should 
be retained and either delete the other land units or use the collapse tool to reduce to a single land unit. 
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Correct the Overlap Error 
 
5. On the Land Unit Editor toolbar, click the Vertex Edit tool. 
 

 
 

 

 
 

 

 
 

 

 
 

6. Double click on the polygon that needs to be edited. 

7. The tool is set up to Auto-Complete a polygon which will snap the edge of the polygon to the edge 
of the neighboring polygon. Move the vertices so that they are inside of the neighboring polygon. 

8. Click the Finish Sketch   button on the Edit Vertices to complete the sketch. 
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9. The boundary has snapped to the adjacent land unit and the overlap error has been corrected. 
 

 
 

 

 
 

 

 
 

10. Save the edits and stop editing. 
 
Edit a Draft Land Unit Using the Reshape Editor 
If a land unit overlaps with another Locked or Plan status land unit, it will be shown as  Draft status. 
Draft land units cannot be added to a plan, the overlap error must be corrected and the land unit 
checked into NPAD and updated to Planned status before proceeding. 
 
The following steps show how to identify the overlap area and fix the overlap error using the reshape 
tool from the Land Unit Editor toolbar. 
 
Identify the Overlap Error 
 
1. On the ArcMap Main menu, click Customize > Toolbars and select Topology from the list of 

available toolbars. 

2. On the Topology toolbar, click the Select Topology button. 

3. In the Select Topology dialog, select the Geodatabase Topology radio button, select Land Unit 
Topology and click OK. 
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4. On the Topology toolbar, click the Validate Topology in Current Extent button. Make sure the Land 
Unit Topology layer is turned on in the Table of Contents. 

 
The areas shown in red  are overlap errors. If needed, zoom in to examine the areas. Do not use the 
Topology tools to correct the overlap errors, use the Toolkit editing tools. For pancaked land units (2 or 
more copies of the same land unit in the Case or Active PLUs layers), determine which land unit should 
be retained and either delete the other land units or use the collapse tool to reduce to a single land unit. 
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Correct the Identified Overlap Error 
 
1. On the Land Unit Editor Toolbar, click on the Select Land Unit button. 
 

 
 

 

 
 

 

 
 

 

 

2. Click in the map view to select the Draft land unit to edit. 

3. On the Land Unit Editor Toolbar, click on the Reshape button. 

4. Starting inside of the selected Draft land unit,click to set the first vertex; then move to the corner of 
the land unit and click again set another vertex; continue digitizing outside of the boundary making 
sure your new boundary has plenty of overlap into the field you want to have a coincident boundary 
with. 
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WARNING:  Do not try to follow the existing boundary, this could cause small gaps between the two 
fields. Draw the reshape line completely over the adjacent land unit and the system will 
automatically snap to the adjacent land unit boundary. 
Finish by double clicking back inside of the selected field. The reshaped boundary will automatically 
snap to the adjacent Locked or Plan land unit boundary and fix the overlap error. 
 

 
 
5. Save the edits and stop editing. 
 
The edited Draft land unit will update to  Sketch status and can be checked into the NPAD database 
using the Check In Features button on the Toolkit Toolbar (assuming it has the required land unit 
attributes). If the reshape was successful, when the field is checked in to NPAD it will come back with a 

 Planned status. 
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Edit a Shared Boundary  
The Land Unit Editor toolbar no longer has the “Topology Tools” to reshape and move vertices on an arc 
or edge of a polygon shared by the land units on both sides, so that it acts on both polygon land units at 
the same time. 
 

 

 
 

 
 

 
The Reshape  and Vertex Edit  tools are used to edit each land unit one at a time. If one land unit 
is reshaped “away from” an adjacent polygon, gaps will be created between the polygon land units. If 
the reshape goes into the adjacent polygon, the land unit will be snapped to enforce the “Must Not 
Overlap” topology rule. See examples below: 
 

1. On the Toolkit toolbar, click the Toolkit Digitizer tool. 
 
2. In the Select a Layer to Edit dialog, click the drop-down arrow and select Case PLU and click OK. 
 
3. The Land Unit Editor toolbar is added. 
 
To edit a boundary that is simultaneously effective for both land units at once, the now separate 
Topology Toolbar must be used. 
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4. Add the Topology toolbar by selecting Customize > Toolbars > Topology from the ArcMap main 
menu. 

 

 
 

 

 
 

 

 
 

 

 

5. On the Topology toolbar, click the Select Topology button. 

6. In the Select Topology dialog, select the Geodatabase Topology radio button, select Land Unit 
Topology and click OK. 

7. On the Topology toolbar, click the Topology Edit Tool button and click on a common boundary 
between two land units. The selected edge will be highlighted in magenta. 
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5. On the Topology toolbar, select the Modify Edge Tool  to edit shared vertices or the Reshape 
Edge Tool  to move the line to the desired location. Both polygons will be reshaped 
simultaneously without any gaps or overlap as shown in the following example. 

 

 
 

 
 
6. On the Land Unit Editor toolbar, save your edits by clicking Editor > Save Edits. 
 
7. Stop Editing by clicking Editor > Stop Editing. 
 
8. Enter or update land unit attributes and Check-In land units if needed. 
 
Replace Land Units in the Case PLU Layer 
Land units cannot be deleted if they have practices scheduled on them that are in a planned or applied 
status. The Link to Tabular tool was removed in Toolkit 8 and replaced with the Replace Land Unit tool on 
the Land Unit Editor Toolbar. The Replace tool allows the planner to select a land unit and replace the 
existing shape either by digitizing or by selecting a new boundary from a polygon source layer. The new 
land unit shape will automatically be updated with the original land unit attributes. 
 
1. On the Toolkit Toolbar, click on the Toolkit Digitizer  and select Case PLUs for the layer to edit. 
 

2. On the Land Unit Editor Toolbar, click the Select Field  button and then click in the map view to 
select the land unit to be replaced. 

 
  



Task Guide 24 P a g e  | 21 September 16, 2016 

3. Click the Replace Geometry button. The Replace Geometry dialog will open and the selected land 
unit will be removed from the Case PLUs layer. 

 

 
 

 

 

 
  

4. In the Replace Geometry dialog, select Digitize New Land Unit or Copy Land Unit from Layer. 

5. If copying from a source layer, select your source layer from the dropdown menu. Click in the map 
view to select the polygon from the source layer to use as the new land unit shape, then click the 
Replace Land Unit button. If digitizing the new land unit shape, click in the map view to begin 
digitizing the new land unit and double-click to complete the sketch. 
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6. The Replace Tool will provide the option to update the land unit acres with the calculated acres for 
the new land unit shape. Select Yes to update the acres or No to keep the original land unit acres. 

 

 
 
7. Save the edits and stop editing. The land unit attributes and any practices associated to the original 

land unit are retained with the updated land unit shape. 
 
Collapse Land Units in the Case PLU  
The collapse tool allows the user to select land units in the Case PLUs layer that overlap by more than 
25% and collapse the selected land units into a single land unit. The duplicate land units are deleted and 
any existing plans and practices from those land units will be pointed to the land unit that is saved. Land 
Units in Active ProTracts contracts are defaulted as the land unit to save. 
 
1. On the Toolkit Toolbar, click on the Toolkit Digitizer  and select Case PLUs for the layer to edit. 
 

2. On the Land Unit Editor Toolbar, click the Select Field  button and then click in the map view to 
select the stacked land units that will be collapsed. The land units must overlap by at least 25%. In 
this example, there is a Legacy land unit stacked with a land unit in Plan status. 
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3. In the Select Feature dialog, select the land units to collapse and then click the Collapse  tool 
button. 

 

 

 
 

4. In the Collapse Land Units dialog, select the land unit to keep and the land unit(s) to delete. Click OK. 

5. Save the edits and stop editing. Only the land unit that was saved remains. Any plans or practices 
that were associated to the deleted land unit(s) are now associated to the land unit that was saved. 

 
Split Land Units in the Case PLU Layer 
Land Units can be split after they are created as long as they are not locked by an active ProTracts 
contract or a CSP plan. When a land unit is split, one field is selected to retain the attributes. The other 
field will change to Sketch status and must be attributed in order to check back into NPAD. 
 
1. On the Toolkit Toolbar, click on the Toolkit Digitizer  and select Case PLUs for the layer to edit. 
 

2. On the Land Unit Editor Toolbar, click the Select Field  button and then click in the map view to 
select the land unit to split. 

 
3. Use the Split Field  tool to digitize a line where you want to split the field, starting the split 

outside of the land unit, and finishing the sketch on the outside of the land unit. 
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4. After completing the split, a pop-up dialog allows you to choose which side of the split polygon will 
retain the attributes of the original land unit. Clicking on Polygon 1 or Polygon 2 in the dialog 
window will flash the selected feature in the map view. Select the polygon to retain the attributes 
and click OK. 

 

 
 

 

 
 

5. Click OK in the Toolkit Infomration window. 

6. Save the edits and stop editing. 
 
7. Attribute the split land unit that did not receive the original attributes. The land unit will 

automatically check into NPAD after the required attributes are entered. 
 
Merge Land Units in the Case PLUs Layer 
Land units can be merged if they are not locked by an active ProTracts contract or a CSP plan. When two 
or more land units are merged, one field is selected as the target and any attributes previously entered 
for that field are applied to the merged field. 
 
1. On the Toolkit Toolbar, click on the Toolkit Digitizer  and select Case PLUs for the layer to edit. 
 

2. On the Land Unit Editor Toolbar, click the Select Field  button and then click in the map view to 
select 2 or more land units to merge. To select multiple fields, click and drag with the mouse or hold 
down the Shift key on the keyboard while clicking in each field to select. 
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3. In the Select Feature dialog window, hold the Ctrl or Shift key while clicking to select the land units 
to merge. Click OK. 

 

 
 

 

 

 
 

4. On the Land unit Editor Toolbar, click the Merge Fields  tool. The tool will not be active unless 
two or more land units are selected. 

5. In the Select Merge Target dialog, select the land unit to use for attributes. Clicking on each feature 
in the dialog will flash it on the screen. Click OK to complete the merge. 

6. Once the land units have been merged, Toolkit will validate the land unit edits. 
 
7. Save the edits and stop editing. 
 
Explode Multi-Part Land Units in the Case PLUs Layer 
Multi-part land unts occur when two or more non-contiguous land units are merged together. This 
creates physically separate polygons that are tied to a single attribute record and thus have the same 
land unit attributes. The Explode Tool can be used to “un-merge” or split a multi-part land unit creating 
a separate feature for each physically separate polygon. One field is selected as the target and any 
attributes previously entered for the multi-part field are applied to the selected target. 
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1. On the Toolkit Toolbar, click on the Toolkit Digitizer  and select Case PLUs for the layer to edit. 
 

 

 

 

 
 

2. On the Land Unit Editor Toolbar, click the Select Field  button and then click in the map view to 
select the multi-part land unit to explode. 

3. On the Land unit Editor Toolbar, click the Explode Field  tool. The tool will not be active unless a 
land unit is selected. 

4. In the Select Explode Target dialog, select the land unit that will retain the attributes. Clicking on 
each feature in the dialog will flash it on the screen. Click OK to complete the explode. 

5. Save the edits and stop editing. 
 
6. Attribute the land unit(s) that did not receive the original attributes. The land unit(s) will 

automatically check into NPAD after the required attributes are entered. 
 
Delete Land Units in the Case PLUs Layer 
Land Units cannot be deleted if they have practices that are in Planned status. If there are planned 
practices that will not be applied, they must be cancelled and the changes saved to NPAD prior to 
deleting the land unit(s). 
 
1. On the Toolkit Toolbar, click on the Toolkit Digitizer  and select Case PLUs for the layer to edit. 
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2. On the Land Unit Editor Toolbar, click the Select Field  button and then click in the map view to 
select the land unit(s) to delete. To select multiple fields, click and drag with the mouse or hold 
down the Shift key on the keyboard while clicking in each field. Then, in the Select Feature dialog 
window, hold the Ctrl or Shift key while clicking to select the land units to delete and click OK. 

 

 

 

 

 
 

  

3. Press the Delete key on the keyboard to delete the selected land unit(s). 

4. In the Continue dialog, click OK to confirm and delete the land unit(s). 

 
Deleted land units are removed from the Case PLUs. If there were any practices in Cancelled or 
Applied status associated with the land unit, the deleted land unit is moved to the History PLUs 
layer. 
 

5. Save the edits and stop editing. 
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Circle Tool and Center Pivot Tool 
The Circle Tool on the Land Unit Editor toolbar is very similar to the Create Land Unit tool. The only 
difference is that the Circle Tool creates a circular land unit, which can be used for creating fields for 
center pivots. When existing fields in a Case PLU will have a center pivot installed, a planner may want 
to merge existing fields to create a new center pivot field, and create new fields for the pivot corners. 
This can be done with the Center Pivot tool. 
 
1. To use the Center Pivot Tool, click on the Toolkit Digitizer  and select Case PLUs for the layer to 

edit. 
 
2. Click Center Pivot on the Land Unit Editor Toolbar to open the Center Pivot Toolbar. 
 

 

Center Pivot Toolbar 

 

 
 

 

Center Pivot Graphic Template (Optional)   
This template may be used if you do not have an imagery file to trace an existing center pivot or when 
you wish to create a perfect circle with a specified radius. 
 
Specify Radius 
1. On the Center Pivot Toolbar, click the Center Pivot Graphic Template button. 
 
2. Holding down the left mouse button, click in the map area where you want to place the center of 

the pivot. While holding down the left mouse button, press the ‘R’ key on your keyboard. 
 
3. In the Radius dialog enter a value in feet and press the <Enter> key. A sketch of the pivot is displayed 

in a magenta color. 
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Drawing the Center Pivot Interactively 
1. Left-click in the map area where you want to place the center of the pivot. Move the cursor to the 

perimeter of the circle and double-click to set the circle. 
 

Select Elements Tool   
The Center Pivot Graphic Template tool creates a graphic, which can be adjusted easily using the Select 
Elements tool. When the template is selected it will be highlighted with a dashed blue line. You can then 
click and drag to move the entire template or click and drag on a corner to resize the graphic as needed. 
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Select Field Tool   
One of the requirements in order to create a center pivot shape is for there to be an existing exterior 
field from which the center pivot can be cut out. Alternatively, the Center Pivot Tool can be used to 
combine several fields into a pivot. In this case, you would only select one field that will part of the 
pivot. 
 
A field must be selected using Select Field tool for the Center Pivot Tool button to become active. 
 

 
 

Center Pivot Tool   
Once you have the exterior field that will contain the center pivot shape selected (or one field selected 
that will be included in the pivot, as shown in the example above), the tool will become activated. 
 
The instructions for creating a center pivot irrigation system are as follows: 
 
1. Once you have activated and clicked on the Center Pivot Tool you will have an edit cursor present. 

The editor will automatically snap to the exterior fields. 
 
2. The first click starts the sketch; the second click will begin the arc of the side of the center pivot 

shape. The third click finishes the arc. Continue this process until you create the full center pivot 
shape. Double-click on the original starting point to finish the center pivot shape. 
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The result is a circle. 
 

 
 

 

 
 

 
  

3. Once the pivot is complete, use the Select Elements tool to select the graphic template, then right-
click and select Delete to remove it from the map. 

4. Save your edits and close the Land Unit Editor. The result is a center pivot field with four pivot 
corners. Each is a separate field, and will need to be attributed. One of the corners will typically have 
the attributes from the original field. 
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Example:  Creating a Center Pivot Irrigation System 
1. The first click is at the top of the circle; the second click is to the left along the graphic template. 
 

 
 

 

 
 

  

2. When dragging the mouse towards the third click, notice how the arc is forming. In the following 
view, the imagery is turned off to illustrate this more clearly. 

3. Continue around the entire center pivot shape. 
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4. Select the graphic template using the Select Elements tool. Right-click and select delete as shown 
below. DO NOT PRESS THE DELETE KEY. 

 

 

 
 
  

 
At the end of the process you will have 5 land units:  the center pivot and 4 corner land units. 
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If the procedure worked successfully, a new field is created where the Center Pivot Tool snaps to the 
exterior field. (Notice the new field at upper right in the example shown below.) In this example, there 
also were four snaps, so there are four new shapes plus the center pivot shape. 
 
Note: The number of fields that are created with this tool depends on where you snapped on the 
polygon selected in Step 2. 
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Task Guide 25 - Modifying Land Units in CSP Plans/Contracts 

Contents: 
Modify a Land Unit in a CSP Plan ............................................................................................................... 1 

Modify a Land Unit in Locked Status in a CSP Plan .................................................................................... 3 

 
Once you add land units to a CSP plan, the land unit is linked to the Conservation Management Unit 
(CMU). It cannot be edited in the Case PLUs layer unless the land unit is first removed from the CSP Plan. 
 
Reasons that you may need to remove land units/CMUs from the CSP plan are:  

• To revise the boundary or attributes before adding it back to the CSP plan. 
• To remove land from the CSP plan because the land has been enrolled in CRP, loss of control, 

land has been sold, etc. 

Modify a Land Unit in a CSP Plan 

1. Check out and open the customer folder that contains the CSP plan. 
 

2. Open the CSP Plan using the Create/Manage Plans button  on the Toolkit toolbar. 
 

3. Click the Modify Land Units in a CSP Plan  button on the Toolkit toolbar to open the CSP 
Protracts Land Use Check dialog. 

 

4. Using the Select Features tool  click in the map view to select the land unit(s) to be removed 
from the CSP plan. 

 
 

 

 

5. Click the Remove button in the CSP Protracts Land Use Check dialog. 
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6. Click OK in the Toolkit Information to remove the selected land unit(s) from the CSP plan. 

7. If needed, edit the land unit using the land unit editor tools. In the example below, the land unit was 
split using the Split Field tool. NOTE:  If the land units are not all in the same Customer Folder, you 
may need to check out multiple folders to edit the Case PLUs. 

8. After completing the edits, save the edits and stop editing. 

9. If needed, update the land unit attributes. The land units will automatically check in when 
attributed. 
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10. If needed, open the CSP Protracts Land Use Check and add the edited land unit(s) back to the CSP 
Plan. Ensure that any changes to the land unit(s) match what is in the CMT. If needed, go to 
Protracts and modify the CMT accordingly. 

 

 
 

 

 
 

Modify a Land Unit in Locked Status in a CSP Plan 

This example shows how to remove a land unit from the CMU to edit the land unit information when 
the land unit is in locked status because it is associated with an active EQIP contract. 
 
1. In the Table of Contents, turn on the CMU layer (the CSP Plan), the Case PLUs, and the Active PLUs. 

2. Click the Modify Land Units in a CSP Plan  button on the Toolkit toolbar to open the CSP 
Protracts Land Use Check dialog. 
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3. Using the Select Features tool  click in the map view to select the land unit(s) to be removed 
from the CSP plan. 

 

 
 

 

 
 

4. In the CSP Protracts Land Use Check dialog, click the Remove button. 
 
5. Click OK in the Toolkit Information window. 
 
6. The CMU layer no longer displays the removed land unit as part of the CSP Plan. Note that the land 

unit is in Locked status in the Active PLUs layer.  

7. Open ProTracts, select Manage Contracts, and select the contract that is linked to the Locked land 
unit. (Note:  Ensure that the customer folder with the plan linked to the ProTracts contract is 
checked IN at the time the ProTracts modification is initiated). 
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8. Start a Contract Modification. Select “Acreage or Land Unit” as the the reason for the modification. 
 

 
 

 

 
 

 

 

 
 

9. Provide the justification for the modification and click OK. The screen will refresh and an Unlock 
Folder button will activate to unlock the Toolkit folder. Click the Unlock Folder button. 

10. In Toolkit, check out the Customer Folder containing the land unit that needs to be modified in the 
Case PLUs layer. 

11. The land unit will now appear in Draft status instead of Locked status and you can make the needed 
edits. You can change land unit attributes, split the field, or edit the field boundary. Refer to the 
Land Unit Editor section for specific information. If you need to delete a land unit and replace it with 
a new shape, make sure to use the Replace tool on the Land Unit Editor. 
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12. Land Units that were edited or attributes changed will automatically check in and update to Plan 
status when those changes are saved. 

 

 

 

 

 

 

 
 

13. Check in the Toolkit Customer Folder. 

14. Return to ProTracts, click the Lock Folder button, and complete the modification. 

15.  Once the modification is approved, return to Toolkit and open the customer folder that contains 
the CSP plan. 

16. Open the CSP Plan and the CSP Protracts Land Use Check dialog. 

17. Add the revised land unit back to the CSP Plan.  
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Task Guide 26 - Modifying Land Units in ProTracts Contracts 

Contents: 

Modify a Land Unit in Locked Status .......................................................................................................... 2 

Splitting a Land Unit in an Active ProTracts Contract ................................................................................ 4 

 
When a modification is started in ProTracts, any Toolkit folders linked to the contract are locked  
preventing Toolkit from checking out a ‘write copy’ of the folder and making changes that could 
contradict changes being made in ProTracts. If changes need to be made in the Toolkit folder, it would 
need to be unlocked using the Unlock Folder button in ProTracts. If the customer folder is already 
checked out in Toolkit, a ProTracts contract modification cannot be started until after the Toolkit folder 
is checked back in. This insures that the data ProTracts is using for the modification is current and will 
not be overwritten by other changes made in Toolkit. 

ProTracts will allow the Toolkit folder to be unlocked while a contract is in a modification. When the 
Toolkit folder is unlocked, the land unit topology will be checked and set to “draft” or “planned” status 
(as appropriate) when the folder is checked out in Toolkit. The land unit geometry and/or land unit 
attributes can then be edited in Toolkit. 
 
Land units that are Locked by an active ProTracts contract will be temporarily set to Draft or Planned 
status when the Toolkit folder is unlocked in ProTracts and checked out in Toolkit. Land units that are 
edited during the contract modification should be checked back in using the Toolkit “Check-In Features” 
Tool in ArcMap. Land units may remain in Draft status due to topology issues that were not (or cannot 
be) resolved, the revised shape will be retained when the plan is locked in ProTracts. All land units in the 
contract will change back to Locked status after the Toolkit folder is locked in ProTracts. 
 
For practices included in ProTracts contracts, changes to the practice attributes may be made in the 
Toolkit Practice Schedule or the Attribute Tool when the Toolkit folder has been unlocked during a 
modification. Planned dates for ProTracts contracted practices will need to be updated in ProTracts. If 
the planned amount has been updated in Toolkit, ProTracts will display a message that the item amount 
was changed and the components should be checked. Planned practice amounts and dates may also be 
updated from ProTracts and will be written back to NPAD when the modification is approved. Practice 
layer geometry (practice shapes) can and should be edited as needed in Arc Map. This can be done 
when the Toolkit folder is unlocked during a modification, however the practice shapes can also be 
updated outside of a ProTracts modification. 
 
Before the ProTracts modification can be submitted for approval, the Customer Folder will have to be 
checked back in from Toolkit and locked again in ProTracts. At this point any changes made in Toolkit 
would be synced up with ProTracts and any problems would have to be corrected before the 
modification could be approved. 
 
When completing a modification in ProTracts to add a new practice, ProTracts will create a back feed to 
Toolkit when the modification is approved assigning a new plan approval date to the plan associated 
with the contract in ProTracts. 
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When a plan or practice items are transferred in Toolkit that are included in an active contract in 
ProTracts, the plan name will continue to be displayed in ProTracts. 
 
Only certain types of modifications allow unlocking the Toolkit folder. Predominant Modification 
Reasons in ProTracts that allow unlocking Toolkit Folders include: 

a. Acreage or Land Unit 
b. Add, Edit or Delete Practices 
c. Appeal Decision 
d. Established Reapplication 
e. Land Transfer 
f. Practice Design or Specification Change 
g. TA Items 
h. Other 

 
The boundaries or attributes of Locked land units  cannot be changed when they are tied to an active 
EQIP or other ProTracts program contract. The only way to make changes to land units locked by an 
active ProTracts contract when needed is through a Protracts modification.  
 
The Land Unit Quick Report Tool can be used to determine if a land unit is locked by ProTracts or if the 
land unit is locked by a reconciled easement or a CSP plan. The land unit status is also displayed in the 
Land Units section of the Practice Schedule. 
 

 
 
Modify a Land Unit in Locked Status  

1. Open ProTracts and select Manage Contracts. Select the contract that is linked to the Locked land 
unit. Note:  All associated contracts must be modified to unlock the land unit. 
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2. Start a Contract Modification and select Acreage or Land Unit as the reason for the modification. 
 

 
 

 

 
 

 

 

3. Provide the justification for the modification and click OK. The screen will refresh and an Unlock 
Folder button will activate to unlock the Toolkit folder. Click on the Unlock Folder button. 

4. In Toolkit, check out the Customer Folder containing the land unit that needs to be modified in the 
Case PLUs layer. 

5. The land units will now appear in Draft or Plan status instead of Locked status and you can make the 
needed edits. You can change land unit attributes, split fields or edit the field boundaries. Refer to 
the Land Unit Editor section for specific information. If you need to delete a land unit and replace it 
with a new shape, make sure to use the Replace tool on the Land Unit Editor. 
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Splitting a Land Unit in an Active ProTracts Contract 

It is very important to split the polygon properly to maintain the correct land unit tract and field 
numbers with the current ProTracts contract. These steps can only be taken after a ProTracts 
modification is started and the land unit is unlocked. 
 
1. On the Toolkit toolbar, click the Toolkit Digitizer tool  button. 
 
2. Select Case PLUs for the layer to edit and click OK. The Land Unit Editor toolbar is added to ArcMap. 
 

 
 

 

 

 

 
 

 

 
 

 
  

3. Use the Select Field  tool and click on the Field you want to split. 

4. Use the Split Field  tool to digitize a line where you want to split the field. 

5. Select the feature to retain the original land unit attributes in the Select Split Target dialog. When 
you select each polygon in the dialog window, the feature will flash on the screen. Click OK. 

6. Click OK in the Toolkit Information window. 

7. On the Land Unit Editor toolbar, click Editor and select Stop Editing. Select Yes to save your edits. 
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8. In the example below, the land unit was split, and the original attributes were retained for Polygon 1 
(the larger land unit). The land unit selected to retain the attributes will automatically check in when 
the edits are saved. The larger land unit is still part of the EQIP contract, and the split portion is 
removed from the contract.  

 

 
 

 

 
 

9. Use the Attribute Tool to make any needed attribute changes. The land units will automatically 
check in when attributed. 
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10. The land units will display in Plan status if they met topology rules. If needed, open the plan that 
contains the contracted practices to make any needed changes to the practice boundaries or add 
new practices. (For example, if the split portion had practices that would be added as new items.) 

 

 
 

 

 

 
 
  

11. Update the Plan Approval Date if needed and check the customer folder in to Toolkit after all edits 
have been made. 

12. Return to Protracts and click the Lock Folder button. Make any needed changes to CIN extents (CIN 
amounts, not “planned” amounts), land units associated with the CIN, etc. based on the changes 
made to the land units and complete the modification. 
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13. Once the modification is approved, return to Toolkit and open the customer folder that contains the 
modified land units in the Case PLUs layer. The original land unit is now in Locked status, and the 
split portion of the original land unit is in Plan status. 
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Task Guide 27 - Practice Layers 

Contents: 

Create a New Point Practice ..................................................................................................................... 4 

Edit an Existing Point Practice ................................................................................................................... 5 

Create a New Line Practice ....................................................................................................................... 6 

Edit a Line Practice .................................................................................................................................... 9 

Create a Polygon Practice ....................................................................................................................... 10 

Edit a Polygon Practice ............................................................................................................................ 12 

Example:  Create a New Polygon Practice using the Import Practice Shape Tool .................................. 13 

Example:  Create a New Line Practice using the Convert and Create Tool ............................................ 15 

Example:  Explode a Multipart Practice using the Explode Tool............................................................. 16 

Example:  Replace a Practice Line using the Replace Shape Tool ........................................................... 17 

 
The Practice layers stores geospatial and tabular data for practices selected by a client to address 
resource concerns. The Practice layers serves as a register of the conservation practices, planned and 
applied for the unique geographic area. 
 
Practice Business Rules 
1. A practice must be associated with a planning land unit. 

a. If a practice is located entirely outside the plan’s PLUs, the planner must select one of the 
plan’s PLUs to complete the attribution of the practice. 

2. Attributes for a practice associated with a financial assistance contract cannot be cancelled, deleted, 
or edited except through a contract modification. 

a. Deleting and editing the planned amount and planned date can be done in ProTracts. 
b. Editing the planned amount, the practice shape and transferring the practice can be done in 

Toolkit. 
c. Editing the practice shape can be done in Toolkit outside of a contract modification. 

3. Practices can only be planned or applied based upon the following PLU geometry status rules. 
 

 

  

PLU Geometry Status Can Plan a Practice Can Apply a Practice 
Sketch N N 
Plan Y Y 
Draft N Y 
Legacy N Y 
Locked Y Y 

4. All practices must have a shape and attributes before the customer folder is checked into NPAD. If 
the practices are missing attributes, the practice will be deleted upon check in. 

5. Annual Practices are when the same practice is scheduled multiple years on the same land unit. 
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6. A line or polygon practice may cross one or more PLUs. 
a. A practice may begin or extend outside the boundary of a plan’s PLU. 
b. Toolkit will intersect the PLUs and create one practice record. The planner will then need to 

assign one land unit to the practice record. 
c. Toolkit will default the calculated planned amount for all practices. The planner can 

manually update the planned amount if needed. 
7. A point practice may be digitized outside or inside the boundary of a client’s PLU. 

a. Each point should represent one practice but the planner is allowed to update the planned 
and applied amount to equal more than one if needed. 

8. Practice digitizing tools will permit planners to digitize in the correct feature type. 
a. The following matrix is used to default to the correct geometry type based upon the practice 

unit that is used for performance reporting and is the standard unit in the Conservation 
Practice Standard. 

 

 

Point Geometry Line Geometry Polygon Geometry 
Number Mile Acre 
Animal Unit Feet Square Feet 
Cubic Feet Linear Feet/Year Acre Feet 

9. A practice may be created by one of these methods: 
a. Digitizing. 
b. Copying a PLU using “Schedule Full Extent Practices” in the Toolkit Practice Schedule. 
c. Copying and pasting from other source layers. 

10. ProTracts programs will not be displayed in Toolkit for selection. 
11. Farm Bill programs are set by ProTracts at the time the contract is obligated. 
12. If the contract is cancelled or modified, ProTracts will make appropriate updates to the practice 

program. 
a. If the contract is cancelled prior to any payments, the program will be set back to CTA-

General. The practice-under-contract indicator is set to ‘no’, unlocking the practice to allow 
modifications. 

b. If payments have been made, the practice program is not reset. It continues to indicate that 
some program funds were expended for that practice. The practice-under-contract indicator 
is set to ‘no’. 

c. If there is a situation where a subsequent contract is obligated to pay an additional amount 
on the practice, the program in the latest contract will replace the previous program for the 
practice. 

13. The Toolkit planner can change a non-ProTracts program to a different program. 
14. Each practice instance can only be associated to one contract item or the contract item is not 

allowed to be uploaded to a ProTracts application. 
15. Most practices can be transferred to plans in the same customer folder or to a new customer folder 

as long as the practice(s) selected do not meet one or more of the following conditions: 
a. Practice is not “Cancelled”. 
b. Practices in active ProTracts contracts that are not under a current contract modification. 
c. CStwP practices created in a CSP Plan. These must be transferred at a plan level. 
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16. Each practice has a practice status. 
 

 
  

Practice Status Business Rules Reported 
to PRS 

Alternative 1. When a practice is created the status is “Alternative”. 
2. ProTracts will not allow a contract modification or 

contract obligation to be approved if the practice is 
“Alternative”. 

N 

Planned 1. After the plan is signed the “Plan Approval Date” should 
be entered or updated. This automatically updates all 
“Alternative” practices to “Planned”. 

Y 

Applied 1. The applied amount and applied date must be entered 
together in order for the practice to be “Applied”. 

2. When the practice applied date and applied amount are 
entered in Toolkit or ProTracts the status automatically 
updates to “Applied”. 

3. Practices cannot be applied if they are not “Planned”. 
4. If the applied date and applied amount are deleted, the 

status will automatically change to “Planned”.  

Y 

Cancelled 1. The planner is allowed to cancel a practice that is in 
“Planned” status.  

2. The “Cancelled” status ensures the practices the client 
agreed to remain in the plan as a permanent record and 
any plan documents provided to the client match the 
practice schedule. 

3. When a plan is cancelled all “Planned” practices will be 
“Cancelled”. 

N 

Deleted 1. A practice can be “Deleted” if the practice is in 
“Alternative” status. 

N 
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Create a New Point Practice  

1. Select the Check In/Out Tab and check out a customer folder and open. 
 

 

 

 

 

  
 

 

 

 
 

2. Select the Customer File Tab, select the ArcGIS_Projects folder and open an ArcMap document 
(.mxd file). 

3. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 

4. Use the Zoom In  tool or the Pan  tool to locate the area you want to schedule a practice. 

5. If there is no existing Point Practice Layer for the selected plan: 
a. On the Toolkit Toolbar click the New Toolkit Layer  button. 
b. In the New Toolkit Layer dialog window select Practice Point and click OK. 

6. If there is an existing Practice Point Layer, click the Toolkit Digitizer  tool. Select Practices (points) 
from the select layer to edit dropdown and click OK. 

 
The Practice Points Editor toolbar is added. 
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7. On the Practice Points Editor toolbar, click the Add Practice button. Click in the map view where you 
want to create the practice. 

 

 
 
8. On the Practice Points Editor toolbar, click Editor and select Stop Editing. Click Yes to save your 

edits.  
 

9. Attribute the practice using the Attribute Tool . 

Edit an Existing Point Practice  

The following example demonstrates how to edit existing point practices that have moved or changed 
since the practice was scheduled. 
 

1. Select the Create/Open/Manage Plans Tool  and select an existing plan. 
 
2. On the Toolkit Toolbar, click the Toolkit Digitizer  tool. 
 
3. In the Select a Layer to Edit dialog, select Practices (points) from the dropdown menu. 
 

 
 
4. On the Practice Points Editor toolbar, select the Edit Tool  and click on the practice you want to 

edit to select it. Then click and drag while holding the left mouse button to move the practice to the 
new location. To select multiple points, hold down the <Shift> key and select the points. 
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5. On the Practice Points Editor toolbar, click Editor and select Stop Editing. Click Yes to save your 
edits. 

 
If the practice was moved to a different land unit, you will need to update the land unit information 
using the attribute tool which will automatically update the practice schedule. 
 

Create a New Line Practice 

1. Select the Check In/Out Tab and check out a customer folder and open. 
 
2. Select the Customer File Tab, select the ArcGIS_Projects folder and open an ArcMap document 

(.mxd file). 
 

3. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 
 
4. Use the Zoom In  tool or the Pan  tool to locate the area you want to schedule a practice. 
 
5. If there is no existing Practice Line Layer for the selected plan: 

a. On the Toolkit Toolbar click the New Toolkit Layer  button. 
b. In the New Toolkit Layer dialog window select Practice Line and click OK. 

 

   
 

 

 
 

6. If there is an existing Practice Point Layer, click the Toolkit Digitizer  tool. Select Practices 
(polylines) and click OK. 
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The Practice Lines Editor toolbar is added. 
 

 
 

 

 
 

  

7. On the Practice Lines Editor toolbar, click the Add Practice  button. 
 
Single Line 
8. To create a single line, left-click with the mouse to begin the line. Double-click when the line is 

complete. 
 
Multipart Line 
9. To create a multipart line, you can digitize each line separately and then select and merge the lines. 

Or, left-click with the mouse to begin the first line then right-click at the end and select finish part. 
Move to the next line and repeat. When the last line is digitized, right-click and select finish 
sketch. 

10. If selecting and merging individual lines to create a multipart line, use the Select Practice Line  
tool on the Practice Lines Editor toolbar and click and drag or hold the <Shift> key to select the lines. 
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11. In the Select Feature window, hold down the <Shift> or <Ctrl> key to select the practices to merge, 
then click OK. 

 

 
 

 

 
  

12. Click the Merge Practices  button.  
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13. In the Select Merge Target dialog, select one of the features to use for attributes and click OK. 
 

 
 

 

 
 

 

 

 

14. Click OK in the confirmation window. 
 
15. On the Practice Lines Editor toolbar, click Editor and select Stop Editing. Click Yes to save your edits. 
 

16. Attribute the practice using the Attribute Tool . 

Edit a Line Practice 

1. Select the Create/Open/Manage Plans Tool  and select an existing plan. 
 
2. On the Toolkit Toolbar, select the Toolkit Digitizer tool, select Practices (polylines) as the layer to 

edit and click OK. 

3. On the Practice Lines Editor toolbar click the Select Practice Line  button and click on the line(s) 
you want to edit. 

4. Use the appropriate tool to edit the line practice(s): 

a. Explode Practice  
b. Replace Shape  

c. Split Practice Line  (active when a single feature is selected) 

d. Merge Practices  (active when multiple features are selected) 

e. Reshape Line Practice  (active when a single feature is selected) 
f. Practice Vertex Edit  

5. On the Practice Lines Editor toolbar, click Editor and select Stop Editing. Click Yes to save your edits. 
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6. If needed, update practice attributes using the Attribute Tool . 
 

Create a Polygon Practice 

1. Select the Check In/Out Tab and check out a customer folder and open. 
 
2. Select the Customer File Tab, select the ArcGIS_Projects folder and open an ArcMap document 

(.mxd file). 
 

3. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 
 
4. Use the Zoom In  tool or the Pan  tool to locate the area you want to schedule a practice. 
 
5. If there is no existing Polygon Practice Layer for the selected plan: 

a. On the Toolkit Toolbar click the New Toolkit Layer  button.  
b. In the New Toolkit Layer dialog window select Practice Polygons and click OK.  

 

  
 

 

 
  

6. If there is an existing Practice Polygon Layer, click the Toolkit Digitizer tool, select Practices 
(polygons) for the layer to edit and click OK. 
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The Practice Polygons Editor toolbar is added to your project. 
 

 
 

 

 

 

 
 

  

7. On the Practice Polygons Editor toolbar, click the Add Practice  button. 
 
Single Polygon 
8. To create a single polygon, digitize the polygon with the mouse, using a single left-click to begin the 

sketch and double-clicking to finish. 

 
Multipart Polygon 
9. On the Practice Polygons Editor toolbar, use the Add Practice tool to digitize each polygon. 

10. Using the Select Practice Polygon  button, click and drag or hold the <Shift> key to select the 
polygons to merge. 



Task Guide 27 P a g e  | 12 September 16, 2016 

11. In the Select Feature window, use the <Shift> or <Ctrl> key to select the polygons to merge, then 
click OK. 

 

 
 
12. On the Practice Polygons Editor toolbar, click the Merge Practices  button. 
 
13. In the Select Merge Target dialog, select the practice to use for attributes and click the OK button. 
 

 
 
14. Click OK in the Toolkit Information window. 
 
15. On the Practice Polygons Editor toolbar, click Editor and select Stop Editing. Click Yes to save your 

edits. 
 

16. Attribute the practice using the Attribute Tool . 
 

Edit a Polygon Practice 

1. Select the Create/Open/Manage Plans Tool  and select an existing plan. 
 
2. Select the Toolkit Digitizer tool, select Practices (polygons) as the layer to edit  and click OK. 
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3. Using the Select Practice Polygon  button, select the Practice Polygon to edit. 

4. There are multiple practices at that location, the Select Feature window will appear. Select the 
practice(s) to edit from list and click OK. 

5. Use the appropriate tool to edit the polygon practice(s): 
a. Split Practice Polygon  (active when a single feature is selected) 

b. Merge Practices  (active when multiple features are selected) 

c. Reshape Practice  

d. Explode Practice  
e. Replace Shape  
f. Practice Vertex Edit  

 
6. On the Practice Lines Editor toolbar, click Editor and select Stop Editing. Click Yes to save your edits. 
 

7. If needed, update practice attributes using the Attribute Tool . 
 

Example:  Create a New Polygon Practice using the Import Practice Shape Tool 

The Import Practice Shape Tool can be used to import point, line, or polygon features from a selected 
source layer to the appropriate practice layer. The following example shows how to import to the 
Practice (polygons) layer. 
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1. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 
 
2. If there is no existing Polygon Practice Layer for the selected plan, select the New Toolkit Layer  

button. In the New Toolkit Layer dialog window select Practice Polygons and click OK. 
 
3. If there is an existing Practice Polygon Layer, click the Toolkit Digitizer tool, select Practices 

(polygons) for the layer to edit and click OK. 
 

4. On the Practice Polygons Editor toolbar, click the Import Practice Shape  button. 
 
5. In the Import Practice Shape(s) dialog, select the source layer from the dropdown list. 
 

 
 

 

 
  

6. Click in the map view to select the feature(s) from the source layer to import. If more than one 
feature is selected, the Select Feature window will open. Highlight the feature(s) to select in the 
dialog and click OK. 
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7. After the source layer features are selected, click OK in the Import Practice Shape(s) dialog. 
 

 
 
8. On the Practice Polygons Editor toolbar, click Editor and select Stop Editing. Click Yes to save your 

edits. 
 

9. Attribute the practice(s) using the Attribute Tool . 
 

Example:  Create a New Line Practice using the Convert and Create Tool 

The Convert and Create Tool can be used to create a line practice that follows the perimeter of a 
selected polygon input feature or a polygon practice that follows a closed line input feature. The tool 
will convert from polygon to line or line to polygon and then create the new feature in the practice 
layer. This example shows creating a line practice that follows a selected land unit boundary. 
 

1. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 
 
2. If there is no existing Line Practice Layer for the selected plan, select the New Toolkit Layer  

button. In the New Toolkit Layer dialog window select Practice Lines and click OK. 
 
3. If there is an existing Practice Lines Layer, click the Toolkit Digitizer tool, select Practices 

(polylines) for the layer to edit and click OK. 
 

4. On the Practice Lines Editor toolbar, click the Convert and Create  tool. 
 
5. In the Convert and Create Practice dialog, select the source layer from the dropdown list. 
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6. Click in the map view to select the input feature from the source layer to use to create the new 
practice. Only one input feature can be selected at a time, to create multiple practices using Create 
and Convert, run the tool again for each additional practice. 

 

 

 
 

7. After the source layer feature is selected, click OK in the Convert and Create Practice dialog. 

8. On the Practice Polygons Editor toolbar, click Editor and select Stop Editing. Click Yes to save your 
edits. 

 

9. Attribute the practice(s) using the Attribute Tool . 
 

Example:  Explode a Multipart Practice using the Explode Tool 

The Explode Tool can be used to explode multipart line or polygon practices, creating a practice record 
for each separate practice shape. One practice is selected to retain the original practice record. The 
following example shows how to explode a mulitpart polygon practice. 
 

1. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 
 
2. Click the Toolkit Digitizer tool, select Practices (polygons) for the layer to edit and click OK. 
 

3. On the Practice Polygons Editor toolbar, click the Select Practice Polygon  button. 
 
4. Click in the map view to select the multipart practice to explode. 
 
5. On the Practice Polygons Editor toolbar, click the Explode Practice  Tool. 
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6. In the Select Target dialog, select the feature that will retain the original practice attribute then click 
OK. Clicking on a feature in the dialog will flash it on the screen. 

 

 
 

  

7. On the Practice Polygons Editor toolbar, click Editor and select Stop Editing. Click Yes to save your 
edits. 

 

8. If needed, update practice attributes using the Attribute Tool . 
 

Example:  Replace a Practice Line using the Replace Shape Tool 

The Replace Shape Tool can be used to replace an existing practice shape either by digitizing a new 
shape or importing a new shape from a source layer. The original practice attributes are retained with 
the exception of the planned amount. For practices that are not part of an active ProTracts contract or 
in Applied status, the planned amount will update with the calculated amount of the new practice 
shape. The following example shows how to replace a line practice by digitizing a new practice shape. 
 

1. Select the Create/Open/Manage Plans Tool  and create a new plan or select an existing plan. 
 
2. Click the Toolkit Digitizer tool, select Practices (polylines) for the layer to edit and click OK. 
 

3. On the Practice Lines Editor toolbar, click the Select Practice Line  button.  
 
4. Click in the map view to select the practice to replace. 
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5. On the Practice Lines Editor toolbar, click the Replace Shape  button. 
 

 
 

 

 
 

 

 
 

 
 

6. In the Replace Shape dialog, select Digitize New Practice. Click in the map view to digitize the new 
practice shape, double-clicking to finish the sketch. 

7. On the Practice Lines Editor toolbar, click Editor and select Stop Editing. Click Yes to save your edits. 

8. If needed, update practice attributes using the Attribute Tool . 
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Task Guide 28 – Practice Filter Tool 

 
The Practice Filter tool can be used to filter which practices from the currently selected plan are 
displayed in ArcMap. Practices with the selected attributes will be displayed in the map view while the 
other practices will not be visible. This may be useful to “hide” full extent practices or to only show 
practices for a selected program on the map. 
 
The Practice Filter tool is located on the Toolkit toolbar. 
 

 

 

 
 

 
Practices can be filtered based on any combination of the following attributes:  Practice Status, Planned 
Year, Applied Year, Program Code, Contract #, and Practice Code. A plan must be open in ArcMap before 
using the Practice Filter tool. 
 
1. If needed, open a plan using the Create/Open/Manage Plans tool. 
 

2. On the Toolkit toolbar, click the Practice Filter tool.  
 
3. In the Practice Filter dialog, select the attributes for the practices to display on the map. In this 

example, only practices in Planned status with the EQIP Program Code will be displayed. Practices 
can be filtered based on any combination of Practice Status, Planned Year, Applied Year, Program 
Code, Contract #, and Practice Code. 
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4. Click the Update Current Filter button to review the selections. This will show the selected 
attributes in the Current Filter section and update the choice lists to display only the options that 
meet the current selection.  

 

 
 

 

 

 

5. In the Practice Filter dialog, click OK to apply the filter or Clear Filters to remove the current 
selection and make changes. 

6. When the practices are filtered, the Practice Filter icon will change to red  to let you know that 
not all practices may be visible in the map view. 

7. To clear a practice filter, click the Practice Filter button . In the Practice Filter dialog, click Clear 
Filters and then click OK. 
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Task Guide 29 – Export Features Tool 

 
Contents: 

Export Practices to an Existing Resource Inventory Layer ............................................................................ 1 

Export Plan Land Units to a New Layer ......................................................................................................... 3 

 
The Export Tool can be used to export selected NPAD features, for example practices from a plan or land 
units from the Case PLUs layer, to a shapefile or web feature service. The exported features can then be 
accessed in GPS or other tools. 
 
The Export Features tool is located on the Toolkit toolbar. 
 

 

 

 
  

 
Features from the following NPAD layers can be exported using the Export Features tool:  Case PLUs, 
Active PLUs, History PLUs, Legacy PLUs, Plan Land Units, Practices (polygons), Practices (polylines), and 
Practices (points). The plan land units and practices can only be exported when a plan is loaded. 
 
The destination layer for the exported features may be a new shapefile, an existing shapefile in the 
ArcMap Table of Contents with the same geometry type (point, line, or polygon) as the source layer, or a 
web feature service. 
 

Export Practices to an Existing Resource Inventory Layer 

1. On the Toolkit toolbar, click the Export Features tool.  
 
2. In the Export Feature dialog, select the layer to export features from as the Source Layer. In this 

example, the practice polygons layer is selected. 



Task Guide 29 P a g e  | 2 September 16, 2016 

3. Using the Select Features tool  , click on the map to select features from the source layer to 
export. The Export Features dialog will show the total number of features selected for export. 

 

 
 

 

 
 

4. Select the Resource Inventory layer from the Destination Layer dropdown menu and click OK to 
export the selected feature(s). 
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Export Plan Land Units to a New Layer 

1. On the Toolkit toolbar, click the Export Features tool.  
 
2. In the Export Feature dialog, select the layer to export features from as the Source Layer. In this 

example, the conservation plan is selected. 
 

 
 

 

 
 

 

3. Using the Select Features tool  , click on the map to select features from the source layer to 
export. The Export Features dialog will show the total number of features selected for export. 

4. Select Create New Layer for the Destination Layer to export the selected features to a new 
shapefile. The Destination Layer dropdown menu will also display any valid layers from the ArcMap 
Table of Contents that can be selected to export to an existing layer. 
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5. Select the Coordinate System for the new shapefile. When an existing layer is selected for the 
destination layer, export will use the destination layer’s coordinate system. 

 

 

 
 

6. Specify the Output Feature Class if exporting to a new layer. Enter the file path and file name for the 
new shapefile. By default, the shapefile will be saved in the customer file’s Resource_Maps folder 
and named with the source layer’s name appended with “_export”. For example, 
LandUnits_export.shp. 

7. Click OK to export the selected features. If exporting to a new layer, the new shapefile will be added 
to the ArcMap Table of Contents. 
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Task Guide 30 – Easement Land Unit Tool 

 
Table of Contents: 
Easement Folders and Reconciliation Process ............................................................................................ 2 

Assign Land Unit(s) to an Easement ............................................................................................................ 3 

Remove a Land Unit from the Easement Association ................................................................................. 5 

 

The Easement Land Unit Tool  is used to associate easement land units to the National Easement 
Staging Tool (NEST) ID number associated with the current easement folder. 
 

• At least one land unit must to be associated to the Easement ID in order to create a plan within 
the Easement folder. 

• Easement land units can be associated to more than one plan in more than one folder. 
• Land units can be selected from the Case PLUs or Active PLUs to add an easement association. 
• Land units must be in Planned or Locked status to add an easement association. 
• Land units can be removed from the easement association. 
• Land units associated to an easement cannot be deleted. To delete a land unit associated to an 

easement, the land unit must first be removed from the easement association. 
• The system will prevent the user from removing the last land unit associated to the easement if 

there are any practices in the Easement Plan. 
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Easement Folders and Reconciliation Process 

The Easement folder type allows the planner to create a folder for a specific easement application or 
existing agreement that is in NEST. Naming conventions should only include the last 5 characters of the 
NEST agreement/application since this is the only unique portion of the application and the FY could 
change on deferred applications. 
 

 

 
 

 
After an Easement folder is created, the Easement Land Unit Tool allows the planner to assign land units 
to the specific easement associated with that folder. 
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Easement Reconciliation allows users with the new reconciliation role in zRoles to control locking and 
unlocking land units associated to an easement. The reconciliation also allows the planner to identify 
issues between NEG boundaries and land units associated with the easement boundaries and to check 
for inappropriate practices scheduled on an easement land unit. The Easement Reconciliation Tool is 
covered in Task Guide 31. 
 

 
 

Assign Land Unit(s) to an Easement 

1. Create an Easement type folder. 
 
2. If there is not an existing AOI, create and check out an AOI around the land unit(s) to be assigned to 

the easement. The land unit(s) may be in the Case PLUs or the Active PLUs layer and they must be in 
Planned or Locked status to be associated to the easement. In easement folders, the National 
Easement Geodatabase (NEG) layer is automatically added to the ArcMap Table of Contents 
to help locate existing easement land units. 

 

3. On the ArcMap Toolkit Toolbar, click the Easement Land Unit button.  
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4. Click in the map view to select the easement land unit(s) from the Case PLUs or Active PLUs layer. 
 

 
 

 

 
 

 

 
 

5. The added land unit(s) will be listed in the Land Units in Easement section of the dialog and 
displayed in the Easement PLUs layer in the map view. The Easement Acres (from NEST), Land Unit 
Acres, and the difference are displayed at the top of the dialog. 

6. Click OK to close the Add/Remove Easement Land Unit(s) dialog. 

7. After the land unit(s) have been assigned to the easement, an easement plan can be created in the 
easement folder and land units can be added to the plan from the Easement PLUs layer. 
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Remove a Land Unit from the Easement Association 

1. To remove a land unit from the easement association, click the Easement Land Unit button  
on the Toolkit Toolbar.  

 

 

 
 

 
 

2. In the Add/Remove Easement Land Unit(s) dialog, check the land unit(s) to remove from the 
easement association from the Land Units in Easement section. Click Remove and click OK to close 
the dialog when finished. 

3. Land units cannot be removed from the easement association if the land unit has “Planned” status 
practices in a plan within the easement folder. In that case, the practices must be cancelled before 
remove the land unit from the easement. 
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Task Guide 31 – Easement Reconciliation Tool 

Table of Contents: 
Review Easement Land Unit(s) and Practices using the Easement Reconciliation Tool ............................. 2 

Enforce Easement Rules to Lock the Easement Land Unit(s) ...................................................................... 3 

Unlock Easement Land Unit(s) .................................................................................................................... 5 

Split a Locked Easement Land Unit ............................................................................................................. 5 

Merge Locked Easement Land Units ........................................................................................................... 8 

 
 
Easement reconciliation is a specialized function that can be performed by a subset of Customer Service 
Toolkit users with the specific zRoles permissions to perform the task. Reconciliation requires the user to 
review the land unit boundaries and the practices that intersect those land unit boundaries with the 
Easement boundary maintained in the National Easement Geodatabase (NEG) layer to determine if the 
land unit(s) and easement aligns within 2% and to determine if there are contracted practices through 
other farm bill programs associated to the easement land units that would violate policy. If there is more 
than a 2% discrepancy where the issue is the land units (in NPAD) that need to be updated, then the 
user can update the land units and any associated practices that may need to be updated as a result of 
updating the land unit boundary. If the issue causing the 2% discrepancy appears to be the easement 
boundary, the user should add a note in the reconciliation tool describing the issue. In either case, the 
rules can be enforced regardless of the amount of discrepancy between the easement land unit(s) and 
the NEG easement boundary. 
 

The Easement Reconciliation Tool  allows users with the appropriate zRoles permissions to review 
and lock or unlock easement land units. 
 

• The user must have the Easement Reconciliation role in zRoles to reconcile or to justify why 
reconciliation was not completed. 

• The Easement Reconciliation Tool cannot enforce easement rules before there is a closed date 
in NEST. 

• The system will alert the user when the land unit calculated acres and NEST closed acres are not 
within 2% of each other. 

• Land Units in planned status will be locked and be displayed as locked once the Enforce 
Easement Rules radio button is selected and saved. 

• If any land units are locked by ProTracts when the reconcile easement tool is used, the 
easement can be reconciled. If the Enforce Easement Rules is later removed, any PLUs locked by 
ProTracts will remain locked. 

• Once the easement land unit(s) have been reviewed and locked, only interior edits can be made 
to the land units. Land Units can be split or merged within the easement boundary. The exterior 
easement boundary cannot be edited unless the easement is first unlocked. 
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Review Easement Land Unit(s) and Practices using the Easement Reconciliation Tool 

1. Create an Easement type folder. 
 
2. Assign land units to the easement using the Easement Land Unit button. 
 

3. Click the Easement Reconciliation button  on the Toolkit toolbar. 
 
4. Review the easement land unit(s) and practice associated to the land unit(s) in the map view and in 

the Easement Reconciliation dialog. The Easement Reconciliation Tool dialog displays information 
from NEST, the NEG layer and the easement land units and practices. The top row displays the 
easement information from NEST. The Land Unit/Easement Area Check displays the Easement Acres 
from the NEG layer, the Calculated Acres of the land unit(s) associated to the easement (Land Unit 
Acres) and the difference between the two. The Practice Overlap Check displays any practices that 
overlap with the land unit(s) associated to the easement. 

 
a) In the map view, compare differences between easement land unit boundaries and the NEG 

boundary. 
 

b) In the Easement Reconciliation Tool dialog, review the acreage difference and percent 
difference. If the difference is greater than 2%, determine if the land unit boundary should 
be updated to more closely match the easement boundary. If the land unit boundary will be 
edited, close the Reconciliation Tool dialog, make the needed edits to the Case PLUs and 
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practice layers, then return to the Reconciliation Tool to complete the review. If the land 
unit boundary is correct and the easement boundary should be updated, this should be 
noted under the Notes section of the Easement Reconciliation Tool. 

c) In the Easement Reconciliation Tool dialog, review the practices that overlap with the land 
units associated to the easement to ensure there are no inappropriate practices being paid 
for in the easement area. An example would be practices that have not been applied (are in 
a Planned status) in an active EQIP contract that overlap with a WRP easement area. 

 

 

 
 

Enforce Easement Rules to Lock the Easement Land Unit(s) 

1. In the Easement Reconciliation Tool dialog, enter any relevant notes from the review in the Notes 
Section. For example, provide a description of the issue if the easement acres and land unit acres 
differ by more than 2% and the land unit boundaries look correct. 
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2. Check the Enforce Easement Rules and the Easement has been reviewed checkboxes. 
 

 

 
 

 

 

3. Click OK to enforce the easement rules and lock the associated land unit(s). Once the easement land 
unit(s) have been reviewed and locked, only interior edits can be made to the land units. Land Units can be 
split or merged within the easement boundary. The exterior easement boundary cannot be edited unless 
the easement is first unlocked. 

4. If the difference in acreage is greater than 2%, you will receive a warning message. Click OK to 
proceed. 
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Unlock Easement Land Unit(s) 

1. To unlock an easement land unit, click the Easement Reconciliation button  on the Toolkit 
toolbar. 

 
2. Uncheck the Enforce Easement Rules checkbox. 
 
3. Click OK to unlock the associated land unit(s). 
 

 
 

  

4. If any land units are locked by ProTracts when the Enforce Easement Rules is removed, those land 
units will remain locked by ProTracts. 

 

Split a Locked Easement Land Unit 

1. Start the Toolkit Digitizer and select Case PLUs for the layer to edit. 
 
2. On the Land Unit Editor Toolbar, click the Select Field button. Click in the map view to select the 

Locked easement land unit to split. 
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3. On the Land Unit Editor Toolbar, click the Split Field button. In the Map View, draw a line across the 
selected land unit, splitting it into 2 separate land units. Begin and end the line completely outside 
of the select land unit and double-click to finish the sketch. 

 

 
 

 

 
  

4. In the Select Split Target dialog, select the polygon to retain the original land unit attributes. When 
you click on Polygon 1 or Polygon 2 in the dialog window, it will flash that land unit on the screen. 
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5. Click OK in the Toolkit Information window. The land unit that was not selected will be automatically 
attributed with the same tract and land unit number as the original feature, followed by an “a” after 
the land unit number. For example, if Tract 1, Land Unit 1 was split, the resulting land units would be 
attributed as Tract 1, Land Unit 1 and Tract 1, Land Unit 1a. 

 

 
 

 

 
 

 

 
 
  

6. On the Land Unit Editor Toolbar, save the edits and stop editing. The land units will automatically 
check in, click OK in the Toolkit Information window. 

7. Click OK in the Toolkit Warning window. This message displays when a land unit is split or edited to 
reduce the area to remind the planner that planned practices may need to be updated to reflect the 
new land unit geometry. 



Task Guide 31 P a g e  | 8 September 16, 2016 

8. The original easement land unit has been split and the resulting land units remain in Locked status. 
 

 
 

 

 
  

Merge Locked Easement Land Units 

1. Start the Toolkit Digitizer and select Case PLUs for the layer to edit. 
 
2. On the Land Unit Editor Toolbar, click the Select Field button. Click in the map view to select two or 

more Locked easement land units to merge. 
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3. In the Select Feature dialog, use the Ctrl key to select all land units to merge and click OK. 
 

 
 

 

 

 
 

 

4. On the Land Unit Editor Toolbar, click the Merge Fields  button. 

5. In the Select Merge Target dialog, select the polygon used for attributing the merged land unit. Click 
on each land unit in the dialog window, to flash it on the screen. 

6. On the Land Unit Editor Toolbar, save the edits and stop editing. 
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Task Guide 32 - Practice Schedule  

Table of Contents: 
Practice Status ............................................................................................................................................. 1 

Schedule Full Extent Practices from the Practice Schedule ........................................................................ 2 

Schedule Identified Priorities (Species) from the Practice Schedule .......................................................... 5 

Assigning National and State Practice Narratives from the Practice Schedule ........................................... 9 

Update the Practice Status ........................................................................................................................ 10 

Schedule CSP Full Extent Practices from Practice Schedule ...................................................................... 12 

Filter Practices in the Practice Schedule ................................................................................................... 14 

 
The Practice Schedule tab is used to plan new full extent practices, modify practices, apply practices, 
cancel practices and delete alternative practices. After selecting a plan the customer folder(s), tract(s), 
land unit(s), and the Practice Filter can be used to filter specific practices needed to create plan and 
contract documents. Refer to the Practice Layers Task Guide for more information on other practice 
rules. 

Practice Status 

Practice Status was introduced in Toolkit 8. When a practice is added to the Practice Schedule, it 
defaults to Alternative status until there is a Plan Approval date, or until it is manually updated on the 
Practice Schedule. The Practice Status is shown in the forth column on the Practice Schedule. The 
practice status codes for Toolkit are shown in the table below. 
 

Practice 
Status 

Definition 

Alternative The practice is newly added to a plan without a plan approval date. 
Planned The practice has a planned date. 
Cancelled The practice was planned but never implemented, and will not be implemented in the 

future. 
Applied The practice was planned and implemented. 
Deleted Practices can be deleted that are in alternative status. Practice is deleted from the 

practice schedule. 
 
 

Practice 
Status 

Business Rules Reported 
to PRS 

Alternative 1. When a practice is created the status is “alternative”.  
2. ProTracts will not allow a contract modification or contract obligation 

to be approved if the practice is “Alternative”.   

N 

Planned 1. After the plan is signed the “Plan Approval Date” should be entered 
or updated. This automatically updates all “alternative” practices to 
“planned”. 

Y 

Applied 1. The applied amount and applied date must be entered together in 
order for the practice to be “applied”. 

Y 
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2. When the practice applied date and applied amount are entered in 
Toolkit or ProTracts the status automatically updates to “applied”. 

3. Practices cannot be applied if they are not “planned”. 
4. If the applied date and applied amount are deleted, the status will 

automatically change to “planned”.  
Cancelled 1. The planner is allowed to cancel a practice that is in “planned” status.  

2. The “cancelled” status ensures the practices the client agreed to 
remain in the plan as a permanent record and any plan documents 
provided to the client match the practice schedule. 

3. When a plan is cancelled all “planned” practices will be “cancelled”. 

N 

Deleted 1. A practice can be “deleted” if the practice is in “alternative” status. N 
 

 

 
  

Schedule Full Extent Practices from the Practice Schedule 

Scheduling full extent practices allows the planner to select land units and schedule the practice and 
create the practice polygon at the same time. This saves time when scheduling a practice for multiple 
years, since the Schedule Full Extent Practice tool automatically creates practice polygons for each year 
on the practice schedule. The Schedule Full Extent Practice tool only applies to acre-based practices. 
 
1. Check out and open a customer folder. 
 
2. Select the Practice Schedule tab and select a plan. 
 
3. Select the customer folder(s), tract(s) and land unit(s) from the Land Units menu on the left. The 

Land Unit tree can be sorted by Tract/Land Unit or by Land Use. 
 
4. Select the practice(s) from the All Practices menu on the right. The practice list can be filtered using 

the Practices Only or Enhancements Only checkboxes. 
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5. Select the Planned Date from the calendar, the Interval (in years), and the End Year. Note that the 
Interval is the time between practice recurrence – “1” means the practice recurs every year, “2” 
means the practice recurs every other year, and so forth. 

 

 
 

 

 
 

  

6. Click the Select Schedule Full Extent Practice button. The Practice Schedule shows that Nutrient 
Management (590) was planned for 2016, 2017 and 2018. Note that newly scheduled practices have 
a status of “Alternative.” 

7. To plan a second 590 practice for 2017 that will just be for one year, select the 590 practice again 
and change the start year and end year to 2017. 
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8. At the Toolkit Information message “The practice you are scheduling is a duplicate. Would you like 
to continue adding the duplicate practice?” Answer Yes. The second 590 practice is  been added to 
the Practice Schedule. 

 

 
 

 

 
 

 

 
 
  

9. Click the Save button. A message will appear reminding you to update the plan approval date. 

10. Once you set the plan approval date, the practice status will be changed from “Alternative” to 
“Planned.” 



Task Guide 32 Page | 5 September 16, 2016 

11. If a practice planned amount is not within 10% of the calculated amount of the practice geometry, a 
warning message will appear when the Practice Schedule is saved. 

 

 
 

 

 
 

12. To view the Practice (polygon) attributes, open ArcMap and use the Attribute tool   button 
located on the Toolkit toolbar and select the land unit in the map display area. Note that in this 
example, the four Nutrient Management practices on the Practice Schedule are identified by the 
Attribute tool– the practices are “pancaked” on top of each other in the figure below.  

Schedule Identified Priorities (Species) from the Practice Schedule  

Planners have the ability to identify priorities for scheduled practices (plus determine a practice specific 
action when applicable), determine if Endangered Species Act (ESA) predictability applies, and enter 
practice verification information. 
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Current priority species and locations are: 
 

Species  Priority Location  
Black-footed Ferret Arizona, Colorado, Kansas, Montana, Nebraska, New 

Mexico, North Dakota, Oklahoma, South Dakota, Texas, 
Utah, Wyoming 

Bog Turtle  Connecticut, Delaware, Maryland, Massachusetts, New 
Jersey, New York, Pennsylvania  

Golden-Winged Warbler  Georgia, Kentucky, Maryland, New Jersey, New York, North 
Carolina, Pennsylvania, Tennessee, Virginia, West Virginia  

Gopher Tortoise Alabama (3 counties), Florida, Georgia, Louisiana, 
Mississippi, South Carolina 

Sage Grouse  California, Colorado, Idaho, Montana, Nevada, North 
Dakota, South Dakota, Oregon, Utah, Washington, 
Wyoming  

Lesser Prairie Chicken  Colorado, Kansas, New Mexico, Oklahoma, Texas 
New England Cottontail  Connecticut, Maine, Massachusetts, New Hampshire, New 

York, Rhode Island  
Southwestern Willow Flycatcher  Arizona, California, Colorado, Nevada, New Mexico, Utah  
Longleaf Pine Alabama, Florida, Georgia, Louisiana, Mississippi, North 

Carolina, South Carolina, Texas, Virginia 
Monarch Butterfly All States 
Honeybee All States  

 
To Create a New Full Extent Practice with an Identified Priority: 
 
Scheduling full extent practices allows the planner to select land units and schedule the practice and 
create the practice polygon at the same time. The Schedule Full Extent Practice tool only applies to acre-
based practices. 
 
1. Check out and open a customer folder. 
 
2. Select the Practice Schedule tab and select a plan. 
 
3. Select the customer folder(s), tract(s) and land unit(s) from the Land Units menu on the left. The 

Land Unit tree can be sorted by Tract/Land Unit or by Land Use. 
 
4. Select the practice(s) from the All Practices menu on the right. The practice list can be filtered using 

the Practices Only or Enhancements Only checkboxes. 
 
5. Select the Planned Date from the calendar, the Interval (in years), and the End Year. Note that the 

Interval is the time between practice recurrence – “1” means the practice recurs every year, “2” 
means the practice recurs every other year, and so forth. 

 
6. Click on the Select Priority button. 
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7. In the Select Priorities dialog box select the Identified Priority, if applicable the Action associated 
with the specific practice, and check the box if the practice applies to ESA Predictability. Select the 
Add Priority button and the priority is added to the list of priorities in the dialog box. Click OK. 

 
To Add an Identified Priority to an Existing Practice in the Practice Schedule:  
 
1. On the Schedule located at the bottom of the screen, click on the line that contains the Tract, Land 

Unit(s), and Practice Code to highlight it. Click in the corresponding cell in the Priority column and a 
blue square appears. Click on the blue square to set the priorities. 
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2. In the Select Priorities dialog box select the Identified Priority, if applicable the Action associated 
with the specific practices, and check the box if the practice applies to ESA Predictability.  Select the 
Add Priority button and the priority is added to the list of priorities in the dialog box. Click OK. 

 

 

 

 
 

 
Note that the Results display a Yes under the Priority column. 
 

 
Note:  If you select a practice that doesn’t have a Priority, you will receive a warning message: 
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Assigning National and State Practice Narratives from the Practice Schedule 

Planners have the ability to customize national and state narratives. The following steps show how to 
customize a practice narrative and copy it to other practices. 
 
1. Check out and open a customer folder. 
 
2. Select the plan and schedule practices. 
 
3. Practices default to the National Narrative. 
 
4. To change the practice narrative, click on the cell in the Narrative column, and a blue square will 

appear. Click on the blue square to open the Practice Narratives dialog. 
 

 
 

 

 

5. Change the National Narrative to a State Narrative by scrolling down the list of narratives to find the 
one you want to use. You can leave the state narrative as is, or modify the narrative by editing the 
text box and entering a practice extension. Click OK. 
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6. To copy the custom narrative, higlight the Narrative and click the Copy to Cell Below button. 
 

 
 

 

  
 

 

 
  

7. After the narratives are updated, click Save. 

Update the Practice Status  

1. The Practice Status is shown in the Practice Schedule grid. If a practice is “Alternative” status and no 
plan approval date has been set, the practice can be deleted. Click on the Practice Status field and 
select “Deleted” from the dropdown list.  
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2. A message will appear asking if you want to delete the practice. If you click OK, the practice will be 
deleted from the Practice Schedule. 

 

 
 

 

 
 

 

 
 

 

 
 

3. When the plan approval date has been entered, the Practice Status is automatically changed from 
“Alternative” to “Planned”. If a “Planned” practice is not going to be implemented, the status can be 
changed by selecting “Cancelled” in the Practice Status dropdown and saving the Practice Schedule. 

4. A message will appear asking if you want to cancel the practice. If you click OK, the practice status 
will update to “Cancelled”. 

5. Practices in “Planned” status can be changed to “Applied” by entering an applied date and amount, 
and saving the Practice Schedule. 
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6. Toolkit will not allow an applied date in the future or an applied amount that is greater than the land 
unit acres. A warning message will appear if the Applied amount is not within 10% of the practice 
geometry calculated acres. 

 

 
 

 
 

 

 

Schedule CSP Full Extent Practices from Practice Schedule 

CSP uses the Conservation Management Unit (CMU) to aggregate land units to the land use level for 
planning practices. The practice schedule has been modified to display the Land Unit Tree by 
CMU/Customer Folder or by Plan Name/Tract/Land Units. Full extent practices that are in acres can be 
planned from the practice schedule for the entire CMU, Tract or by Land Unit(s). 
 
1. In Toolkit, select the Practice Schedule tab and select the Plan from the drop-down menu. 
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2. In the Land Unit tree, click on the CMU/Customer Folder(s)/Tract(s) or land unit(s) you want to 
schedule a practice for the full extent of the land unit. 

3. To see practices required by CSP (based on the application entered in CMT), double-click on the 
Required By CSP header to sort by that column. If a Practice shows True, then the practice is 
required to be planned before a plan approval date can be entered. 

4. To Schedule a Full extent practice, follow these steps: 
a. Select the CMU/Folder(s)/Tract(s) or Land Unit(s). 
b. Select one or more practices by clicking on the practice row. When the practice row is 

highlighted in blue it is selected and ready to plan a new practice. 
c. Select the Planned Date and enter Interval (in years), enter the End Year if the practice will 

be planned over multiple years. 
d. Select the Schedule Full Extent Practice. 
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5. The Practices should now be displayed in the Practice Schedule Grid. The practice attributes, such as 
planned date and Program, can be edited in this table. Save the practice schedule when finished. 

 

 
 

 

 

 
 

  

Filter Practices in the Practice Schedule 

1. The Practice Filter can be used to display a selected subset of practices in the Practice Schedule Grid 
based on selected practice attributes. 

2. When there is an active filter, the Practice Filter icon will be shaded in red , indicating the 
Practice Schedule Grid is filtered and not all practices are displayed. 
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3. To filter practices, select the attributes for the practices to display in the Practice Filter dialog. In this 
example, practices in “Planned” status and with a planned year of 2017 will be the only practices 
displayed. Practices can be filtered on any combination of Practice Status, Planned Year, Applied 
Year, Program Code, Contract #, and Practice Code. 

 

 
 

 

 

4. The clear an active practice filter and view all practices, click the Clear Filters button on the Practice 
Filter dialog. 
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Task Guide 33 - Plan Wizard 
 
Contents: 

Develop a Plan Document ......................................................................................................................... 2 

Select Template and Report Type ............................................................................................................. 3 

Select Participants ..................................................................................................................................... 4 

Customize the Plan Document .................................................................................................................. 5 

Working with the Plan in Excel ................................................................................................................. 7 

 
Conservation plan documents are created using the Plan Wizard. The Plan Wizard assembles the plan 
information into an Excel spreadsheet, saves it in the customer’s Plan Reports folder and starts Excel. 
From Excel you may print the plan in the standard format or customize it. The standard format includes 
the following items: 

• Practices grouped by land use or by practice name 
• A practice narrative for each practice 
• The tract(s), land unit(s) and land unit acres for each practice 
• The planned amount, month, and year for each practice 
• Columns for the applied practice amounts and dates 
• Signature block for the plan decision maker 

 
The plan's appearance may also be customized, for example: 

• Select summary or detail report 
• Add signature blocks for additional plan participants 
• Turn the display of practice narratives on or off 
• Turn the display of participant signature blocks on or off 
• Sort practices by land use or by practice name 
• Select practices to include in report by practice status 
• Add and customize up to 3 additional signature blocks 
• Display a standard statement 
• Display a block for the customer’s objectives 
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Develop a Plan Document 

The Plan Wizard guides you through the process of creating a plan document for the land units that 
were selected from the Practice Schedule dialog box. In order to develop a conservation plan document, 
you must first have a customer record checked out and open. To create a plan, complete the following 
steps. 
 
1. Click on the Practice Schedule tab. 
 
2. Select a plan from the dropdown list. 
 
3. Select the land units to include in the Land Unit area. The Land Unit Tree can be sorted by Tract and 

Land Unit or by Land Use. Practices for the selected land units will display in the Schedule grid. 
 

OPTIONAL:  If you highlight practices in the schedule grid, those will be the only practices used in the 
Plan Wizard. You can also select practices by practice status within the Plan Wizard. 

 

 
 

 

 

4. Click the Plan Wizard button to start the wizard. If the Plan Wizard button is grayed out, Save the 
practice schedule to activate the button. 
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Select Template and Report Type 

1. In the Conservation Plan Wizard dialog, select the Spanish Version checkbox if you want the Plan 
Document developed in Spanish. Leaving this box unchecked (the default setting) will create the 
Plan Document in English. 

 

 

 

 
 

 

 
 

 

2. Select the Report Type.  
a. Summary Report:  practices are summarized as a single row in the Plan Document when the 

practice code, narrative and planned date are the same. 
b. Detail Report (default selection):  each practice is listed on a separate row in the Plan 

Document. 

Summary Report: 

Detail Report: 

3. Click Next. 
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Select Participants 

In the Conservation Plan Wizard dialog, the plan decision maker is automatically selected and displayed 
in the participants list. To add an additional participant/associated customer to the Plan Document, 
complete the following steps. If no additional participants are needed, click Next. 
 
1. Click on the List of Participants dropdown menu and select the participant to add.  

Note:  If the participant is not listed, they must be added to the customer folder from the General 
tab and added to the plan from the Create/Open/Manage Plans dialog. 

 
2. Click the Add button to add the selected participant. 
 
3. To remove a participant, highlight the row you want to remove in the participants list and press the 

<Delete> key. 
 
4. When all necessary participants have been added, click Next. 
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Customize the Plan Document 

The final dialog box of the Conservation Plan Wizard allows you to customize the Plan Document. For 
example, the practices can be sorted by land use or by practice, practices included in the Plan Document 
can be selected by Practice Status, and Standard Statements or Plan Objectives can be added. 
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1. Check Options:  Uncheck to remove practice narratives or signature boxes from the Plan Document. 
These are checked by default and it is recommended that both are included in the plan. 

 
2. Sort By: Select the method to sort practices in the Plan Document. 
Land Use:  Practices are grouped by land use, then sorted by tract, practice, and land unit. 
Practice:  Practices are listed in alphabetical order by practice name. 
 
3. Practice Statuses:  The Plan Wizard allows you to select the practices included in the plan by 

practice status (Alternative, Applied or Planned). 
• If nothing is selected, all statuses will be included in the plan. 

• Click on a listed status to select it, more than one status can be selected to include in the plan. 
Practices with a status that is not selected will not be included in the Plan Document. 

 

 
 

 

 

 

 

 
  

4. Signature Box:  If more than one Field Office and/or Conservation District have been set up (see 
Preferences), you select a different office or district from the dropdown list. By default the Signature 
Box area displays the Field Office, the Designated Conservationist Name and Title, and the 
Conservation District. 

5. Add Additional Signatures:  Select the checkboxes to add up to 3 additional signature blocks to the 
Plan Document. Enter the Agency name and Sign By title to include in the plan. These are saved in 
the user’s preferences and will be displayed the next time the Plan Wizard is opened. 

6. Standard Statements block:  Enter a Standard Statement to be included in the Plan Document 
(optional). There are two options for entering standard statement:   
a. Manually type the statement in the text box. 
b. Create a standard statement in a text editor (MS Word, Notepad, etc.) and save as a text file 

(.txt) in the default directory C:\Program Files (x86)\USDA\Toolkit5\Templates\PlanWizard. 
Insert the saved statement by clicking the Browse button , selecting the appropriate file and 
clicking Open. The statement is displayed in the Standard Statements box and can be edited 
there as needed. 

7. Plan Objectives:  Enter plan objectives in the text box (optional). If plan objectives are entered, they 
will be added to the top of the Plan Document. 

8. Click Finish. 
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9. In the Save Excel File As dialog, enter a meaningful, descriptive file name. Click Open. 
 

 
 
10. When finished saving, the Plan Document will open in Excel. 
 
Working with the Plan in Excel 

If needed, the Plan Document can be edited in Excel to set page breaks, or adjust cells to fit the text. 
 
To adjust page breaks: 
 
1. In Excel, select the View tab. Click the Page Break Preview button. 
 

 
 

 

2. The page breaks will appear as blue lines. Use the mouse to click and drag page breaks to the 
desired location. 
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3. When finished, save the Excel file and print the Plan Document. 
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Task Guide 34 - Contract Wizard 
 
Contents: 

Creating a New Contract Using the Contract Wizard .............................................................................. 2 

Developing Contract Items ...................................................................................................................... 5 

Selecting Participants .............................................................................................................................. 9 

Set Contract Preferences ....................................................................................................................... 10 

Save the Contract Support Document ................................................................................................... 11 

 
The Contract Wizard allows users to develop contract items to be uploaded to a ProTracts Application 
for a Financial Assistance Program or to develop contract items and create a contract support document 
(NRCS-CPA-1155) or a contract revision document (NRCS-CPA-1156). Before starting the Contract 
Wizard, it is important to know what items belong in the contract and how they should appear. The 
Contract Wizard will group like practices that are scheduled for the same year with the same narrative 
ID (including any modifier you may add). Therefore, you may want to use different narrative IDs to help 
you separate practices into different contract items. Another alternative is to separate practices into 
different contract items manually. See the section titled “Splitting one practice into 2 or more contract 
items” in this Task Guide for details. 
 
To develop a contract, complete the following steps: 

1. Select a contract template. 
2. Select a cost list or payment schedule. 
3. Develop or revise contract items. 
4. Select participants for signature blocks. 

 
Once a practice has been included in any contract items using the contract wizard, Toolkit will not allow 
changes to the practice with the exception of:  Planned Amount, Applied Amount, Applied Date, and 
editing the practice shape. If other changes are needed, the contract item for that practice must first be 
removed from the Toolkit contract. Toolkit will display a message if the user attempts to change 
attributes that are read-only because the practice is saved in a Toolkit contract. The Toolkit Contract 
Identifier and Contract Item Number (CIN) are displayed in the Practice Schedule grid to help users 
pinpoint where changes may be needed. A practice can only be included in a single contract item in the 
contract wizard. Once a contract item has been created for a practice, another contract item cannot be 
created using the same practice instance. 
 
Once the “Upload Toolkit Contract” has been used to add all practices to the ProTracts application, 
ProTracts will create a back feed to Toolkit and will assign a Toolkit Plan Approval Date based on the 
date of obligation in ProTracts. The Toolkit Contract Identifier and CIN displayed in the Practice Schedule 
will be replaced with the ProTracts contract number. 
 
NOTE: The decision maker is set at the plan level in Toolkit. If you will be uploading a Toolkit contract 
into a ProTracts application, be sure the (Toolkit) plan Decision Maker is the same as the name of the 
applicant in ProTracts before running Toolkit’s Contract Wizard. 
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Additional information about the interaction of Toolkit/NPAD and ProTracts is included in Task Guide 36 
- Contract Modifications. 
 

Creating a New Contract Using the Contract Wizard 

1. Check out and open a customer folder. 
 
2. Select the Practice Schedule tab. 
 
3. Select the Plan from the dropdown list. 
 
4. If items were recently added to the Schedule, click Save at the bottom of the screen. 
 
5. Select the Tract(s) and Land Unit(s) with practices scheduled to be included in the contract. 
 
6. Select the practices to be included in the contract using the methods described below. 
 

a. By default, all of the practices in “Alternative”, “Planned”, or “Applied” status will appear in the 
contract wizard. When the Contract Wizard opens, the planner can select any/all practice status 
types they would like included in the contract. 

 

 
 
  



Task Guide 34 P a g e  | 3 September 16, 2016 

b. If specific practices are selected in the Schedule table, only the selected practices will be 
included in the Contract Wizard. Methods of selecting practice are as follows. 

i. Hold down the <Ctrl> key on the keyboard and click the grey box in front of the lines in 
the Schedule table to select non-contiguous lines. 

 

 
 

 

 
 

 

 

 
  

ii. Select one line in the Schedule table, hold down the <Shift> key and click a row before 
further down to select all of the rows in between. 

7. Click the Contract Wizard button at the bottom of the Practice Schedule tab to open the Contract 
Wizard dialog. (If this button is greyed out, saving the practice schedule may activate the button.) 

8. On the Select Contract Information screen:  

a. Select a template from the Template Selection options. The default template is the NRCS-CPA-
1155. 
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b. Select the Level of Detail. 
 

 

 
 

 

 
 

 

 

 

 

i. Contract Details:  Each contract item is listed as a separate row in the contract 
documents. 

ii. Contract Summary:  Contract items with the same practice code, planned amount, and 
narrative will be summarized (displayed in a single row) for all years. 

c. Enter a Contract Identifier.  A contract identifier uniquely identifies the customer's contracts in 
NPAD. An ID is used since a contract number may not be available when the contract is 
developed. Each new contract for a customer must have an identifier. The identifier is also used 
to retrieve the contract data from the database for revisions. See the Contract Modifications 
Task Guide for more information. 

d. If desired, select Practice Statuses to be included in the Component selection screen. If no 
selection is made, all selected practices regardless of status will be displayed in the next screen. 

e. If desired, change the rounding option. The default is to round up to the nearest dollar which is 
the rounding method used by ProTracts. 

f. In the Select a Cost List block, click on the first row under Cost List File. In the Select Cost List File 
dialog, navigate to the location of your cost lists and payment schedules. By default the Contract 
Wizard looks in the C:\Field_Office_Tech_Guide\Section_I directory for cost lists. Select the 
correct cost list by double-clicking on the filename or select the file and click the Open button. A 
cost list must be selected for each program displayed. 
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9. Click the Next button. 
 

Developing Contract Items 

1. Click the Expand button or icon ( ) to display the land units for each practice in the Practice list. 

2. The current CIN (Contract Item Number) appears in the list in the upper left corner of the dialog. As 
practices are added to the contract, new CIN numbers are automatically generated. Check the CIN 
dropdown when moving between items to ensure it is changing appropriately. 
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3. Click on a Practice, Tract, or Land Unit in the Practice list to select it. Selecting a practice or tract will 
select all land units underneath that selection. When a selection is made, the practice component(s) 
appear in the Components grid. 

 

 

The Components grid displays components from the previously selected cost list for a selected 
practice. 
• To view the components, at least one land unit must be selected and the practice must be 

included in the selected cost list. 
• If needed, click and drag on the column header to adjust the width of that column (e.g., 

Component) and display more or less information. 
• The Amount, Unit Cost and Share Rate values may be changed by double clicking the cell in the 

Components grid (not the Contract Items grid). Enter the new value and press the enter key. Any 
changes will apply to the current contract only and this option should be used with caution. 
Most cost lists contain values that are approved by the State Conservationist. Changing the Unit 
Cost, Share Rate, etc. could be a violation of policy. 

• Skipping over any practice or land unit in the Practices list will result in that item being omitted 
from the contract as long as no component is added. 

Selecting Practice Components - Basic 
a. Select a Practice Component by clicking the check box next to a component. 
b. If the component units match the units of the selected practice, the planned amount of the 

practice will appear in the Amount cell. If the units do not match, the value in the cell will be 0. 
To change the Amount, click in the Amount cell in the Components area, type the correct 
amount then press the Enter key. (IMPORTANT: you must press Enter or click in another cell 
for the value to be saved.) 
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c. When you select a component, the new contract item is added to the Contract Items grid. The 
first item is labeled 1a. If you select another component for the practice in the Components grid, 
a new Contract Item is added and numbered 1b. The third is numbered as 1c, and so on. 

d. To include another land unit in the current CIN, select it from the Practices list then select one or 
more components from the Components grid (as described above). 

 
Splitting One Practice into 2 or More Contract Items 

a. Land units under the same practice code, planned year and narrative are automatically grouped 
as a single CIN. If desired, you can override this feature and create a separate CIN for each land 
unit by selecting a different CIN from the CIN list (upper left corner). More than 1 CIN cannot be 
created from a single practice instance. 

b. This separation could also be achieved by selecting different narrative IDs in the practice 
schedule. 

c. Add the contract item for the first land unit as described above. Select the second land unit, 
then click the CIN dropdown list and select the next contract item from the list (2 in this 
example). Click the check box to select one or more components from the Components grid.  

 

 
 

 

 

d. This creates 2 separate CINs for a practice scheduled on multiple land units. In this example, 
there were 2 CINs added for the 590 practice:  CIN 1 for Land Unit 2 and CIN 2 for Land Unit 3. 

 
Adding Non-Cost Shared Contract Items (may not be allowed for ProTracts Contracts) 

a. Click once on the green dollar sign  next to a practice to add it as a "non-cost shared" contract 
item. All Land units under the selected practice are selected automatically. The dollar sign 
changes to show the non-cost shared icon . If needed, uncheck the land unit checkbox to 
remove that land unit from the contract item. 
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Create a Contract Item Group 
A Contract Item Group can be created to display the selected practices together in the NRCS-CPA-1155 
or NRCS-CPS-1156. Contract Item Groups are created in the Contract Wizard and can be uploaded and 
displayed in ProTracts. Contract Item Groups are used for grouping and displaying practices for the 
client, they do not change any rules on Contract Item certification or payments. 

a. Develop the Contract Items using any of the methods detailed above. 
b. Click the Create/Edits Groups button. 
c. In the Set up Contract Item Groups for the Contract dialog, enter a name for the new Contract 

Item Group in the text box. 
d. Select the practices to be included in the Contract Item Group by holding down the <Shift> or 

<Ctrl> key while clicking the gray box to the left or each CIN. 
e. Click the APPLY button. 
f. When finished, click OK to close the dialog. 

 
Delete a Contract Item or Component 
In the process of developing a contact, you may need to delete a contract item. 

g. In the Contract Items grid, click the gray box at the left of the row you want to delete to select 
the contract item row. 

h. Press the <Delete> key. 
i. If needed, renumber the contract items (see below). 
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Reorder or Update Contract Items 
When developing a contact, you may want to reorder contract items or components or bring in updated 
practice amounts after updating the Practice Schedule. Contract items can also be reordered in 
ProTracts after uploading if necessary. 

a. Select the Practice, Tract, or Land Unit for the CIN to renumber in the Practice list. 
b. Uncheck the selected component to remove the contract item. 
c. Re-select the Practice, Tract, or Land Unit in the Practice list. 
d. Check the component again to create the contract item with the updated CIN or amount. 

 
Remove Land Unit(s) from a Contract Item 
Land Units can be removed from a Contract Item without removing the entire item unless the last Land 
Unit for that item is removed. 

a. Select the Land Unit to remove from the CIN in the Practice list. 
b. Uncheck the selected component to remove the land unit. 
c. The CIN amount and program cost will update to reflect the new amounts. 

 
Be sure to click Save often while developing your contract items, and save when completed. Stop here if 
the contract will be uploaded to ProTracts. The AD-1155 should not be printed from Toolkit, it should 
be printed from ProTracts. Exit the Wizard by clicking the red X at the upper right corner of the dialog. 
The customer must be checked back into NPAD prior to uploading the contract to ProTracts. If the 
contract will not be uploaded to ProTracts, continue to the next section. 

Selecting Participants 

In the Contract Wizard dialog, click Next to go to the Select Participants screen. The plan decision maker 
will automatically be added as a participant. 
 
1. To add Associated Customers, select the customer from the participants dropdown list, or type the 

name and address in the boxes if necessary. Click Add. 
 

 
 

 

2. To remove a participant, highlight the row containing the name you want to remove from the 
participant list and press the <Delete> key. 
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3. Click Next. 
 

Set Contract Preferences 

The Set Preferences screen contains options to customize the contract. 
 
1. By default, Practice Narratives are displayed on the contract. Uncheck the Display Practice Narrative 

checkbox if you do not want to display the narratives on the contract document. 
 
2. The Field Office and Conservation District are automatically populated in the Signature Box area 

with the default offices from your Toolkit preferences. If more than one Field Office and 
Conservation District are available in Toolkit Preferences, you can change the office by selecting 
from the dropdown lists. If needed, you can edit the Conservationist Name and Title. 

• The default Conservationist Name reflects the NRCS office contact as designated in the 
Office Information Profile (OIP) database. Contact your state data steward if updates are 
needed. 

 
3. Select the Additional Signature checkboxes to add up to 3 additional signature blocks to the contract 

document. Enter the Agency name and Sign By title to include in the plan. These are saved in the 
user’s preferences and will be displayed the next time the Contract Wizard is opened. 

 
4. In the Contract Information area, the total contract acres, state, and county are automatically 

populated. These can be edited as needed. 
 

 
 
5. When you are done making changes, click Finish.  
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Save the Contract Support Document 

After clicking Finish in the Contract Wizard, the Save Excel File As dialog window opens. By default, the 
contract will save as <contract identifier>.xls in the Customer File’s Contract_Reports subfolder. 
 
1. Accept the default file name and location or change as needed. 
 
2. Click Open to save the file. 
 
3. A warning message will display if the file already exists, click Yes or No to overwrite the existing file 

and proceed. 
 
4. When the contract document is finished, it will open in Microsoft Excel. 

• If the wait is longer than a few minutes for an average contract, there may be a problem 
with the printer driver installed on your machine. Contact your State Toolkit Coordinator. 

 
5. Make any needed adjustments in Excel (last minute edits, adjust page breaks, etc.) Save the 

changes, print the contract and close Excel. 
 
6. If you need to reopen the contract document later, select the Customer File tab. Select the 

Contract_Reports folder on the left side of the screen, then double-click on the contract document 
to open. 

 

 
 

 

7. See the Task Guide 36 - Contract Modifications if changes need to be made to the contract after you 
complete the wizard. 
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Task Guide 35 - Plan Approval 

Before the plan is official and the practices are reportable, the plan approval information must be 
entered or updated. Once the client has approved the plan, the plan approval date can be selected. 
Whenver there are significant changes or updates to the plan, a new approval date should be entered to 
reflect the client’s approval of the updated plan. The Practice Schedule tab shows the status code of the 
plan. 
 
New plan status codes are used beginning in Toolkit 8.0. These are shown in the table below. Only plans 
in Active status are checked out with the customer folder and editable in the Practice Schedule and Arc 
Map. Completed and Cancelled plans are viewable only from the Quick Report Tool. Deleted plans are 
deleted from NPAD. 
 
A planner must update the status from Active to Deleted, Cancelled, Completed through the Modify 
Folder/Plan Status menu. Refer to the Folder and Date Management Task Guide for more information. 
 

Status  Definition 
Active All plans are defaulted to Active when the plan is created and will remain in 

Active status until changed by the planner. 
Completed Plan has a plan approval date, and all practices have been applied. 
Deleted Plan does not have any planned practices and there is not a plan approval date.  
Cancelled Plan has a plan approval date, but not all practices have been applied. 

 
Business Rules: 

• Entering the Plan Approval Date updates all “Alternative” practices to “Planned” status. 
• Primary agency responsible for planning should be selected in the Work Performed By. 
• Plan approval date is not required to be entered before plan or contract wizard is ran. 
• Plan approval date is required for the practices and plan to be reportable to PRS. 
• A CSP plan cannot be approved until all required practices are planned  
• Plan approval date is not required to be entered or updated before contract items are uploaded 

to a ProTracts application. 
• Plan approval date will be automatically updated by ProTracts if any practices are in the 

“Alternative” status when a contract is obligated and a contract modification is approved. 
 
The plan creation process is summarized below. Each step is explained in detail in different Task Guides. 
 
1. Check out or create a customer folder. 
 
2. Open the customer folder. 
 
3. Select/create the plan from the Create/Open/Manage Plans. 
 
4. Add land units to the plan. 
 
5. Schedule the practices. 
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6. On the Toolkit Practice Schedule tab, select the correct plan from the Plan drop-down list. 
 

 

 
 
 
  

7.  Click the Plan Approval button to open the Plan Approval dialog. 
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8. Enter the Plan Approval Date. You can select the month and year, or click on the Today button to 
use the current date. A message will appear if this is an update to an existing plan, confirming the 
plan approval date was modified. 

 

 
 

 

 

 

 
 

9. Select the primary agency  that is performing the work on the plan. Note:  Toolkit only allows one 
agency to be selected per plan. 

10. The checkbox to make the plan viewable in Conservation Client Gateway defaults to checked status 
when there is a plan approval date set. If you do not want the customer to be able to view the plan 
in CCG, uncheck the box. 

11. Click Save. A message appears confirming the Plan Approval Date is saved. 

12. When the Plan Approval Date is saved, “Alternative” status practices in the practice schedule will 
update to “Planned” status. 
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Task Guide 36 - Contract Modifications  
 
Contract modifications for contracts that are not linked to ProTracts (CRP, WRE, etc.) are completed 
using the Contract Wizard. See Section A of this task guide. 

There are rules in Toolkit that prevent certain data linked to a ProTracts contract from being changed 
unless a contract modification is underway. When the ProTracts contract is signed and obligated (e.g. 
when it becomes a contract), “under contract” flags are set in TK. This includes setting the practice 
under contract flag and the land unit to Locked status. Land unit shapes cannot be edited or changed 
unless a contract modification is underway. Planning data (planned date, amount, practice code, tract 
number, land unit number, acres, etc.) are also only editable as part of a contract modification. Only the 
practice applied data (amount and date) and the practice geometry (or practice shape) can be changed 
on an under contract practice without completing a contract modification. If the planning data needs to 
be changed, it must be done through a ProTracts contract modification. When the modification is 
approved, the changes are updated in NPAD. 

If the land units or practices are linked to a ProTracts contract, it is possible that changes will need to be 
made both in ProTracts and Toolkit to complete the necessary contract modifications. However, the 
contract wizard is not used for these types of modifications. If the land is included in a ProTracts 
contract and the land unit is locked see Task Guide 26: Toolkit Digitizer-Case PLU Layer-Modifying Land 
Units in ProTracts Contract. If the land is included in a FY14 - FY16 CSP contract see Task Guide 25: 
Toolkit Digitizer-Case PLU Layer-Modifying Land Units in CSP Plan and/or Contract Modification CSP Land 
Units for information about modifying land included in a Stewardship Plan. For FY17 and newer CStwP 
plans see Task Guide 26: Toolkit Digitizer-Case PLU Layer-Modifying Land Units in ProTracts Contract. 

Contents: 
Edit a Toolkit Contract That is Not Linked to a ProTracts Contract ........................................................ 2 
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Edit a Toolkit Contract That is Not Linked to a ProTracts Contract 

Use the Contract Wizard to revise a contract (Form NRCS-CPA-1156) that is not linked to a ProTracts 
contract. Contract revisions are saved in the customer's database and overwrite the original contract 
data. The following changes can be made: 
 

a. Edit the contract items (i.e., change amount, unit cost, share rate) 
b. Delete a contract item 
c. Add a contract item 
d. Add land units to a contract item 
e. Remove land units from a contract item 
f. Print revised contract document 

 
Note:  If you open the Contract Wizard on an existing contract after you have changed information such 
as the land unit, practice, narrative, year, or cost-share program in the Practice Scheduler, you may 
receive a Toolkit warning. It warns that: 
 

“A modification has been made in the Practice Scheduler that affects Contract Item(s). The Contract 
Item(s) listed will not show up in the contract. Practices will need to be created in the Practice 
Scheduler and the Contract Items re-entered to fix.” 

 
1. Check out the customer folder. 
 
2. Select the appropriate plan and adjust the Practice Schedule as needed. For previously saved 

contract items, only the planned amount can be updated in the Practice Schedule. If other 
adjustments are needed, complete steps 3 - 10 below to open the Contract Wizard and the steps 
under Delete Contract Item to remove the saved contract item. Save the Contract Wizard changes, 
then adjust the Practice Schedule as needed. 

 
3. Save the Practice Schedule. 
 
4. On the Practice Schedule tab, select the land units in the original contract in the Land Units area and 

select the practices from the original contract from the Schedule grid. It is important to select all of 
the same land units (and only those land units) in the land unit tree to access previously created 
Contract Wizard information. 

 
5. Click the Contract Wizard button to start the wizard. 
 
6. From the Select Contract Information dialog box, select the template you want to use (e.g. NRCS-

CPA-1156). 
 
7. Select the Contract Identifier from the drop-down list for the contract you want to revise. 
 
8. For Select a Cost List, click once on a program in the list to open the Select Cost List for <Program> 

dialog box.  
 
9. Select the cost list file(s) that was used for the original contract and click Open. 
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10. Click Next to display the Contract Items dialog box. 
 

Edit the Contract Items 

Edit contract items by changing the values entered for Amount, Unit Cost or Share Rate in the 
Component grid. 
 
1. Select a Contract Item in the Contract Item grid. When an item is selected, the practice and land 

units become visible in the Practices area. 
 
2. Click once on a scheduled practice, tract, or land unit to display the contract item component(s) in 

the Components grid. 
 
3. Click in the Amount cell in the Components grid to select it. 
 
4. Change the value, and then press the Enter key. This updates the Amount cell in the Contract Items 

grid automatically. 
 
5. Click in the Unit Cost cell in the Components grid to select it.  
 
6. Change the value, and then press the Enter key. This updates the Unit Cost cell in the Contract Items 

grid. 
 
7. Click in the Share Rate cell in the Components grid to select it.  
 
8. Change the value, and then press the Enter key. This updates the Share Rate cell in the Contract 

Items grid. 
 
9. Click Save to save the revisions in the customer's database. This action overwrites the original 

contract data in the database. 
 
10. Repeat the above steps to edit other contract items. 

Delete Contract Item 

1. Select the contract item. 
 
2. Press the <Delete> key on the keyboard. 
 
3. Click the Save button to remove the item from the customer's database. 
 
4. Repeat the above steps to delete other contract items. 

Add Contract Item 

1. Review the practices in the Practice list on the Contract Items dialog box. 
a. If the practice for the new contract item is in the list, skip to step 4. 
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b. If the practice for the new contract item is not in list, it must be selected or added from the 
Practice Schedule. Click Cancel to close the Contract Wizard and return to the Practice Schedule. 

 
2. Review the practices in the Schedule grid. Each practice record in the Practice Schedule can be 

linked to only one Contract Item in ProTracts. Practices must first be scheduled in Toolkit, then they 
can be selected to create the Contract Item. 
a. If the practice is displayed, select it along with the practices from the original contract. 
b. If the practice is not displayed, select the land unit where the practice is scheduled from the 

Land Units area to add it to the grid. 
c. If the practice has not been scheduled, schedule the practice from the Practice Schedule or in 

ArcMap. 
 
3. Select the new practice along with the practices from the original contract in the Schedule grid. 
 
4. Click the Contract Wizard button to start the wizard. 

a. If the item is cost-shared, follow the steps in the Contract Wizard for Add Cost-Shared Items to a 
contract.  

b. If the item is non cost-shared, follow the steps in Add Non Cost-Shared Items to a Contract. 
 
5. Repeat the above steps for each new contract item. 

Add Land Units to a Contract Item 

1. Select a contract item in the Contract Items grid. The practice and land units for the item become 
visible in the Practices area. 

 
2. Select one or more land units. 
 
3. Select a component in the Components grid.  

a. Accept Amount or enter a value.  
b. Accept Unit Cost or change the value.  
c. Accept Share Rate or change the value.  
d. When the first component is selected for a land unit, the land unit is checked in the Practices 

list.  
 
4. If a component is selected for a practice for the first time, a Subitem is added to the Contract Item 

grid.  
a. If the same component is selected again for the practice, the Subitem Amount is updated.  
b. The Subitem also shows changes made to Unit Cost and Share Rate.  
c. Select additional components as needed for the land unit. 

 
5. Repeat steps 2 and 3 to add other land units to the contract item if needed. 
 
6. Repeat steps 1-3 to add land units to other contract items. 
 
7. Click Save to save the revisions. 
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Remove Land Units from Contract Items 

1. Select a contract item in the Contract Items grid. The practice and land units for the item become 
visible in the Practices area. 

 
2. Select the land unit to remove in the Practices area. 
 
3. Uncheck the selected component checkbox to remove the land unit from the contract item. The 

cells in the Contract Item grid are updated automatically. 
 
4. Repeat steps 2 and 3 to remove other land units from the contract item. 
 
5. Repeat steps 1 - 3 to remove land units from other items. 
 
6. Click Save to save the revisions in the customer's database. 
 

Print Revised Contract Document 

The procedure for printing a revised contract document is the same as for printing the original contract 
document. 
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Removing a Contracted Land Unit from ProTracts and Toolkit 

1. Begin a contract modification in ProTracts to remove a land unit. 
 
2. Remove land unit(s) from the contract by removing the check mark in front of every place that land 

unit appears in the “Planned Practices” section of a contract item. 
a. Be sure to check each contract item and remove all the necessary check marks and adjust 

the components as necessary. 
 
Before: 

 
 
After: 

 
 
3. Follow normal procedures for submitting and getting the ProTracts modification approved. 
 
4. Check out the Toolkit customer folder. 
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5. The land unit geometry status will now show Draft or Plan instead of Locked. Practices associated 
with the land unit(s) that were formerly in the contact may continue to show EQIP as the program in 
NPAD/Toolkit. However, the Contract Number column will show n/a. 

 

 
 
6. You may remove the practices and land unit from Toolkit if desired. 
 

Adding a New Item to a ProTracts Contract 

When completing a modification in ProTracts to add a new practice, ProTracts will create a back feed to 
Toolkit when the modification is approved assigning a new plan approval date to the plan associated 
with the contract in ProTracts. 
 
1. Practices must be added to Toolkit prior to beginning the modification in ProTracts. 
 
2. Check out the Toolkit customer folder. 
 
3. Schedule whole field practices on the practice schedule tab or digitize and attribute any point/line or 

partial field practices in ArcMap. 
a. Practices must be scheduled for the current year or a year in the future. 
b. Do not try to split a practice in Toolkit that is already contracted in ProTracts. Use the Vertex 

Edit, Reshape, or Replace Shape tool to edit the practice instead. 
c. Practices added in Toolkit for the purpose of bringing into an existing ProTracts contract 

should NOT be run through Toolkit’s Contract Wizard. 
 
4. Check in the Toolkit customer folder. 
 
5. Go to ProTracts and begin the modification. 
 
6. Click New Item. 
 
7. Select the practice. ProTracts will look for the practice in the current year in the first Toolkit plan 

listed. 
a. If it does not default to the correct plan, the user needs to select the correct plan from the 

drop down. 
b. ProTracts defaults to the current year. If the practice is scheduled for a future year, the user 

should select the correct year from the dropdown in ProTracts and search again. 
 
8. The planned practice grid is populated with the data from Toolkit. 

a. The only data that can be changed in ProTracts at this point is planned year, practice extent, 
and associated land units. 
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9. Because the newly added practice was not run through Toolkit’s Contract Wizard, the practice 
currently does not have a specific component associated to it. Click Add Component and select 
components from the payment schedule and entered planned amounts. 

 
10. Follow normal procedures for submitting and getting the ProTracts modification approved. 
 

Deleting an Entire Contract Item (Practice) from a ProTracts Contract 

1. Begin contract modification in ProTracts to remove item. 
 
2. Select the correct item in ProTracts. Click Delete Item. 
 
3. Follow normal procedures for submitting and getting the ProTracts modification approved. 
 
4. The practice will automatically be changed to CTA in the practice schedule when the modification is 

approved. 
 
5. If practice is no longer needed, check out the customer in Toolkit and delete the practice so it will 

not be included in reports used to set goals.  
 

Increasing/Reducing the Extent of an Item (Practice) in a ProTracts Contract 

Reminder:  Changes to the practice planned years are not allowed in the Toolkit Practice Schedule or 
Attribute Tool even when the Toolkit folder has been unlocked during a modification. Planned practice 
dates must be updated from ProTracts and will be written back to NPAD when the modification is 
approved. 
 
1. Begin contract modification in ProTracts to increase/reduce extent of a contract item. 
 
2. Increase/Reduce the extent of the item in ProTracts. 
 
3. Submit ProTracts modification for approval. 
 
4. No need to do anything in Toolkit unless practice geometry will change, e.g. fence or terrace line 

should be changed. If so, change the geometry in Toolkit, see below. 
 

Changing Geometry of Contracted Practices in Toolkit (including correcting 
auto-created practice features produced during the initial migration to NPAD) 

Note:  Do not delete a practice feature and re-draw if it is linked to a ProTracts contract, since there is 
no method to link new geometry back to the existing tabular data. The Replace Shape tool may be used 
to update the practice shape while maintaining the tabular data. The practice geometry may be edited 
at any time, it is not necessary to begin a contract modification in ProTracts when updating the practice 
shape only. 
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1. Check out customer folder. 
 
2. Edit the practice geometry using the Vertex Edit, Reshape, or Replace Shape tool in Toolkit and 

check in customer folder. 
 
3. No need to do anything in ProTracts, unless contracted practice extent needs increased or reduced. 
 
Completing a Modification to Synchronize Toolkit and ProTracts 

If Toolkit edits must be made to land units associated with practices in a ProTracts contract, a 
modification must be done to unlock the land units for editing and to synchronize the Toolkit changes 
with the information in ProTracts. Changes that would require a modification include editing land unit 
boundaries or attributes (land use, tract and land unit numbers). 
 
1. Begin a ProTracts modification and select “Other” as the Basis for Modification. 

a. If no tract, field numbers or acres were changed, the basis for modification should include 
wording to that effect. For example:  “Modifying contract to synchronize conservation plan 
and contract data. Changes may include updates to land unit boundaries, land use, etc. that 
do not affect contracted amounts or locations. No participant signature required.” 

b. If tract or field numbers were changed, include detailed information about what was 
changed. 

 
2. Unlock Toolkit land units in ProTracts by clicking Unlock Folder. 
 
3. Lock Toolkit land units in ProTracts by clicking Lock Folder. 
 
4. Note ProTracts data sync messages. 
 
5. Follow normal procedures for submitting and getting the ProTracts modification approved. 

Modifying a CSP Contract in ProTracts to Edit Land Units 

These steps apply to CSP contracts linked to CMT, or contracts entered prior to FY17 (FY18 for 
renewals). For CStwP Contracts entered for FY17 (FY18 for renewals) or later, follow the same 
modification process as for other ProTracts contracts. 
 
Once the CSP plan is tied to a contract, any changes to the land units or attributes will require a 
modification to the CMT. The workflow process to modify a land unit which is tied to a CSP contract is as 
follows. 
 
To begin a contract modification for the CSP plan: 
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1. Open ProTracts and select Manage Contracts. Select the contract that is linked to the CSP plan. 
 

 
 
2. Start a Contract Modification, the reason for the modification is “CSP inventory adjustments” 
 

 
 
3. Provide the justification and click OK. The screen will refresh and the CMT button will become 

active. 
 

 
 
4. Make the needed adjustments to the CMT and submit the revised CMT to ProTracts. 
 
5. In Toolkit, check out the customer folder that contains the CSP Plan. 
 
6. Open the CSP plan and click on the CSP button on the Toolkit toolbar. 
 
7. Remove any land units that need to be revised from the CSP plan. 
 
8. If the land units that need to be modified are in a different customer folder than the CSP plan, check 

out the folder that contains the land units in the Case PLUs layer and open ArcMap. 
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9. Edit the land unit boundaries or attributes and save the changes. The land units will automatically 
check in to NPAD when the changes are saved. 

 
10. If needed, close ArcMap and switch to the customer folder that contains the CSP plan. Open 

ArcMap. 
 
11. Open the CSP Plan and click on the CSP button on the Toolkit toolbar. 
 
12. Add back the land units that were revised. You should see the revision of the acres in the Program 

Acres column that was a result of the changes to the CMT. 
 
13. Update any planned practices if needed. Modify the practice geometries and attributes to address 

the CMT changes. The Replace Shape tool can be used to update practice geometry for full field 
practices with the new land unit shape. 

 
14. Create and print a new plan map. 
 
15. Enter the new Plan Approval Date. 
 
16. Save the edits, and run the Plan Wizard. 
 
17. Check in the Toolkit customer folder. 
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Information in this document was taken from ArcMap Help and from the Introduction to ArcGIS 1 for 
USDA SCA 9.2 training course materials. 

The ArcMap Interface 

 

 
  

 
Features of the ArcMap Interface 

Context menu Appears by clicking the right mouse button.  It contains ArcGIS controls directly 
to the data layer that is active. 

Data View Switches to Data View. 
Display Area Area where the data is displayed. 
Layout View Switches to Layout View. 
Menu bar Functions as any menu in Windows. 
Refresh Refreshes the Display Area. 
Standard toolbar Contains file management commands, a map scale, shortcuts to ArcCatalog, 

ArcToolbox, Search and the Toolkit toolbar button. 
Status bar Displays coordinates and a description of the selected button or menu item. 
Suspends drawing Suspends drawing of the map.  The <Esc> key may also be used. 
Title bar Displays the map name. 
Toolkit toolbar Contains the Toolkit tasks.  Toolbars are dockable. 
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Data Frames and Layers 

A map is the document (.mxd) that stores data frames, layers and map elements such as text or 
graphics.  A data frame is a container for layers.  The layers store a path to a data source as well as 
properties in the data source. 

 
A map contains: 
• Data frames 
• Layers 

A data frame: 
• Organizes layers 
• Contains properties 

o Coordinate system 
Layers: 
• Reference spatial data 
• Can set symbols, labels, and other properties 
• Manipulate through the context menu 
 
 

The Table of Contents (TOC) 

The table of contents lists all the layers on the map and shows what the features in each layer represent. 
The map's table of contents helps you manage the display order of map layers and symbol assignment, 
as well as set the display and other properties of each map layer.  
 
The layers at the top of the table of contents draw on top of those below them. Thus, you'll put the 
layers that form the background of your map, such as the ocean or an image, near the bottom of the 
table of contents and the layers to which you want to draw the map reader's attention near the top. A 
typical map might have an image or a terrain base (such as shaded relief or elevation contours) near the 
bottom. Next, comes base map polygon features, followed by line and point features near the top. And 
finally, you might typically see some reference layers, such as road names and place names, that provide 
locational context. 
 
You use the check box or icon to the left of each map layer to turn it on or off. Holding down the <CTRL> 
key and clicking turns all map layers on and off simultaneously.  
 
You can set the display properties for each map layer so that it draws within a specific range of map 
scales. When the map display is out of range for scale-dependent drawing, the layers will not be visible. 
Layers that are out of range of the current map scale are indicated in the table of contents by a gray 
check box with a scale bar under it. 
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Managing the Table of Contents (TOC) 

The Table of Contents lists all the data frames and 
thematic layers on the map and shows the symbols used 
to represent the features in each layer.  

• Place a check box next to a layer to make it 
visible on the map.  

• The draw order of the data layers are from the 
bottom up.  If you want a layer to be in the 
background, such as imagery, make sure it is 
displayed at the bottom of the TOC.  ArcMap 
contains smart drawing.  When a new data layer 
is added, it places points on top of polygons and 
polygons on top of raster layers such as imagery. 

• Layers can be removed by right clicking on the 
data layer and click Remove. 

• Layer properties can be changed by either 
double clicking the left mouse button on a layer 
or by right clicking on the data layer and select 
Properties. 
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List by Drawing Order  

Use List by Drawing Order  to author the contents of your map, such as to change the display order of 
layers on the map, rename or remove layers, and create or manage group layers. All the data frames in 
your map are listed when the table of contents is sorted by drawing order. However, only the active 
data frame—indicated by a bold data frame name—is shown in the map in data view. 
 

 
 
  



Task Guide 37 P a g e  | 6 September 16, 2016 

List by Source  

Click List By Source  to show the layers in each data frame with the layers organized by the folders or 
databases in which the data sources referenced by the layers can be found. This view will also list tables 
that have been added to the map document as data. 
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List by Visibility  

Click List by Visibility  to see a dynamic listing of the layers currently displayed in the active data 
frame. The way layers are listed updates automatically as you pan and zoom, interact with the map, 
select features, and turn layers on and off.  
 
Listing layers by visibility helps you visually simplify and organize a detailed or complicated map with 
many layers. Since the organization of the table of contents visibility list is controlled automatically, you 
cannot change the order or groupings of layers manually. Layers within a group layer are listed 
individually, since each layer can have its own visibility and selection properties. You can choose to 
display the group layer's name beside the layer's entry on the Table of Contents Options dialog box. 
 

 
 
With List By Visibility, you have visual cues to indicate the layer's visibility. Each type of layer has its own 
icon, and the symbol is either colored to indicate the layer is on or gray when it is not, so you can quickly 
look at the icon to determine whether a layer is visible.  
 
When layers are listed by visibility, they are grouped into these categories:  

• Visible—The layer is turned on.  
• Out of Scale Range—The layer has a visible scale range and is not being displayed at the current 

map scale. To bring it back into view, right-click and click Zoom To Make Visible.  
• Not Visible—The layer is turned off. To turn it back on, click the icon to the left of the layer 

name.  
 
When you right-click a layer name, the menu that appears contains the same commands as the menu 
for listing layers by drawing order and selection. 
To turn a layer on or off, click the layer icon to the left of the layer name, such as  for a line layer or 

 for a polygon layer. To make a layer selectable or not selectable, click the selection icon to the right 
of the layer name. If that icon is colored , the layer is selectable; if it is gray , the layer is not 
selectable.  
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List by Selection  

Click List by Selection  to group layers automatically by whether or not they are selectable and have 
selected features. A selectable layer means that features in the layer can be selected using the 
interactive selection tools, such as those on the Tools toolbar or the Edit tool, when in an edit session. 
 

 
 

Symbology  

The Case PLU units and the Active PLU symbology must be changed by following these exact steps. Do 
not use the Layer Properties to change the symbology or it will change to “All other values” and show up 
black.  
 
1. In the Table of Contents, left click on the symbol to bring up the Symbol Selector dialog window. 
 
2. In the Symbol Selector dialog window, change the fill color and the outline color to the desired 

color. 
 

Note:  It is important to choose a color that is not distracting.  The symbology affects how readers 
interpret your map.  For information on how best to symbolize for effective color contrast for people 
with partial sight and color deficiencies go to http://www.lighthouse.org/accessibility/design/accessible-
print-design/effective-color-contrast 
 
  

http://www.lighthouse.org/accessibility/design/accessible-print-design/effective-color-contrast
http://www.lighthouse.org/accessibility/design/accessible-print-design/effective-color-contrast
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3. In the Symbol Selector, click OK. 
 

 

 
 

 
The land unit symbology for the CSP Planned land units are represented by the yellow hashed symbol.  
 

Identify Tool 

In order to find a customer’s land units that are outside the conservation plan you are currently editing, 
you must first know which customer folder and plan to check out. This User Guide explains how to use 
the Active and Legacy PLU Layers to find specific land unit(s) Customer Folders and Plans to check out 
for maintaining the Active and Legacy PLU layers. 
 

1. On the ArcMap Tools toolbar, click on the Identify tool button. 
2. Using the Identify tool, click on one of the Active or Legacy PLU’s to identify the attributes.  In the 

Identify dialog window the plan_name, customer_folder_path, and customer_folder_state_county 
codes have been identified, this information can now be used to check out the plan the land unit is 
in. 
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The following tips are from the ArcMap Help documentation.  

Standard Toolbar 

 
 
Commonly used buttons on the Standard Toolbar: 
Button Name Function 

 New Create a new map document. 

 Open Open an existing map document. 

 Save Save the current map document. 

 Print Print the current map document. 

 Cut Cut the selected element(s). 

 Copy Copy the selected element(s). 

 Paste Paste the selected element(s). 

 Delete Delete the selected element(s). 

 Undo Undo the last action. 

 Redo Redo the previous undone action. 

 Add Data Add data to the map’s active data frame. 

 Map Scale Map scale. 

 Table of Contents Open the Table of Contents. 

 Catalog Open the ArcCatalog window to to manage and access your data. 

 Search Open the Search window to search for data, maps, tools, etc. 

 

 

ArcToolbox Open the ArcToolbox 
toolboxes. 

window to access geoprocessing tools and 
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Tools Toolbar 

 

Commonly used buttons on the Tools Toolbar: 
Button Name Function 

Zoom In  Zoom in to a geographic 
box. 

window by clicking a point or dragging a 

Zoom Out Zoom 
a box. 

out 
 

from a geographic window by clicking a point or dragging 

Pan Pan the data frame.  

Full Extent Zoom to the full extent of your map.  

Fixed Zoom In  Zoom in on the center of your data frame.  

Fixed Zoom Out Zoom out on the center of your data frame.  

Back Go back to the previous extent. 

Forward Go forward to the next extent.  

Select Features  Select features graphically, by clicking or dragging a box around 
them. You can also use the Select By Polygon, Lasso, Circle, and 
tools to select features using graphics drawn to the screen. 

Line 

Clear Selection Unselects all the currently 
frame.  

selected features in the active data 

Select Elements Select, resize, and move text, graphics, and 
the map.  

other objects placed on 

Identify Identifies the geographic feature or place on which you click.  

Measure  Measures distances and areas on your map.  

Find  Finds features in the map.  

Go To XY Location Type an x,y location and navigate to it. 
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Accessing ArcMap Menu Commands Using Shortcuts 

The following table lists the keyboard shortcuts for some common commands: 
Shortcut Command Menu 

CTRL+N New File 

CTRL+O Open File 

CTRL+S Save File 

ALT+F4 Exit File 

CTRL+Z Undo Edit 

CTRL+Y Redo Edit 

CTRL+X Cut Edit 

CTRL+C Copy Edit 

CTRL+V Paste Edit 

DELETE Delete Edit 

F1 ArcGIS for Desktop Help Help 
 

  

Refreshing or Suspending Map Drawing 

• Press F5 to refresh and redraw the display.  
• Press F9 whenever you want to suspend or pause drawing so you can make changes to your 

map without having the map redraw after each change. Press F9 again to resume drawing.  

Dragging and Dropping to Move or Copy 

• You can drag and drop or copy and paste multiple layers in the table of contents and between 
ArcMap sessions. You can also drag and drop or copy and paste data frames between ArcMap 
sessions.  

• Use drag and drop to move layers in and out of a group layer within a data frame.  
• Layers that are dragged and dropped between data frames and ArcMap sessions are copied; 

hold down CTRL while dragging and dropping to move layers between data frames and ArcMap 
sessions.  

• Data frames that are dragged and dropped are moved; hold down CTRL while dragging and 
dropping to copy them.  

• Layers that are dragged and dropped inside a data frame are moved; hold down CTRL while 
dragging and dropping to copy them.  

• Similarly, in ArcCatalog, you can hold down CTRL while dragging and dropping to copy items.  
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Using Mouse Shortcuts in the Table of Contents 

• CTRL+click an expansion control (+/-) to expand or collapse all the items at that level. If any 
items are currently selected, only the selected items are expanded or collapsed.  

• CTRL+click selects or deselects multiple layers or data frames.  
• SHIFT+click selects all layers or data frames between two layers or data frames within the same 

table of contents level.  
• ALT+click a data frame to activate it.  
• CTRL+click a layer's check box turns all the layers on or off at that level. If any items are currently 

selected, only the selected items are turned on or off.  
• ALT+click a layer's check box turns that layer on and turns off all others at that level.  
• ALT+click a layer's name to zoom to the extent of that layer. This saves having to right-click a 

layer and click Zoom To Layer.  
• When dragging layers, hover the pointer over an expansion control to expand or collapse any 

item.  
• Right-clicking features, layers, and data frames always opens a shortcut menu.  

Navigating Maps and Layout pages 

Hold down the following keys to temporarily turn the tool you are currently using into a navigation tool: 
Z—Zoom In  
X—Zoom Out  
C—Pan  
B—Continuous Zoom/Pan (Drag with mouse button zooms in/out; drag with right mouse button 
pans.)  
Q—Roam (Hold down mouse wheel until cursor changes, then drag or hold Q.) 

 
These shortcuts work in data view and layout view. In layout view, they apply to the page by default. 
Hold down SHIFT as well as the key to apply it to the data frame you click instead of the page. 
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Task Guide 38 - Add-In Tools – Soil Data Viewer 

Installing Soil Data Viewer  

This tool allows users to create Soil Interpretation Maps for use in ArcGIS 10.x and Toolkit 9.x and is used 
in the Soils Map and Inventory Task Guide. 
 
1. Verify that Soil Data View has been installed on your machine by clicking on Start>All 

Programs>USDA Applications>Soils>Soil Data Viewer 6.2. 
 

 
 

 

 

*If you do not see Soil Data Viewer you must have CTS install it for you. 
 
2. If Soil Data Viewer is installed, open Windows Explorer and navigate to the C:\Program Files 

(x86)\USDA\Soil Data Viewer 6.2 folder. 
 
3. Double click on the file named SDVArcMapAddin.esriAddIn (if file extensions are not visible, it may 

show up just as SDVArcMapAddin). 
 
4. In the Esri ArcGIS Add-In Installation Utility window click the Install Add-In button.  
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5. Start ArcMap.  
 

 

 
 
 

6. On the ArcMap Main Menu, click Customize> Toolbars>Soil Data Viewer Toolbar to add the Soil 
Data Viewer toolbar. This toolbar is dockable.  
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Task Guide 39 - ArcGIS 10.x Training Videos  

These videos have been written to demonstrate the changes and enhancements in ArcGIS 10.x in 
cooperation with ESRI and the National Geospatial Center of Excellence.  
 
Each video has the script available as an attachment and is available on the Customer Service Toolkit 
USDA Connect community. 
 

Subject Description Video Name 
Accessing Data  
 

Explore how to add data to 
your map document. We’ll 
explore adding local data, 
accessing ArcGIS Online web 
services, and base maps. In this 
video, we’ll also explore how to 
update symbology on web 
services. 

USDA-WNA10-AccessingData 

Editing Basics Explore how start and manage 
an edit session, navigate the 
Editor toolbar, select features, 
and work with Edit templates. 

USDA-DW-EditingBasics 

Editing Tables Explore how to add, update and 
table fields, using the field 
calculator and calculate 
geometry. 

USDA-DW-EditingTables 

Editing Tools and Properties 
 

Explore several editing tool and 
properties. We’ll introduce 
editing tools such as create new 
feature, modify and reshape 
features, along with several 
other tools. We’ll also explore 
working with map topology, 
such as creating topology and 
performing topology edits. 

USDA-DW-
EditingToolsAndProperties 

Sketch Properties 
 

Explore common sketch 
properties such as sticky move, 
stream tolerance, and 
snapping. 

USDA-DW-SketchProperties 

  

http://www.nrcs.usda.gov/wps/portal/nrcs/main/national/ngce/
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Window Frames 
 

Explore working with the 
Catalog, Table of Contents 
(TOC), and Search windows in 
ArcMap. At ArcGIS 10, each of 
these windows are dockable 
within the ArcMap interface. 
Through the TOC, you will learn 
the different display options for 
data in the map document. 
Using the Search window, we 
will explore the different search 
options, such a data, maps, or 
tools. 

USDA-WNA10-
WorkingwithWindowFrames 

Working with Geodatabases 
 

Focuses on geodatabase 
enhancements and how they 
can make your overall 
experience with the software 
easier and more streamlined, 
such as working with 
geodatabase types and setting 
the ArcMap default 
geodatabase. 

USDA-WNA10-
WorkingWithGeodatabases 

Working with Tables 
 

Explore how to work with 
attribute tables, how to dock 
attribute tables, and drag 
attribute tables separately to 
view two attribute tables at one 
time. 

USDA-WNA10-
WorkingWithTables 
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Task Guide 40 - ESRI Virtual Campus 

The ESRI Virtual Campus training provides a high-quality learning experience using online-interactive 
exercises, examples, and instructional resources to create a rich learning environment. 

These courses are available at no cost. The courses teach a variety of topics related to ESRI software, the 
theory underlying GIS technology, and the application of GIS tools in particular fields. Some Web courses 
include downloadable trial editions of ESRI software. View the list of courses 
at: http://training.esri.com/gateway/index.cfm?fa=aul.premiumCourses 

For ordering information please go to the ESRI Virtual Campus Training web page, located on the 
National Employee Development Center course listing 
at: http://www.nrcs.usda.gov/wps/portal/nrcs/detail/national/nedc/training/gis/?cid=nrcs143_024136 
 

http://training.esri.com/gateway/index.cfm?fa=aul.premiumCourses
http://training.esri.com/gateway/index.cfm?fa=aul.premiumCourses
http://www.nrcs.usda.gov/wps/portal/nrcs/detail/national/nedc/training/gis/?cid=nrcs143_024136
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Task Guide 42 - Data Provisioning 

Using Local Geospatial data  

ArcMap works more efficiently when local geospatial layers are used in map documents.  Using local 
geospatial layers draw faster in the map; zooms in and out without long delays; and data comes into the 
map without long initial drawing.  Establishing geodata on the C: drive can be organized by the Toolkit 
user to suit the needs of users for specified planning areas.  Geodata on the C:\ drive mimics what’s on 
the servers and can easily be accessed when not connected to the network.  Geospatial layers must be 
selectively transferred manually to C:\geodata folders. See example below with folders most used in 
Toolkit conservation planning. 
 
C:\geodata 

 

Connect to Folder 

When accessing ArcMap for the first time, folder connections must be established.   
 
1. On the ArcMap Standard toolbar, click the Add Data  button.  
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2. In the Add Data dialog, click the Connect to Folder  button. 

 
 

 
 
  

3. In the Connect to Folder dialog, navigate to C:\geodata and click OK.  
 
Note:  Limit the number of connections to make ArcGIS more efficient. Suggestions to include other 
folders are as follows: 

F:\geodata\common_land_unit 
C:\Users\<your.name>\My Customer Files Toolkit 
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Add Data to ArcMap Project  

Click the Add Data button and navigate to the geodata folder to find appropriate layer.  The example 
demonstrates an example of geospatial files located in the hydrography folder.  Water_dm_l_pa11.shp 
is selected; click Add button or double click the selected file name to bring data onto the Table of 
Contents in project. 

 

 

 

Using ArcCatalog to Manage Data Layers 

ArcGIS 10.X changed how the Catalog application worked in ArcGIS.  It is embedded in the ArcMap 
for easy access.  The icon to open Catalog is located on the ArcMap Standard toolbar. Hovering the 
cursor over any icon will display a banner naming the icon.  The Catalog can also be accessed through 
the Windows menu: 
 

 
Catalog will appear as a box somewhere in the Data Frame. Anchor the box to the right of the data 
frame.  Note pushpin pointing down. Click on it to make it auto hide (pushpin will be pointing to the 
left), thus making it available in any project that is opened. 
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When not open,   there is a tab displayed for ease of access next time it is needed. Click on tab to 

reopen.  Open Folder Connections to see established paths.  Use the Connect to Folder icon   to 
create new connections if needed. 
 
Navigate to a geodata layer to bring into the project. Below is the same layer as in the example above.  
With left click on the mouse, drag the selected layer into the center of the data frame. The layer will be 
displayed into the Table of Contents and on the map.  Catalog will bring in one layer at a time.   
 

 
 
Using Catalog is very good for moving and copying files from one directory to another, renaming 
shapefiles, or deleting obsolete files. 
 
Users may want to disconnect some of the established paths. In Catalog, select the connection, right 
click and select Disconnect Folder. 
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Using National Geospatial Web Services in ArcMap 

Image services are a way of delivering geospatial layers located on a server via the internet to be used in 
GIS. NRCS customers and employees may access Enterprise Internet Map Services to assist in program 
business and for remote sensing activities. National data services that are available are as follows: 

Services Available 

Basemaps 

http://geodatacache.sc.egov.usda.gov/arcgis/services 
 
Provides worldwide basemaps and reference layers including:  

• shaded elevation 
• government units showing places and boundaries 
• orthographic imagery 
• topographic images 
• street maps and transportation  

State Data 

http://geodatastates.sc.egov.usda.gov/arcgis/services 
 
Hosts data provided by each state and US territory to be consumed by the NRCS offices. Within the 
service are state and territory specific map and feature services including the following (if provided by 
the state/ territory):  

• soils classification and boundaries 
• working lands for wildlife boundaries 
• 12 digit hydrologic unit boundaries 
• EPA impaired waters for both 100 and 300 meter buffers 

Reference layers 

http://geodata.sc.egov.usda.gov/arcgis/services 
 
Provides map, image and feature services including:  

• public land survey system boundaries 
• common land units 
• easement stewardship land boundaries 
• easements imagery beginning in 2007 
• high resolution elevation at 1m, 2m, 3m, and 5m 
• contours and shaded relief 
• national elevation dataset (NED) at 3m, 10m, and 30m 
• government units and boundaries 
• hydrography data 
• land use and land cover 
• orthographic imagery for the US and its territories 
• soils boundaries 

http://geodatacache.sc.egov.usda.gov/arcgis/services
http://geodatastates.sc.egov.usda.gov/arcgis/services
http://geodata.sc.egov.usda.gov/arcgis/services


Task Guide 38 – Data Provisioning  P a g e  | 6 September 16, 2016 
 

Accessing the Services  

There are multiple methods for accessing services for NRCS employees. Each method provides users 
different capabilities and data. 

• Web-Based Internet Map product 
• ArcMap, OGC, or KML service using a GIS 
• Web Based 

GeodataCache: 

http://geodatacache.sc.egov.usda.gov/arcgis/rest/services 

GeodataStates: 

http://geodatastates.sc.egov.usda.gov/arcgis/rest/services 

Geodata: 

http://geodata.sc.egov.usda.gov/arcgis/rest/services 

Using a GIS such as ArcMap or ArcCatalog 

Services data can be previewed in ArcCatalog or added to ArcMap for further analysis by adding an 
ArcGIS Server connection through the GIS Servers menu on the catalog tree. Select add ArcGIS Server, 
then use GIS services connection and the following server URLs are used for the NRCS services: 

GeodataCache: 

http://geodatacache.sc.egov.usda.gov/arcgis/services 

GeodataStates: 

http://geodatastates.sc.egov.usda.gov/arcgis/services 

Geodata: 

http://geodata.sc.egov.usda.gov/arcgis/services 

 
Contact:  For questions or comments, please contact lo-tx-nrcs-ngmc-ServicesHelp@one.usda.gov 
 
  

http://geodatacache.sc.egov.usda.gov/arcgis/rest/services
http://geodatastates.sc.egov.usda.gov/arcgis/rest/services
http://geodata.sc.egov.usda.gov/arcgis/rest/services
http://geodatacache.sc.egov.usda.gov/arcgis/services
http://geodatastates.sc.egov.usda.gov/arcgis/services
http://geodata.sc.egov.usda.gov/arcgis/services
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Tutorial:  Add data from a National Web Service. 

1. On the Standard Toolbar, click the Add Data  button. 
 

 

 
 

 

 
 

 

 

2. Select GIS Servers. 

3. Double click Add ArcGIS Server. 

4. In the Add ArcGIS Server dialog, leave the selection set to Use GIS Services (default) and click Next. 
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5. Enter the appropriate server name listed in the table for the Server URL and click the   
button. 

 

 
 

 

 
 
 

 

 

6. Double click on arcgis on geodata.sc.egov.usda.gov. 

7. Double click on the data set.  For instance, double click on common_land_units to see the data 
layers included. 
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8. Double click on the data layer to add it to Toolkit. 
 

 

 
 

 

 
 

Add an ESRI Base Map  

ESRI basemaps are available to be used in Toolkit.  The data is served over the web.   
 
1. On the ArcGIS Standard toolbar click the arrow on the Add data button and select Add Basemap. 
 

2. Select Imagery or a different layer and click the  button. 
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Task Guide 43 – Preparing SSURGO Soils data for Toolkit 

Contents: 

Initial Toolbox Setup .................................................................................................................................... 1 

Download SSURGO Data ............................................................................................................................. 1 

Project SSURGO Data to UTM Coordinates ................................................................................................. 3 

 
To maximize the functionality of the Toolkit Soil Data and Inventory Report button, it is necessary for the 
SSURGO shapefile (soilmu_a_stXXX.shp) to contain a field with the Prime Farmland attribute.  The steps 
outlined below will help to download and prepare the data for use in toolkit with minimal time and 
effort.  This does require ArcGIS 10.1 or higher. 

Initial Toolbox Setup 

1. Download the Soil Data Development Toolbox and unzip to a location of your choosing. 
 

 

Download SSURGO Data 

2. Open ArcCatalog and navigate to where you placed the Soil Data Development Toolbox. 
 
3. Expand the Download SSURGO Toolset, choose a method to download the data and double click the 

name. This example will cover Download SSURGO by Areasymbol.  

 

https://ems-team.usda.gov/sites/NRCS_SSRA/gis/Shared%20Documents/Forms/AllItems.aspx?RootFolder=%2Fsites%2FNRCS%5FSSRA%2Fgis%2FShared%20Documents%2FgSSURGO&FolderCTID=0x0120002F0A48248C08E6499E4246615A858ECC&View=%7B84275069%2DB5E0%2D4B7D%2D88A0%2D2B841EB47578%7D
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A. Enter the state abbreviation. 
B. Choose an output location for the files. 
C. Select the county(s) that you are interested in downloading.  If you want all of them, click the 

Select All button. 
D. Select the Template Database to use, if applicable.  Typically you would only select a template if 

your state has a customized, state specific template. 
E. Select Remove text files (tabular).  It is unnecessary to maintain these text files for toolkit 

purposes and makes the easier to move. 
F. Make sure that Add Map Unit Name is checked.  This will add both the Map Unit Name and 

Prime Farmland information to the soilmu_a_stXXX shapefile, which is needed in Toolkit to run 
the Soil Inventory and Report Tool. 

G. Click the OK button to execute the tool.  It typically takes a minute or less for a survey. 
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Project SSURGO Data to UTM Coordinates 

The data that was just downloaded is in a WGS84 projection, which is not the projection we want for 
use with Toolkit.  To rectify that we will need to project the data to the appropriate UTM zone. 
 

 
 

 

 
 

4. Expand the SSURGO Data Management Toolset and Double click on Project SSURGO Dataset. 

A. Select the folder location that the SSURGO data was downloaded to in step 3B. 
B. Select a Survey Boundary Layer.  
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• If processing the whole state and you do not have a state layer with soil survey areas, you can 
download it at: 
http://websoilsurvey.sc.egov.usda.gov/DataAvailability/SoilDataAvailabilityShapefile.zip 

• If processing one county, you can use the soil survey boundary that was downloaded.  It is 
named soilsa_a_stXXX.shp in the spatial folder: i.e.  

 
C. Chose the dataseta that you wish to project.  By default all avaialble will be checked; you can use the 

Unselect All button if you need to. 
D. Select an output folder for the projected data. 
E. Select the appropriate Geographic Location for the data. 
F. Select the appropriate UTM Zone for the data. 
G. Select Copy Tabular Data. 
H. Click the OK button to execute the tool.  It will typically take less than 10 seconds per survey. 
 
Data is now prepared and ready to use with Toolkit. 
 

http://websoilsurvey.sc.egov.usda.gov/DataAvailability/SoilDataAvailabilityShapefile.zip
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Task Guide 44 – CStwP Lesson Plans 

The CStwP Lesson Plan document is not inserted here. The file can be printed separately as needed. 
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Task Guide 45 – Conservation Lesson Plans 

The Conservation Lesson Plan document is not inserted here. The file can be printed separately as 
needed. 
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Task Guide 46 – Easement Lesson Plans 

The Easement Lesson Plan document is not inserted here. The file can be printed separately as needed. 
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Task Guide 47 – IET Lesson Plans 

The IET Lesson Plan document is not inserted here. The file can be printed separately as needed. 
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